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Introduction 

About the Software 

CAE Fidesys  is a software package for strength analysis. The package comprises the following types of analysis: 

 Static loading 

 dynamic (transient) loading 

  buckling  

 analysis of natural frequencies 

  frequency analysis 

 calculation of effective material properties 

 response spectrum 

 external integration MBD 

 topological optimization. 

The package also includes a program Fidesys Viewer for visualization and analysis of the obtained results: 

 Visualization of scalar and vector fields 

 SEG-Y files visualization 

 building graphs and charts 

 building frequency dependencies  

 time dependency analysis. 
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Getting Started 

System Requirements 

CAE Fidesys has low system requirements for the package. It can be run on an ordinary personal computer. If the computer 

has one or more multi-core processors, calculations are automatically parallelized on all cores. Starting with version 1.5, 

calculation parallelization to several nodes connected to a local network or a cluster is available in the 64-bit version of the 

program package.  

CAE Fidesys  software package has following minimal requirements for software and hardware: 

Hardware Requirements 
 CPU: Dual-core 1,7 GHz minimum 

 RAM: 4GB minimum 

 Free hard drive space: 6 GB 

 Video card NVIDIA GeForce GTX 460 or faster 

 Screen resolution: 1024х768 or higher 

Operating System 

Following operating systems are supported. (for the 64-bit versions) 

Windows 11 Ubuntu 16.04, Ubuntu 18.04, Ubuntu 20.04, Ubuntu 22.04 

Windows Server 2022 Alt Linux 9.2 

Windows 10 Debian 9, Debian 10, Debian 11 

Windows Server 2019 RHEL 7, RHEL 8, RHEL 9 

Windows Server 2016 Astra Linux Special Edition РУСБ.10015-01 

Windows 8.1 Astra Linux 1.6, Astra Linux 1.7 

Windows 8 RedOS 

Windows Server 2012 Centos 7, Centos 8, Centos 9 

Windows Server 2012 R2 Oracle Linux Server 9 

Windows 7 SP1 OpenSUSE 15.3, OpenSUSE 15.4 

Windows Server 2008 R2 SP1 Rocky Linux 8.5 

 

Scientific Linux 7 

Fedora 36 

  

NOTE: Install the latest updates for Windows. 

 

Installation  

Microsoft Windows 

A user with administrator rights installs the software. Close all the CAE Fidesys windows before installation if there’s 

another version of CAE Fidesys installed. 

1. Download the CAE Fidesys installer from the site http://www.cae-fidesys.com/ru/download/login and run it for the 

architecture you are interested in (Windows x64 or Windows x32), or run the installation from the DVD-ROM.  

http://www.cae-fidesys.com/ru/download/login
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If any other version of CAE Fidesys is already installed on a computer, after starting the installation program you will be asked to 

delete it or to cancel the installation. 

2. Click Next in a pop-up window.  

 

3. Read the license agreement. If you do not agree with any of its paragraphs, interrupt the installer by clicking Cancel. 

If you totally agree with its terms, click Agree to proceed the installation. 

 

 

4. Select a folder for installation and click Next. 
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5. In the Start menu enter the name of the folder to create a shortcut for running the program. If you do not want to 

create a folder in the Start menu, choose Do not create shortcuts. Click Install. 

 

6. The process of installation may take some time. Click Ready after installing. 
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Linux 
Only 64-bit Linux distribution kits are currently supported. 

Setup file CAE Fidesys for Linux available for download only in the browser of the Linux operating system. Supported 

operating system: Ubuntu 20.04. 

1. Download the CAE Fidesys file for Linux x64 from https://www.cae-fidesys.com. 

 2. Installer " CAE-Fidesys-5.1<version>-lin64-<language>-mpi.run ". Installation takes in two steps: 

2.1. With user access rights in the terminal, a run file is launched to unpack the installer 

./CAE-Fidesys-5.1.<version>-lin64-<language>-mpi.run 

If the file is not executable, it must be designated as executable 

chmod +x CAE-Fidesys-5.1.<version>-lin64-<language>-mpi.run 

Default program installation directory is 

./CAE-Fidesys-5.1 

2.2. The installation script is launched as administrator 

sudo <path_to_install_directory>/install.sh 

2.3. To uninstall the program, run the script as administrator 

sudo <path_to_install_directory>/uninstall.sh 

 3. Second installer option " CAE-Fidesys-5.1-<language>-mpi_<version>_amd64.deb". Installation takes in 1 step: 

3.1. Run as administrator 

sudo dpkg -i CAE-Fidesys-5.1-<language>-mpi_<version>_amd64.deb 

Default program installation directory is 
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/opt/fidesys/CAE-Fidesys-5.1 

3.2. To uninstall the program, run the script as administrator 

sudo dpkg -r CAE-Fidesys-5.1 

 4. Start the program 

4.1. CAE Fidesys. In console/terminal 

cae-fidesys-5.1 

4.2. Fidesys Viewer. In console/terminal 

fidesys-viewer-5.1  
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Activation and Trial Period  

When you first run the preprocessor, the Fidesys Licensing window appears with a proposal to purchase a license or to 

activate a trial period.  

Trial Period  

30-day trial period is automatically activated during installation. The trial period starts at the moment when application 

installation is completed. The trial period is for familiarization with the product and is not for any commercial calculations 

(related directly or indirectly to getting a profit out of them). The trial period can not be activated on a virtual machine, and 

the trial version is not designed to work through remote desktop. 

To activate a trial period, click the button Trial period in the start window.  

As long as the program runs in trial mode, the Fidesys Licensing window appears each time you launch it. Click Try to 

continue working in a trial mode. 

Activation  

To activate the product: 

1. Click Activate in the Fidesys Licensing window.  

2. Select I do not have a V2C file and click Generate C2V. The system opens the Save file window. Save the C2V 

file and send it to the organization where the product was purchased. 

3. In response, you get a file containing an activation key with V2C extension. After receiving the V2C file, select I 

have V2C file and click Apply V2C. An Open File dialog window appears on the screen. Indicate in it the path to 

the received file.  

 

4. Your product is activated. 

The system will accomplish the activation automatically when using a dongle. 
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Information on the Purchased License 

Select Help → About in the Main Menu, and you see a window with the following information: 

  Full software version number; 

 License type and its expiration date; 

 The list of features available in the purchased license. 

Uninstalling the Software 

A user with administrator rights uninstalls the software. 

Close all the running copies of the application before uninstalling the software: both preprocessor (Fidesys) and 

postprocessor (Fidesys Viewer). 

To remove the software, open Windows Control Panel and select Programs and Features (Add or Remove Programs in 

the earlier versions of Windows). Select CAE Fidesys #.#.#.# xNN in the list of installed programs, where #.#.#.# are four 

numbers standing for the number of the version and xNN is the architecture (x64). Right-click it and choose Delete/Change. 

Confirm your choice by clicking Delete in the opened window. 

Removing the software does not involve removing its activation data. 
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The program Overview. 

Package Structure 

CAE Fidesys comprises three main components: 

 Fidesys — preprocessing and analysis (computational kernels). 

 FidesysCalc – calculations; 

 Fidesys Viewer — postprocessing and visualization of results. 

Running the Software 

You can run the program in either of the following ways: 

 Use the Start menu (if you chose creating shortcuts in it when installing): choose Fidesys in the folder where you 

installed the program. 

 Use any file manager for Windows from the list where the program was installed 

(C:\Program Files\Fidesys\Fidesys 4.0 by default): run the file fidesys.exe (it is in the folder preprocessor\bin). 

Several copies of the program can be run on the same PC at a time. 

If you work on the licensed version, after running the program you see its Main window. If you use the trial period, a Fidesys 

Licensing window appears in which you should either click Activate in order to purchase a license or click Try to continue 

working in trial mode and go to the Main window. 

Main Window  

CAE Fidesys  has an intuitive graphic interface providing communication between the user and the software, and it allows 

the user to perform the full cycle of calculations step-by-step. 

 

 

Workbench (1) displays the model and visual effects. 
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Main Menu (2) includes standard operations for working with files and projects, managing the visualization modes, panel 

display settings, help, and other functionality available in the drop-down lists of the menu. 

Power Tools (3) comprise the Model Tree, as well as the tools for geometry and mesh analysis. 

Command Panel (4) contains most of commands for working with the program. Panel display buttons are logically located, 

and it allows the user to perform the full cycle of calculations step-by-step. 

Toolbar (5) comprises the buttons for calling the most frequently used commands while working with the program. 

Properties Page (6) displays the properties of the selected object in the Workbench or in the Model Tree. 

Console (7) helps you to input the CAE Fidesys commands and to display the messages to the user. 
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New Features in CAE Fidesys 5.1 

Released: december 2022 

Functional Additions and Improvements 

 Added common contact with friction for FEM and SEM 

 Supported order for the SEM - 9 

 Added step-by-step loading with a change in the topology (composition of blocks) of the body, taking into 

account finite deformations 

 Added elastic-plastic calculation for the Drucker-Prager model with tabular (multilinear isotropic) asymmetric 

hardening for small deformations 

 Added calculation of poroelastic effective properties 

 Added integration with BricsCAD and NanoCad packages 

 Added linear isotropic hardening type 1 for the von Mises plasticity model 

 Added calculation of thermal conductivity for orthotropic laminate shells 

 Added calculation for orthotropic thermoelasticity 

 Added the ability for material properties to set dependence on temperature 

 Added the ability to calculate random vibration 

 Added specification of cylindrical and spherical coordinate systems (preprocessor) 

 Added ability to calculate materials with zero density for modal analysis 

 Fixed display of results in the 3D view of beams for high SEM orders 

 Improved and extended *.cdb file converte 

Additions and Improvements to the Postprocessor 

 Changed the interface for calculating Additive Printing 

 Added display of local coordinate systems for beam and shell elements 

Additions and Improvements to the Postprocessor 

 Residual response added for linear spectral analysis 

 Improved "Harmonic Analysis" filter: interactive node selection implemented, reaction calculation added 

 Added new filter "Multi-threshold" 

 Expanded functionality of the filter "Coordinate systems" 

 Improved filter “Margin of safety” 

 Time or harmonic index display added to model display area 

 



CAE Fidesys — User Guide (version 5.1)           17 

 

 

Using the Program 

Performing calculations with the use of CAE Fidesys  implies the following steps: 

 Setting the geometry; 

 Meshing; 

 Setting boundary conditions; 

 Setting the material; 

 Starting calculation; 

 Visualizing and analyzing results. 

All of the steps except for the last one are accomplished in preprocessor; the last step is accomplished in postprocessor. 

Geometry 

CAE Fidesys  allows to generate volume geometry on your own due to the built-in functionality, as well as to import 3D 

models created in different CAD-systems. 

Geometry Import 

For geometry import choose File → Import in the Main menu. CAE Fidesys  supports the import of the following formats: 

 ACIS (*.sat, *.sab); 

 IGES (*.igs, *.iges); 

 STEP (*.stp, *.step); 

 Warefront Object (*.obj); 

 Stanford Polygon (*.ply); 

 GAMBIT Real Geometry (*.dbs); 

 Catia (*.CATPart, *.CATProduct, *.ncgm); 

 Parasolid (*.x_t, *x_b); 

 SolidWorks (*.sldprt, *.sldasm); 

 JT (*.jt); 

 Pro/E (*.ptr, *.asm); 

 Exodus (*.e*, *.exo); 

 Genesis (*.g, *.gen); 

 Abaqus (*.inp); 

 STL Files (*.stl); 

 Facets (*.fac); 

 Fluent (*.msh); 

 AzoreCFD (*.azmsh); 

 GAMBIT Neutral (*.neu); 

 I-DEAS (*.unv); 

 Nastran (*.bdf); 

 Patran (*.pat, *.neu, *.out); 

 Cubit files (*.cub); 

 Cubit HDF5 (*.cub5, *.trelis); 

 CATIA v4 (*.model); 

 Ansys Mesh Files (*.cdb); 

 Fidesys Project (*.fds); 

 Fidesys Case (*.fc); 

 VTK UnstructuredGrid (*.vtu); 

 FidesysViewer Data Files (*.pvd); 

 Additive Manufacturing (*.cli). 
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Geometry Creating 

For geometry generation CAE Fidesys  provides the user with large numbers of volume geometric primitives 

(parallelepiped, cylinder, prism, cone, pyramid, sphere, torus). It also allows uniting the surfaces in closed volume bodies. 

For complex geometry generation you can use Boolean operations (Intersect, Subtract, Unite volumes) and different 

transformations of the object (Rotate, Move, Scale, Reflect). All of the described functionality is available on Command 

Panel in Geometry section. 

 

   

Converter CDB 

In CAE Fidesys, it was possible to import a cdb file. The cdb format is an archive format supported by the Ansys software 

package. 

 These files contain the following information about the model: finite element mesh, material, boundary conditions, analysis 

type, calculation parameters. 

 Below is information about the capabilities of the cdb envelope in the CAE Fidesis software package. 

Table 1 - Conversion of types of analysis 

Analysis  Analisis (Ansys)  Result 

Static Antype,Static Static 

Mode Frequency Analisis Antype,Modal Analysis of frequencies, waveforms 

Buckling Antype,Buck Calculation for buckling 
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 Table 2 - Conversion of finite element types 

Element  Element (Ansys) Result 

Solid solid186, solid187  Solid (1 or 2 order) 

Shell shell181,shell281 Shell (1 or 2 order) 

Beam beam188,beam189 Beam (1 or 2 order) 

Linear spring combin14 Spring (type - linear) 

Combination spring combin40 Spring (type - combination) 

Discrete mass element mass21 LumpMass 

 Table 3 - Conversion of boundary conditions 

BC APDL script Result 

Displacement D;DK;DL;DA  Displacement (entities - nodes ) 

Node Forse, Moment F Forse (entities - nodes) 

Binding degrees of freedom COUPLING Coupling Constraint  (variables) 

Bonded region CERIG Coupling Constraint (distance between entities) 

 Table 4 - Conversion of the physical properties of the material 

Properties Properties (Ansys) Result 

Linear elastic isotropic material (Young's 

modulus, Poisson's ratio) 

Linear Isotropic Material Properties 

(EX,PRXY) 

Hooke's material (Young's modulus, 

Poisson's ratio) 

Mass density Density Density 

Thermal expansion coefficient 
Isotropic thermal Secant 

Coefficient 
Thermal expansion coefficient 

Fidesys 5.1 introduced the ability to convert the surface load from the Ansys package. The result of this conversion will be 

the "Distributed force" field, located in the "Loads" tab. 

Meshing  

Elements Type 

CAE Fidesys  supports the following types of the finite elements for meshes: 

 volume: SOLID (tetrahedrons, hexahedra, pyramids, prisms); 

 plane: PLANE (triangles, quadrangles); 

 shell: SHELL (triangles, quadrangles); 
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 beam: BEAM; 

 springs: SPRING; 

 point masses: LUMPMASS. 

The order of all elements, except for springs and point masses, can vary from 1st to 9th. The order of the element above the 

second means using the method of spectral elements. 

Volume Meshing 

Select volume mesh generation section on Command Panel (Mode — Mesh, 

Entity — Volume). 

1. Specify the degree of mesh refinement (Action — Intervals) for each 

volume: 

 Select the volumes (specify their ID). You can enumerate several 

volumes using space after each of them. All of the volumes can be 

set by the command all; 

 Select the way of mesh generation (Auto, Approximate size, 

Geometry-adaptive, Interval or Sizing function) ; 

 Click Apply Size. 

 

2. Specify the type of the elements for each volume: 

 Select the entities for mesh generation (specify their ID). You can 

enumerate several volumes using space after each of them. All of 

the volumes can be set by the command all; 

 Select meshing scheme (tetrahedral (Tetmesh) or hexahedral 

elements (Automatically calculate); 

 For tetrahedral mesh generation select the level of optimization (Extreme, Strong, Heavy, Standard, Medium, Light, 

or None) and set the checkboxes in front of the corresponding points, if you need to minimize the over-constrained 

and/or sliver tets. 

 Click Apply Size; 

 Click Mesh. 

For complex geometry it is recommended to set the scheme of surface mesh generation first (triangular or quadrangular 

elements). 
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Surface Mesh Generation 

To generate a surface mesh, follow these steps. 

1. Select surface mesh generation section on Command Panel (Mode — 

Mesh, Entity — Surface). 

 

2. Specify the degree of mesh reducing (Action - Intervals – Approximate 

size) of each surface: 

• select volumes (specify their ID). Multiple volumes can be listed through a 

space; all volumes can be specified using the command all; 

• indicate the Approximate size; 

• Click Apply Size. 

To generate an irregular mesh (e.g. make it finer in the vicinity of stress 

concentrators), you can add nodes on the boundaries near geometry features, 

as well as split curves, surfaces and volumes in the vicinity of the features. 

Using the functionality available on Command Panel you can: 

 Check the mesh quality (including checking the mesh quality of individual elements: volumes, surfaces, curves); 

 Modify the generated mesh (Refine, Smooth, Delete); 

 Renumber the elements and delete the generated mesh. 

Parallel Meshing 

Fidesys has been designed as a serial application, using a single CPU to generate its meshes. In some cases, where memory 

or time constraints are critical, parallel meshing may be necessary. Fidesys currently provides a separate application 

designed to run in parallel either on a desktop or on massively parallel cluster machines. In these cases, Fidesys can be used 

as a pre-processor to manipulate geometry and set up for meshing, however the actual meshing procedure is performed as 

a separate process or on another machine. 

Sculpt 

Sculpt is a separate parallel application designed to generate all-hex meshes on complex geometries with little or no user 

interaction. Fidesys provides a front end command line and GUI for the Sculpt application. The command will build the 

appropriate input files based on the current geometry and can also automatically invoke Sculpt to generate the mesh and 

bring the mesh back to Fidesys. 

Sculpt parameters are divided into 4 areas: Size, Mesh, Smoothing, and Parallel. 

 

The method for generating an all-hex mesh employed by Sculpt is often referred to in the literature as an overlay-grid or mesh-

first method. This differs significantly from the algorithms employed by Sweeping and Mapping, which are classified 

as geometry-first methods. Mapping and Sweeping start with the geometry, carefully fitting logical groupings of hexes to 

conform to a recognized topology. In contrast, the Sculpt method begins with a base Cartesian grid encompassing the 

geometry which is used as the basis for the mesh. Geometric features are carved or sculpted from the Cartesian grid and 

boundaries smoothed to create the final hex mesh. The obvious benefit of the Sculpt (mesh-first) method over Mapping and 

Sweeping (geometry-first) methods is there is no need to decompose the geometry into mappable or sweebable components, 

a process that can often be very time consuming, tedious and sometimes impossible. Input to Sculpt can be any geometry 

regardless of features and complexity. 
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The basic Sculpt procedure is illustrated in figure 1. Beginning with a Cartesian grid as the base mesh, shown in figure 1(a), 

a geometric description is imposed. Nodes from the base grid that are near the boundaries are projected to the geometry, 

locally distorting the nearby hex cells (figure 1(b)). A pillow layer of hexes is then inserted at the surfaces by duplicating 

the interface nodes on either side of the boundaries and inserting hexes (figures 1(c) and (d)). While constraining node 

locations to remain on the interfaces, smoothing procedures can now be employed to improve mesh quality of nearby hexes 

(figure 1(e)). 

 

 

Figure 1. The procedure for generating a hex mesh using the Sculpt overlay grid method 

New meshing capabilities let you cut out the overlay mesh using the STL geometry definition. This is useful when the block 

definition in the source mesh does not exactly match the STL geometry. Also, a new calculate_ss_stats option will report 

the surface area statistics of the resulting side parts in the original mesh. This is often useful for microstructures where it is 

important to know the interface area between materials. 

 

New options for creating a hexahedral mesh using the Sculpt method 
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Voxel Mesh 

Applies to: Volumes. 

Summary: A voxel mesh will be create for a volume. 

Settings: Command Panel, Mode - Mesh, Entity - Volume, Action - Mesh, Voxel. 

 

Syntax: 

voxelmesh x [y ] [z ] [use_api] 

Where 

 x, y, z - voxel sizes; 

 use_api - a parameter indicating the use of api during grid generation (set by default). 

 When constructing a voxel mesh, a block is created for each layer, to which a material must be assigned in the 
future. 

Discussion: The word voxel is derived from the word VOLume and the abbreviation piXEL (pixel stands for PICture'S 

ELement, image element). That is, it is translated as “element of the volumetric image” or “element of the volume of the 

image”. A voxel is an element of a three-dimensional image. An analogue of a hexagonal mesh. 

Voxel mesh examples  
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Setting Material  

Set the Material 

CAE Fidesys  supports the following materials: 

 Hooke material; 

 Orthotropic material; 

 Transversely isotropic material; 

 Mooney Rivlin material; 

 Material Blatza-Ko; 

 Murnaghan material; 

 Elastoplastic material (Mises criterion, Drucker-Prager); 

 Thermoelastic material; 

 Poroelastic material (Bio Model). 

For Mooney-Rivlin and Murnaghan materials, the following defining relations are used. 

Mooney-Rivlin potential: 

, 

where D, С1, С2 are Mooney-Rivlin material constants. 

Relation of D, С1, С2 and Poisson's ratio : 

. 

Murnaghan potential: 

 

where , G, C3, C4, C5 are Murnaghan material constants. 
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To set the new material, select the setting material properties section on Command Panel (Mode –Materials, Entity – 

Materials Management). 

 

 
 

Material properties are set in the Materials Management widget. 

 

 
 

Next, using the “drag & drop” method, add the necessary characteristics from the left column to the Material Properties 

column. 

Select the desired characteristic with the mouse. Hold down the left mouse button and drag the label to Material Properties. 

Double-click in the Value field opposite the property that appears and specify the correct value. 

The right column shows the preset materials. To use these materials in the calculation also drag the material of interest into 

the Materials column (where the active materials are located). Click the Apply button. 

Upon successful addition, the created materials should appear in the Model Tree in the Materials section. 
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Note:  Use Block to link the material and the model. 

Setting tabular dependencies for materials 

To create tabular dependencies for material characteristics, double-click in the Value field opposite the desired property. A 

button with a triple point will appear. Click this button. The Edit Table widget opens, where you can set table dependencies. 

 

 

To specify a formula dependence,  enter the appropriate formula in the Value field and then click Apply. 
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Import/Export Material 

To import materials right-click in the Imported Material column. Select Import in the context menu. Specify the path to the 

imported material. 

Panel settings for an existing material change, if an added material with the same name already exists in previously imported 

materials: 

• If it is allowed to overwrite it, tick the Overwrite checkbox. 

• If you need to add a new one, put the Append checkbox, and the material will be added with renaming. 

• By default, the check is set to Ignore - the material is not imported, the previous material remains. 

Click Apply. Next, drag the imported material into the active materials column (Material). Click Apply. 

CAE Fidesys supports importing material in XML format.  

 

To export the created material, right-click the material name, select Export in the context menu. Specify the path to save the 

file, click Apply. 
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If the value of a property is not entered, then by default it is assumed to be zero (except for the shear modulus, which is 

determined automatically based on the entered values of E and ν). 

Setting the Yielding Model  

The choice of the correct model of the material plastic flux is very important to obtain a proper solution of the problem. 

Plasticity problems are nonlinear, therefore, they require substantial computer resources and solving problems with large 

plastic strains may take a long time. The Fidesys system of strength analysis for the Hook material realizes two criteria of 

transition into plasticity: the Mises criterion and the Drucker-Prager criterion. Problems are solved both for perfectly 

elastoplastic models and for models with linear hardening. An approach taking into account finite strains in the elastic zone 

is currently implemented; the linear formulation of the problem is used in the zone of plastic flux. 

Von Mises Yield Criterion  

To add the Mises plasticity to the Hook material, select the section for setting material properties on the Command Panel 

(Mode - Blocks, Entity - Materials Management). 

 

Specify the name of the material. From the left column, drag the Hooke Material inscription into the Material Properties 

column. Fill in the Values fields accordingly: 
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To create the model with the von Mises plasticity without hardening, set elastic properties of the Hook material as well as 

the yield strength: 

 

To obtain a model with von Mises plasticity with linear hardening, it is also necessary to enter either the tangential modulus 

(type 1) or the ultimate tensile strength and ultimate plastic tensile strains (type 2): 
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Drucker-Prager Yield Criterion  

There are two ways to specify the Drucker-Prager plastic model in the CAE Fidesys software package - “First Drucker-

Prager Criterion”, “Second Drucker-Prager Criterion”, which become available in the “Materials Management” widget 

after specifying elastic constants. 

“First Drucker-Prager Strength Criterion” implies the setting of the material properties “Yield strength”, “Yield 

strength for compression”: 
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To use the "Drucker-Prager Second Criterion " it is necessary to enter the properties of the material "Cohesion", "Internal 

friction angle", "Dilatancy angle ": 

 

To obtain a Drucker-Prager plasticity model with hardening, also specify the limits of strength and ultimate strain for tensile 

and compression (available for both the first and the second plasticity criterion according to Drucker-Prager): 



CAE Fidesys — User Guide (version 5.1)           32 

 

 

 

 

Polylinear hardening 
 

Also, with the Mises plasticity or Drucker-Prager plasticity more general type of hardening is available in CAE Fidesys - 

polylinear hardening, for which you need to fill in the table property of the material “Sigma(epsilon) curve” material (in 

the table pairs of values from the strain on plastic component “plastic component of deformations ” - “ true stress 

"): 

 

11
11s
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Element Types (for Yielding Models)  

CAE Fidesys supports the solution of elastoplastic problems for the following types of already existing finite elements: 

– Solid elements (3D/2D). 

Orthotropic Thermoelasticity 

To calculate orthotropic thermoelasticity, it is necessary to set elastic (Ex,Ey,Ez, nuxy,nuxz, nuyz, Gxy, Gxz, Gyz) and 

thermoelastic (α1, α2, α3) characteristics of the material. In the case of calculating an orthotropic volumetric body, the 

constants will refer to the CS of the block, in the case of orthotropic thermoelasticity of shells, to the CS of the shell elements. 

The CS of the shell elements are determined by projecting the CS of the shell block onto the plane of each element, taking 

into account the fact that in each shell element the Z axis will necessarily be perpendicular to the element plane, X will be 

the projection of the CS block onto the element plane, and Y will be perpendicular to X and Z. 

Blocks Operations  

A block contains an element type, ID and the name of the geometric model of the material. It is recommended to create 

several blocks if several materials or several types of geometric entities are used in the calculation. 

For example, if a structure contains solid and shell elements, it is necessary to create a block for each type of element. If the 

construction consists of beams with different types of sections, then for each type of section you need to create your own 

block. 

The sequence of operations with blocks can be schematically represented as follows:  

 Create block specifying geometric Entity ID; 

 Assign the material to the block; 

 Assign the element type to the block. 

Let us consider these steps in detail.  

1. To create a new block go to Mode – Blocks, Entity – Block, Action – Add. 

2. In the Entity list drop-down menu, select the type of geometric objects that will be included in the block. 

Click Apply. 

You can find out the ID of the geometrical entities united into the block as 

follows:  

 in the Model Tree on the left;  

 by clicking on geometrical objects you are interested in – their ID will 

automatically appear in the appropriate field. 

 

The block ID field requires a serial number. 

  

 

 

 

 

 

 

 

 

Note: Created block is displayed in the Model Tree on the left in the section Blocks.  
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To look through the list of the geometric entities united into the block, enter in Command Line  

List block 1. 

In the Console, you will see the list of entities united into the block. 

 

3. To assign the material and the element type to the block, select Block – Block Prorepties/Parameters. 

To assign a material to a block, select one of the available (pre-created) materials in the Material drop-down list. 

To set a coordinate system for a block, select one of the available (pre-created) coordinate systems in the corresponding 

drop-down list. 

The choice of the category of elements depends on the desired characteristics of the model itself. In the Category field, 

select the item that corresponds to the entity of the object added to the block. The following categories are available in CAE 

Fidesys for the respective element types: 

 Solid: SOLID 

 Plane (2D): PLANE 

 Shell: SHELL 

 Beam: BEAM 

 Spring: SPRING 

 Point mass: LUMPMASS 

 POINT 

For more information about the types of elements, see the section Types of elements (CAE Fidesys Help). 
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If no element type is assigned to the block, the program selects it by default based on the type of geometric object contained 

in the block. In this case, the following rules are used: 

 In volumes, meshes are generated from SOLID elements 

 Meshes are generated on surfaces from SHELL or PLANE elements 

 Curves generate meshes from BEAM or SPRING elements 

 Vertices correspond to single-node LUMPMASS elements 

 Spring: SPRING 

 Point mass: LUMPMASS 

Depending on the selected element category, a special button may appear below to set specific properties of 

a beams, shells, springs or point mass elements. When you click on the button, a new window should appear with fields for 

entering the properties of the specified elements. 

To set the order of the element, specify. Thus, order 2 corresponds to the choice of an element of the second order, where 

intermediate nodes are added on the faces. The order of element 3 and further means that the calculation will be carried out 

by The Spectral Element Method of the corresponding order. 

 NOTE: Nodes corresponding to the higher order of approximation are positioned according to curved geometry by default. 

To change this rule, you can use the command: 

set node constraint [ON | off | smart] 

The off setting corresponds to the arrangement of higher-order nodes without regard to curved geometry. They occupy 

middle positions between the corner nodes of the elements: at the midpoints of straight edges, at the centers of flat faces, 

etc. The smart setting ensures that curvature is taken into account only when it does not degrade the quality of the elements. 

 

Setting Shell Properties  

CAE Fidesys  supports shell elements SHELL. 

To calculate thin-walled structures modeled by shell finite elements, it is necessary to specify the geometric parameters of 

shell sections: thickness and eccentricity. These geometric parameters are assigned to the element block. 

CAE Fidesys supports SHELL / SHELL4 / SHELL8 / TRISHELL / TRISHELL3 / TRISHELL6 shell finite elements, 

spectral shell elements are also supported. 

To set the properties of the shells - thickness and eccentricity - go to Mode - Blocks, Object - Block - Action - Block 

Properties/Parameters. The category when assigning an element type to a block must be Shells. 
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 When you select the Shell category, the Block Properties ID button should appear. In this case, it is possible to create a new section of 

the shell or select existing IDs.   

 

When you click on the "ellipsis" button, a new window opens for setting the necessary parameters. Specify: 

 The thickness of each layer of the shell 

 Material for each layer of the shell 

 Angle 

 Coordinate system 

 Eccentricity 

NOTE: The eccentricity for the shell element varies from 0 to 1 and determines the distance between the shell surface, considered in the 

framework of the geometric or mesh model, and the middle surface of the shell (in fact, the thickness offset of the middle surface relative 

to the upper surface of the shell in lobes). By default, the eccentricity is set to 0.5. 

  Viewing a shell section in a 3D view is possible in the CAE Fidesys preprocessor by clicking the Show 3D View button. 

3D shell cross section view is possible in the Fidesys Viewer postprocessor by clicking 3D-view button in the 

default string. 

 

Multilayer Shells 
To specify a multi-layer shell, add another row to the table and fill in as required by the task condition. 
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Rotation of the Stress-Strain State of the Layer in the Element Coordinate System 

In the case of modeling multilayer laminates with layers lying at an angle to any coordinate system, first a coordinate system is created 

for a block with shell elements. This coordinate system is projected onto each element and, accordingly, its own coordinate system  is 

formed in each element. 

When setting the laminate reinforcement scheme, it is necessary to set the thickness of each layer and the angles of their reinforcement 

relative to the SC of the block elements. Thus, to analyze the stresses in the layers, it is necessary to derive the stresses in the SC of the 

layer. In this case, XX stresses can be interpreted as stresses along the fibers, YY stresses across the fibers, and XY as shear stresses in 

the layer. 

To display stresses in the element (and layer) coordinate system, it is necessary to use the "Coordinate systems" filter in the 

postprocessor: Filters - Alphabetical index - Coordinate systems. 

Derivation of Stresses by Layers 

To display stresses in a layer of a multilayer shell in Fidesys Viewer, you must use the "Coordinate system 

Conversions" filter. 

In the "Properties" of the applied filter, it is necessary to select the voltages in the corresponding layer as an 

input array and select the corresponding layer number in the "Layer coordinate systems" tab. 
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After applying this filter, an array of stresses in this layer will appear in the coordinate system of this layer. 

 

 Result: 
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Setting Beam Properties  

CAE Fidesys  supports beam elements BEAM.  

To calculate structures modeled by beam finite elements, it is necessary to specify the geometric parameters of the 

sections of these elements. The geometric parameters of the sections are assigned to a block of elements. 

CAE Fidesys supports first and second order beam elements -BEAM / BEAM2 and BEAM3, respectively. To define the 

sections of beams using geometric characteristics or moments of inertia, go to Mode - Blocks, Object - Block - Action - 

Properties / block parameters. The category when assigning the element type to a block must be Beams. 

  

 

When you select the Beam category, the Block Properties ID button should appear. In this case, it is possible to create a new section of 

the beam or select existing IDs.   
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When you click on the "ellipsis" button, a new window opens for setting the necessary parameters. Specify 

 block ID; 

 quality of the cross-section mesh; 

 angle of rotation of the local coordinate system; 

 section profile and corresponding dimensions to it. 

Click Apply. 

  

CAE Fidesys supports the following beam cross sections types: 

 Rectangle; 

 Ellipse; 

 I-Beam; 

 Channel; 

 Corner; 

 T-Beam; 

 Z-Beam; 

 Hollow Rectangle; 

 Trough profile; 

 Circle With Offset Hole; 

 setting the section using moments of inertia. 

 

The 3D view of the beam section is possible in the CAE Fidesys preprocessor by clicking the Show 3D Beam 

View button. 

 

3D beam cross section view is possible in the Fidesys Viewer postprocessor by clicking 3D-view button in the 

default string after the calculation is complete 

 For sections defined using moments of inertia only, the 3D view is not available. 

 

Specifying Sphere Element Properties 

CAE Fidesys supports point masses (lumpmass elements). 

To set the properties of the point mass, go to Mode - Blocks, Object - Block - Action - Properties / block parameters. 

The category when assigning the element type to the block must be Lumpmass. 
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 When you select the Point Mass category, the Set Sphere Elements Properties button should appear. When you click on 

it, a new window opens for setting the required parameters. Indicate: 

 block ID; 

 mass; 

 Inertia moment. 

Click Apply 

 View cross sections of the beam in 3D form are possible in the preprocessor CAE Fidesys when by clicking the Show 3D view 

of the beam button 

 3D point mass view is possible in the Fidesys Viewer postprocessor by clicking 3D-view button in the default 

string. 

Set Spring Properties 

 CAE Fidesys supports springs (spring elements). 

To set the properties of the spring, go to Mode - Blocks, Object - Block - Action - Properties / block parameters. The 

category when assigning the element type to the block must be Springs. 

When you select the Spring category, the Block Properties ID button should appear. In this case, it is possible to create a 

new section of the spring or select existing IDs.   

 

When you click on the "ellipsis" button, a new window opens for setting the necessary parameters. Specify: 

 block ID; 

 Spring type; 

 Corresponding to the type of spring parameters. 

3D spring view is possible in the Fidesys Viewer postprocessor by clicking 3D-view button in the default 

string. 
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Local Coordinate Systems 

CAE Fidesys can define the following local coordinate systems: 

• Cartesian; 

• Cylindrical; 

• Spherical. 

 

 

Cylindrical Coordinate System 

Cylindrical coordinate system (CCS) is usually used in axisymmetric 

problems, i.e., in such problems in which the axis of rotation can be 

distinguished. CCS is used for fastening in radial, tangential or axial 

direction. 

In CAE Fidesys, for the correct use of the CCS, the X axis must be located 

along the axis of rotation, while the position of the Y and Z axes is not so 

important. In this case, the X direction will be responsible for the radial 

direction, Y for the tangential direction, Z for the axial direction. When 

setting the boundary conditions in which the CCS will be used, this should 

be taken into account - which axis in the CCS is responsible for which 

direction. 

For example, for the cylinder segment shown in Figure 1, the X-axis of the CCS must be directed along the Z-axis of the 

global coordinate system. In this case, the X component of the boundary condition in the CCS will be responsible for the 

radial direction, Y for the tangential direction, and Z for the axial direction. 

In the coordinate system settings widget, you can use direction cosine values in the global coordinate system, numbers of 

reference nodes or vertices. 
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Spherical Coordinate System 

Spherical CS (SCS) are used for fastening in the radial direction and around two axes Y and Z. Thus, when specifying 

spherical CS, it is necessary to specify the center point of the CS, from which the radius will be counted, and the direction 

of the X and Y axes. The Z axis will be perpendicular to them. 

In the figure below, X-clamping means radial clamping, Y and Z-clamping means rotational clamping around these axes, 

respectively. 

 

It should be noted that fixation along the Y component will mean fixation of the theta angle, which is in the plane of the 

radius vector from the center of the CS to the node and the Z axis. Thus, depending on the position of the body relative to 

the axes, fixation along Y can mean either fixation from rotation y-axis, or fixation from rotation around the x-axis, as 

shown in the example below. 

When you rotate a segment around the Z-axis by 90 degrees, pinning along the Y-axis in a spherical CS will result in pinning 

around the X-axis. 
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Setting Boundary Conditions  

Types of Boundary Conditions  

CAE Fidesys  supports boundary conditions of the following types:  

 Force; 

 Pressure; 

 Displacement; 

 Distributed Force; 

 Gravity; 

 Stress; 

 Acceleration; 

 Velocity; 

 Angular Velocity; 

 Coupling Constraint; 

 Contact; 

 Absorbing BC; 

 Temperature; 

 Convertion: 

 Heatflux; 

 Pore Pressure; 

 Directional Restraint; 

 Periodic BC; 

 Radiation; 

 Heat Sourse; 

 Volume Heat Sourse; 

 Fluid Flux; 

 Fluid Sourse; 

 Volume Fluid Sourse;  

 Additive Printing. 

 

To set boundary conditions, follow these steps: 

1. Select Mode— Boundary conditions on Command Panel. 

2. Select Boundary Condition Type in Entity block. 

3. Select Action — Create. Set the following parameters: 

 ID/Name (assign a new ID, enter a name using letters and/or numbers, or use the system assigned ID); 
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 Entity where the boundary condition is applied (Volume, Surface, Curve, Edge, Vertex, Node, Nodeset, Element, 

Side, Sideset); 

 Entity ID(s) (point mouse cursor at the field Entity ID(s) and select the necessary entities with a mouse, their 

numbers will be entered into the field automatically. If you need to specify several entities, mark them holding 

down the Ctrl key); 

 Other parameters (Value, DOFs, etc.). 

4. Click Apply. 

Using the functionality available on Command Panel you can also see the list of Boundary Conditions, modify or delete the 

boundary condition you previously set. 

 

Setting Initial Conditions 

Types of Initial Conditions 

 CAE Fidesys supports the following initial conditions 

 displacement 

 speed 

 angular velocity 

 temperature 

 pore pressure 

 initial stress (set in Materials Management) 

 

 

Time/Coordinate Dependency 

The time/coordinate dependency can be specified separately for each type of boundary conditions using tabular and 

formulaic dependencies.  

The boundary conditions are set in advance (Mode – Boundary Conditions)..  

 

To set the formulaic dependency on Command Panel, select Mode – BC Dependency, and in the appeared form: 

 Select BC Type; 

 Select an individual component or an entire vector for time dependency application; 

 Select Dependency Type (formula can be entered manually, you can use the standard formulae for the time 

dependency); 

 Set Dependency Parameters. 
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Click Apply. 

To view a tabular data or graphs plotted by a given formula, go to the corresponding tabs in the window BC Dependency. 

In addition, there is a possibility to export tabular data or to import new tables. 

 

 
 

Here are standard formulae for the time dependency: 
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 Viewing of the tabular data corresponding to the formula -100*sin(x): 

 

 
 

Viewing of the graph corresponding to the formula -100*sin(x) 
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Setting Contact Interaction  

Contact problems are highly nonlinear and require significant computer resources to be solved. Thus, to select the model 

resulting in the most effective solution, it is very important to understand the physical content of the problem. Two factors 

determine nonlinear nature of contact problems. Firstly, the contact area and therefore the boundary conditions are unknown 

until you get the solution. Secondly, it is necessary to take friction into account in many contact problems. Effects related 

to the friction can result in poorly converging problems. 

Contact Region  

To set contact areas, select the Contact dialogue (Mode - Boundary conditions, Entity - Contact) 

CAE Fidesys implements node-surface and node-curve contact interactions. 

 

Note: if contact conditions are not specified, then the parts in the assembly do not 

interact. The interaction of assembly parts through the specified contact area 

means an obstacle to the mutual penetration of parts and the transfer of loads. 

It’s recommended to assign contact zones to separate surfaces in 3D and lines in 

2D. The contact regions should be large enough so that the process of interaction 

of bodies does not outstep, but at the same time it is recommended to minimize 

these regions to save computer resources. 

Specify which of the entities will be the Master, and which - the Slave. 
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The Master is simulated by surfaces, and the Slave - by nodes. 

When building a contact pair, you should keep in mind that the choice of Master and Slave can cause various results and 

influence  the accuracy of the solution. 

Recommendations for the selection of Master and Slave entities: 

 If one surface (A) is flat or concave, and the other surface (B) is a sharp edge or bulge, then surface A should be the 

Master. 

 If both contacting surfaces are convex, then the Master surface is assumed to be less convex. 

 If both surfaces are flat, the choice of Master and Slave entities is arbitrary. 

 If one contact surface has a sharp edge, and the other one does not have it, then the first is taken as a Slave surface. 

 If one of the contacting bodies is rigid, then its surface is assumed to be the Master. 

 In some cases it is useful to create a symmetrical contact. In addition, each surface is defined as the Master, and as 

a Slave. It’s possible to simulate, for example, the contact of two areas with sharp edges or grooved (undulating) 

surfaces by this methods. 
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Contact Types 

General - the type of contact, which takes into account the force of sliding friction, proportional to the normal reaction. The 

area of contact can be different. 

It contains both areas of adhesion and areas of sliding, which occurs with an increase in the modulus of the tangential force 

of the limiting value of the friction force (static friction). The indicated coefficient of friction must be non-negative. 

Tied - a type of contact in which the main and side objects are connected ("tied") to each other and the contact area does 

not change under the action of the applied load. Slippage between faces or ribs, as well as their separation (disconnection) 

is not allowed. 

Tied Normal - a type of contact similar to connected, in which the separation of the main and secondary objects in the 

normal direction is not allowed, but slipping of the contact surface is allowed. 

Tied Tangent - a type of contact, similar to the connected one, in which the slipping of the main and secondary objects 

along the tangent is not allowed, but the opening of the contact surfaces is allowed. 

Autoselection of Contact 

CAE Fidesys implements the automatic definition of contacting entities. To do this, select Autoselect in the drop-down list 

and select the corresponding entity in the Geometry panel. 

 

You will see the applied contact pairs on the left side of the screen in the objects tree. Click the name of the desired contact 

region in the Model Tree to visualize, and it will be highlighted on the model. 

Offcet - is the distance between bodies at which contact interaction started. It can be considered as the size of a rigid body 

between the contacting bodies. 
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Each contact pair has an individual number (ID) and a set of properties. The number of contact pairs is not limited. To 

visualize the created contact pair, click the name of the required contact pair on the left in the same tree of objects. The 

selected pair will be highlighted in yellow on the model. 

 

The following contact pair settings are available in CAE Fidesys: 

• Tolerance (affects the search for contact pairs, as well as the behavior of the contact interaction 
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throughout the calculation) 

• Type (General, Tied, Tied Normal, Tied Tangent) 

• Friction Value (for general contact) 

• Offset (for bolt preload) 
• Method 

To simulate a bonded contact, select the type of contact Tied. Then, if the contact is created, Master and Slave entities 

merge in all directions so that displacements and stresses are continuous through the contact zone. 

If the motion of a rigid body is limited only by contact conditions, it is important to ensure that the elements of the contact 

pair are in interaction in the initial state. However, in some cases, the definition of interaction can be difficult. This can 

occur in the following cases: 

 body contours can be complicated, and it is difficult to define the point at which the first contact will occur; 

 in spite of the fact that the geometric model is constructed without gaps, floating point errors arising while 

meshing the model can lead to the appearance of small gaps/overlaps between the elements. 

For the same reasons, an initial penetration of the Master entity into the Slave one can occur. In these cases, excessively 

large reactive forces may appear in the contact elements, and this may lead to a divergence of the solution. 

Therefore, the definition of initial contact is perhaps the most important aspect of building a model for contact analysis. 

Contact Algorithm 

CAE Fidesys implements the following contact algorithms: 

 Penalty, 

 Multipoint Constraint (MPC). 

For the Auto method, the program automatically selects one of the listed algorithms for solving the contact problem. 

The Penalty method is a contact method that requires the setting of contact stiffnesses, that is, the stiffnesses of elastic 

elements (virtual springs) added by the program to connect between contacted objects. 

The stiffness value is calculated by the program independently depending on the properties of the material of the deformable 

elements, but the user can scale it by multiplying by the required coefficient. 

The choice of an appropriate contact stiffness factor is an important task, since an overestimated value can lead to a 

divergence of the problem, and a too small one can lead to mutual penetration of the contacting bodies. 

By default, the contact stiffness multiplier is equal to 1 along the normal and 0.5 along the tangential. 

The MPC method is a contact method using connection equations; not nodes are used, but integration points (Gaussian). 

The MPC method imposes the requirements of lack of penetration and equality of normal stresses, for which the direct 

elimination method is used. This approach does not require selection of stiffness and gives a solution in one iteration (if the 

contact zone does not change). 

General recommendations for choosing a multiplier for normal contact stiffness: 

• for problems with a predominance of bending and movements of rigid bodies, a value from 0.001 to 0.1 is recommended; 

• for problems with pair contact, the normal coefficient of contact stiffness can be up to 1000, and for other contact models 

up to 1. 

General recommendations for choosing a multiplier for tangential contact stiffness: 

• for problems with a predominance of bending and tangential displacements of rigid bodies, it is recommended to reduce 

the value; 

• The maximum value is 0.5, the minimum value is limited to 0, but it is not recommended to set values less than 0.01. 
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Elements Type 

CAE Fidesys computational algorithms make it possible to simulate a contact with non-conformable mesh. It does not 

require the use of any special finite elements in the contact area to denote the interaction of parts. This approach allows to 

easily set the conditions for interaction in contact or for connected surfaces. 

CAE Fidesys supports the solution of elastoplastic problems for the following types of existing finite elements: 

 Solid elements (3D); 

 Plane elements (2D). 

Contact Status 

The behavior of each contact element can be visualized in Fidesys Viewer by the Contact Status field. 

This field has one component, which has one of the following values: 

• STATUS = 0 – no contact; 

• STATUS = 1 - the contact is defined for the master surface; 

• STATUS = 2 - contact defined for slave surface; 

• STATUS = 3 – contact without tangential slip; 

• STATUS = 4 - Tangential sliding contact. 
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Bolt Pretension 

Bolt pretension - a specific type of load that occurs when bolts and studs are tightened - tensile stresses occur in the body 

of the bolt / stud. Pretension can be modeled using CAE in two ways: 

 direct modeling of a threaded connection, taking into account the contact in the threads and threads and the rotation 

of the nut/bolt, which is an unreasonably resource-intensive procedure 

 engineering approach - when tensile stresses are created by cutting the bolt in half and applying forces to the cut 

surface, thereby creating interpenetration of the bolt halves into themselves. To implement this type of loading, 

CAE Fidesys uses such a type of contact as "tangentially connected", which allows the contact surfaces to 

interpenetrate each other, but does not allow their relative transverse displacement (due to which the integrity of the 

bolt body is violated). supported) and also allows you to set the preload in Newtons via the pin settings. 

 

The result, after turning off the flange display through the "Threshold" filter, will look like this: 
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Starting Calculation  

Analysis Types  

 

CAE Fidesys includes the following types of analysis: 

 Static; 

 Dynamic (transient); 

 Modal; 

 Frequency Analysis (Harmonic); 

 Buckling; 

 Effective Properties; 

 External Integration MBD; 

 Topologiсal Optimization; 

 Additive Printering (by commands). 

 

When starting calculation follow these steps: 

1. Select Mode – Calculation settings on Command Panel. 

2. Select the necessary type of analysis: Static, Dynamic, Modal, or Effective properties analysis. 

3. Set the parameters of the type of analysis you chose: solver type, coordinate system, fields, scheme, time settings (for 

dynamic analysis), etc. 

4. Click Apply. 

5. Click Start Calculation. 

You may see the process of calculation in the console. It will also output the messages for the user, including the errors in 

case of unsuccessful or incorrect end of the calculation. If the system ends the calculation successfully, you will see the 

“Calculation finished successfully at <date> <time>” message in the console. 

All the calculations are made in Cartesian coordinate system by default. If necessary, you can also convert the results into 

cylindrical and spherical coordinate systems (use the appropriate filters in Fidesys Viewer). 

The dimension of the calculated problem is 2D or 3D. The following types of 2D problem are included: 
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 Plane stress; 

 Plane strain. 

Stress, strain and displacement fields are calculated by default. If necessary, you can also calculate principal stresses, strains, 

and Mises stress intensity (use the appropriate filters in Fidesys Viewer). 

The following types of solvers of linear systems (systems of linear algebraic equations (SLAE)) appearing while discretizing 

the problem, are available: 

 Direct (LU) 

 Iterative. 

The following solvers for problems of modal analysis at systems of linear algebraic equations (SLAE) are available: 

 Krylov- Schur; 

 Arnoldi. 

For dynamic load, one of the two calculation schemes can be used: 

 Explicit 

 Implicit. 

Mechanical Models  

The following mechanical models are supported: 

 Elasticity; 

 Plasticity; 

 Nonlinear geometry; 

 Heat transfer; 

 Pore Fluid Transfer. 

To choose a model, the user selects the appropriate checkboxes. Selecting multiple checkboxes simultaneously allows 

setting various combinations of models. For example, the selection of the checkboxes Elasticity and Plasticity gives an 

elastoplastic model and the selection of the checkboxes Elasticity and Thermal conductivity gives a model of 

thermoelasticity. 

To improve the convergence of nonlinear problems, use the following settings: 

 



CAE Fidesys — User Guide (version 5.1)           58 

 

 

For nonlinear problems, check convergence of iterations at each loading step in the file Convergence.txt. The file is 

downloaded into the folder that is created next to the file * .pvd which stores the calculation. 

For effective performance of several calculations you can use the Results on Command Panel (see the section Result 

Analysis). 

For visualization and analysis of the obtained results you can use the program Fidesys Viewer included into the package. 

Multistep Solution 

Setting Steps for Boundary Conditions 

In CAE Fidesys it is possible to specify a multi-step loading through tabular dependence on time or through explicit 

assignment of steps. 

The tabular dependency is set in the section Set time and/or coordinate BC dependency, and you should set the time 

dependency flag. Setting the load like: 

 

Time Value 

1 5 

2 0 

means a linear decrease of the value from 5 to 0. 

 

Explicit assignment of steps for boundary conditions occurs in the Load step settings window (Mode - Calculation settings 

– Static - Set load steps count). 

Enter the required number of calculation steps. To open the window of load step settings, click the icon . 

Next, specify the required settings: 

 Select the BC; 

 Click in the left column for the boundary condition for which you want to set active steps of calculation. 

 Set the active calculation steps for the selected boundary condition in the corresponding field. 

 Setting active steps is possible in the format: "all", "1 2 3 to 5", "1 to 5". 

Click Apply. 
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An example of a problem using active calculation steps for boundary conditions (at each step a new movement is added): 

 
The solution of the same problem in CAE Fidesys: 

 

 

Setting Steps for Blocks (Volumes) 

 

CAE Fidesys allows you to add or remove blocks (volumes \ surfaces added to the block) at specified loading steps. 

 

Adding or excluding blocks in the calculation process takes place in the Setup of load steps window (Mode - Calculation 

Settings - Static / Transient / Buckling - Set load steps count). In this case, all operations occur on the basis of blocks, 

therefore for all geometric entities it is better to create a block in advance. 

Go to the Settings loading steps window. On the general solver settings panel, enter the required number of calculation steps 

and click the icon . 

Next, specify the required settings: 
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 Select the Blocks; 

 Click on the block in the left column; 

 Set the active calculation steps for the selected block in the corresponding  field; 

 Setting active steps is possible in the format: "all", "1 2 3 to 5", "1 to 5". 

Click Apply. 

 

 

 

An example of a problem with using active calculation steps for boundary conditions (at the first step, the model is 

compressed, at the second step one of the fixings is removed, a new volume is added to the deformed model, now two 

volumes are combined to compress): 

 
The solution of the same problem in CAE Fidesys: 
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Detailed examples are given below in the Step-by-Step User Guide. 

 

Spectral Element Method 

 

It is a unique feature of CAE Fidesys  that, in addition to the finite element method (FEM) used by default, enables 

calculations by spectral element method (SEM).  

SEM Brief Description and Advantages 

Spectral element method (SEM) is a FEM modification where piecewise functions are used as basic functions consisting of 

high degree polynomials.  

The main advantages of SEM in comparison to FEM: 

1. High computational speed as there is no need to solve the system of linear algebraic equations due to diagonal form 

of mass matrix. The latter is obtained by specific quadrature formula for volume integration. 

2. High precision of solution approximation at coarse meshing (low number of elements). The solution error is estimated 

as  

, 

where  

 for FEM 

and  

 for SEM. 

 are constants,  is a characteristic element size,  is an element order,  is a numerical solution,  is an 

exact solution in mesh nodes. 

3. Ability of effective paralleling for OpenMP, MPI and CUDA.  

SEM is most effective for the dynamic analysis using an explicit time scheme.  

Here are the results of classical problem of wave propagation in 2D plate (size 1x1). 
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To achieve the computational error 2% and less, it is necessary to generate one of the following meshes: 

a) 3-noded triangular mesh of 6 390 197 elements (characteristic element size is 4e-4); 

b) 4-noded quadrilateral mesh of 1 640 961 elements (characteristic element size is 3e-3); 

c) coarse spectral element mesh with 4th element order (only 16 elements are required). 

 

 

Fig.1. The distribution of the field of displacement 

magnitude U across the plate  at the time t1 

 

Fig.2. The distribution of the field of displacement 

magnitude U across the plate  at the time t2 

Here are the examples of computation results for different spectral element orders: 

 

 

 

2nd spectral element order 

 

4th spectral element order 
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8th spectral element order 

 

12th spectral element order 

 

SEM Usage  

To use the method of spectral elements instead of the finite element method to solve the problem, set the order of elements 

3 and higher (except springs and sphere elements): 

  
 

  



CAE Fidesys — User Guide (version 5.1)           64 

 

 

Heterogeneous Materials Effective Property Calculation  

In CAE Fidesys  there is the possibility of calculating the effective properties of an heterogeneous material, for example, 

composite or porous material. 

Geometry of the Model for Effective Property Calculation  

A representative volume is a geometric model for calculating the effective properties of the material of nonperiodic 

structures, i.e. the volume of the material by which you can judge the behavior of the material under deformation in general. 

This typically means that the size of the representative volume should be approximately an order of magnitude greater than 

the characteristic pore size or the inclusions in the material. A periodicity cell may be a geometric model for the calculation 

of the effective properties of periodic structure material. 

It is important that the geometric model for the calculation of the effective properties must always be a fragment of material 

«cut» out of it in the form of a rectangular parallelepiped. When calculating, this fragment should be positioned so that 

the edges of the parallelepiped were strictly parallel to the coordinate planes. The system doesn’t provide the automatic 

checking of the model form and position to calculate the effective properties, so the user ahould control this – otherwise the 

calculation can be correctly completed but the results will be misleading. 

Examples of valid models for the calculation of the effective properties are shown below. If the tested material is solid (left), 

then the model for calculating its effective properties must be a solid rectangular parallelepiped with edges parallel to the 

coordinate planes. If the material contains pores or cavities, then the model for the calculation must contain cavities that 

may come to the surface (as shown on the right).  

  

  

CAE Fidesys  can perform the generation of periodicity cell geometry of some composite materials with periodic structure 

automatically. In the geometry control mode, there is a button «Create Composite» as shown below. 

 

You can create periodicity cells of the following composite types  

 Fiber-layered (two-layer) composite; 

 single-layer fiber; 
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 single-layer fiber with shells; 

 dispersed fiber reinforced (spherical inclusions); 

 dispersed fiber reinforced with shells. 

The user needs only to set the parameters of materials and click "Create" - the geometry will be generated automatically by 

means of the CAE Fidesys  interface. The user can also create the geometry for the calculation manually by means of the 

interface or by import. The most important thing is that the geometric model for the calculation of the effective properties 

is «cut» out of the material in form of the rectangular parallelepiped with edges parallel to the coordinate system in the CAE 

Fidesys  interface. 

Starting Сalculation  

After creating the geometry, it is necessary to carry out the same actions as 

when calculating for static load: blocks creation, finite element mesh 

generation, material properties setting, etc, except for the boundary conditions 

application. To calculate the effective properties, it is unnecessary to apply the 

boundary conditions to the model: when calculating a number of boundary 

conditions types are automatically applied to the model sequentially; the static 

load problem is solved for each type; results of all the problems are averaged 

and, as a result of averaging, the effective properties of the material are 

calculated. The user only needs to choose the type of boundary conditions: 

periodic or nonperiodic. 

Periodic boundary conditions are preferred if the effective properties of the 

material of periodic structure are calculated, and the periodicity cell serves as 

a model for the calculation. For example, if the material is a composite with 

matrix and inclusions, moreover, the stiffness of the inclusions is much higher 

than the one of the matrix, and the inclusions are located on the surface of the 

model for the calculation – in this case it is necessary to use periodic 

conditions. If the effective properties of the material of irregular structure are 

studied and a representative volume is a model for the calculation, then the 

nonperiodic boundary conditions are preferred. 

In CAE Fidesys the SLAE direct solver is available to calculate the effective 

properties. 

Element Types  

CAE Fidesys supports the effective properties calculation for the following 

existing finite elements: 

 Solid elements (3D); 

 Plane elements (2D); 

 Shell elements (3D); 

 Beam elements (3D). 

Beam and shell elements can only be used in 3D analysis. Beam elements can be used to model threads  / rods, the 

diameter of which is much (two orders of magnitude or more) smaller than the size of the representative volume (periodicity 

cells). Shell elements - for modeling membranes / planes, the thickness of which is much (two orders of magnitude or 

more) less than the size of the representative volume (periodicity cells). The use of beam and shell elements to simulate 

sufficiently thick rods and membranes is fraught with large errors in calculating the effective properties of the model. 

It is advisable to model such rods and membranes with volumetric elements.   
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A representative   volume or a periodicity cell can only consist of beam and / or shell elements (for example, in the case 

of calculating the effective characteristics of lattice structures, metamaterials, etc.). But in this case, it is important that 

the differences between the maximum and minimum coordinates of the model along all three axes (ie, its “overall 

dimensions”) are non-zero. If, for example, you build a rectangle in the XY plane and specify shell elements of non-

zero thickness on it, the calculation of effective properties on such a model will not work, since the difference between 

the maximum and minimum coordinates along the Z axis is zero.   

Effective Property Calculation and Its Results  

CAE Fidesys supports the calculation of such effective properties as: 

1) elastisity moduli  

2) density 

3) coefficients of thermal expansion 

4) thermal conductivity coefficients. 

1.  Effective Elasticity Moduli 

To set effective linear elastic properties calculation click "Elasticity" in the settings for calculating effective properties. To 

calculate effective properties the model undergoes a series of strains. The following types of strains are used: 

 tension (along each of the coordinate axes); 

 shears (in each of the coordinate planes). 

The strain magnitude is 0.2% for all types. 

Effective properties are evaluated in the form of the generalized Hook's law: 

 

The result of the calculation is effective elastic modules  displayed to the command line and in the file called Cijkl.txt 

in the working directory. The modules are evaluated in the coordinate system where the calculation was carried out (in 

which coordinate planes are parallel to the edges of calculation model). 

Modules  contain 21 independent constants – it is often more than it is necessary to describe effective properties of the 

tested heterogeneous material. That is why there is a possibility of the automatic conversion of the obtained effective elastic 

modules into constants of orthotropic, transversally isotropic or isotropic material. After completing the calculation of the 

effective properties, the window «Process effective properties data» opens. In the window, obtained effective elastic 

modules  are shown at the bottom right in the form of a symmetric matrix sized 6x6 (the matrix part below the main 

diagonal is not displayed because of the symmetry). 

If the calculated effective elastic moduli are unphysical, immediately after opening the data processing window a message 

will pop up, warning that the matrix is not symmetric with sufficient accuracy or is not positive definite.  In this case you 

should check again the correct choice of model for calculation:  

 if it is a rectangular parallelepiped with faces parallel to the coordinate planes  

 in the two-dimensional case, if it is a rectangle with sides parallel to the coordinate axes 

  if it is a periodicity cell in case of calculation with periodic boundary conditions. 

If the model is correct, it is necessary to improve (grind) the grid. 

When the calculation is complete, the window opens automatically. If the user closes it, it can be re-opened in the mode 

Material > Effective properties: 

klijklij
C  

ijkl
C

ijkl
C

ijkl
C
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The user can assess whether the matrix with obtained  corresponds to orthotropic materials with the acceptable 

tolerance. For the exact orthotropic material, the matrix should look as follows (where the letters X denote those components 

that can be nonzero). 

 

Since the components of the matrix are the result of numerical calculation of effective properties - they tend to contain 

some errors. If, from the user's point of view, the matrix corresponds to orthotropic materials with acceptable tolerance, 

select the «Orthotropic» type of material and click «Process Data», and the system will calculate nine constants of 

orthotropic material. If the material is not orthotropic with sufficient accuracy or if orthotropic constants turned out to be 

unphysical, when you click "Process data” the system will show you a message with a warning. 

If orthotropic constants do not depend on the direction (i.e., for example, different Young's moduli are the same or differ 

from each other within the acceptable error) then you can select the type of material «isotropic» and click «Process data» 

again. The system will calculate two constants of an isotropic material – Young’s Modulus and Poisson's Ratio. If the 

material is not isotropic with sufficient accuracy or if Young's modulus and / or Poisson's ratio are unphysical, when you 

click "Process data” the system will show you a message with a warning. 

2. Effective Density 

Density is an additive quantity. Therefore, the effective density is calculated as the mass of the model divided by the effective 

volume (including pores and voids in the material). Density is calculated automatically for any calculation of effective 

elastic moduli. 

3. Effective Coefficients of Thermal Expansion. 

Calculation of effective coefficients of linear thermal expansion is set in the settings for calculating effective properties by 

checking the box "Thermal expansion". To calculate the effective coefficients of thermal expansion, the model is subjected 

to uniform heating. The heating value is 1 K. 

Effective thermal expansion is estimated as: 

 

The results of the calculation are effective coefficients of thermal expansion,which are output to the command line and to a 

JSON file called EffProps.json located in the working directory. Coefficients are calculated in that coordinate system, in 

which the calculation was carried out (to the coordinate planes / axes of which the faces / sides of the calculation model are 

parallel). 

ijkl
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Coefficient matrix   contains 6 independent constants, often this is more than enough to describe the effective linear 

thermal expansion of the studied heterogeneous material. Therefore, it is possible to automatically recalculate obtained 

effective coefficients of linear thermal expansion into constants of an orthotropic or isotropic material. The window "Process 

data on effective properties" will appear after the calculation is completed. You may see the effective coefficients of thermal 

expansion  on the “Temperature” tab on the right in the form of a symmetric matrix of thermal expansion of size 3x3 

(the part of the matrix below the main diagonal is not displayed due to symmetry). 

If the calculated effective thermal conductivities are unphysical, immediately after opening the data processing window, the 

system will show a warning that the matrix  is not symmetric with sufficient accuracy or is not positively definite. In 

this case you should check again the correct choice of model for calculation:  

 if it is a rectangular parallelepiped with faces parallel to the coordinate planes  

 in the two-dimensional case, if it is a rectangle with sides parallel to the coordinate axes 

  if it is a periodicity cell in case of calculation with periodic boundary conditions. 

If the model is correct, it is necessary to improve (grind) the grid. 

The user can assess whether the matrix with obtained  corresponds to orthotropic materials with the acceptable tolerance. 

For the exact orthotropic material, the matrix should look as follows (where the letters X denote those components that can 

be nonzero). 

 

Since the components of the matrix are the result of numerical calculation of effective properties - they tend to contain some 

errors. If, from the user's point of view, the matrix corresponds to orthotropic materials with acceptable tolerance, select the 

«Orthotropic» type of material and click «Process Data», and the system will calculate nine constants of orthotropic material. 

If the material is not orthotropic with sufficient accuracy or if orthotropic constants turned out to be unphysical, when you 

click "Process data” the system will show you a message with a warning. 

If orthotropic constants do not depend on the direction (i.e., for example, different Young's moduli are the same or differ 

from each other within the acceptable error) then you can select the type of material «isotropic» and click «Process data» 

again. The system will calculate two constants of an isotropic material – Young’s Modulus and Poisson's Ratio. If the 

material is not isotropic with sufficient accuracy or if Young's modulus and / or Poisson's ratio are unphysical, when you 

click "Process data” the system will show you a message with a warning. 

4. Effective Biot Coefficients 

The calculation of the effective Biot coefficients is set in the settings for calculating the effective properties by 

checking the Poroelasticity checkbox. To calculate the effective Biot coefficients, fixing boundary conditions are imposed 

on the outer boundary of the model (i.e., not allowing its deformation). All internal surfaces are subjected to the same 

pressure. 

The effective poroelasticity of a material is estimated in the form of the Biot-Terzaghi law: 

ij ijkl kl ijC pI     

The result of the calculation is the effective Biot ij coefficients output to a JSON file named EffProps.json located 

in the working directory. The coefficients are calculated in the coordinate system in which the calculation was performed 

(the coordinate planes/axes of which are parallel to the faces/sides of the calculation model). 

The matrix of coefficients ij  contains 6 independent constants, which is often more than enough to describe the 

effective poroelasticity of the investigated inhomogeneous material containing pores. Therefore, it is possible to 
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automatically recalculate the obtained effective Biot coefficients into the constants of an orthotropic or isotropic material. 

When the calculation is completed, the "Process Effective Properties Data" window also appears. The effective Biot 

coefficients ij  are shown on the Poroelasticity tab on the right as a symmetrical 3x3 poroelasticity matrix (the portion of 

the matrix below the main diagonal is not displayed due to symmetry). 

If the calculated effective combat coefficients are not physical, immediately after opening the data processing 

window, a window appears with a corresponding warning about the matrix ij  asymmetry with sufficient accuracy. In this 

case, one should once again check the correctness of the choice of the model for calculation: whether it is a rectangular 

parallelepiped with faces parallel to the coordinate planes (in the two-dimensional case, a rectangle with sides parallel to 

the coordinate axes) , and whether it is a periodicity cell in the case of calculation with periodic boundary conditions. If the 

model is built correctly, it is likely that the mesh needs to be improved (refine). 

The user can evaluate whether the matrix corresponds to the received ij orthotropic material with the accuracy that 

satisfies him. For an exact orthotropic material, this matrix should look like this (here X denotes those components that can 

be non-zero). 

0 0

0

X

X

X

 
 
 
 
 

 

But, since the matrix components are the result of a numerical calculation of the effective properties, they usually contain 

some error. If, from the user's point of view, the matrix corresponds to an orthotropic material with acceptable accuracy, 

you can select the poroelastic property type "Orthotropic" and click the "Process Data" button, which will calculate the three 

orthotropic material constants. If the material is not orthotropic with sufficient accuracy, or if the Biot orthotropic 

coefficients are found to be non-physical, pressing the "Process data" button will open a window with a corresponding 

warning. 

If the orthotropic constants do not depend on the direction (different Biot coefficients are the same or differ from each other 

within the acceptable error), then you can select the material type "Isotropic" and click the "Process data" button again. One 

constant will be calculated - the isotropic coefficient of the Biomaterial. If the material is not isotropic with sufficient 

accuracy, pressing the "Process data" button will open a window with a corresponding warning. 

5. Effective Tthermal Conductivity. 

To set the calculation of the effective thermal conductivity tick “Thermal conductivity”in the settings for calculating the 

effective properties. To calculate the effective thermal conductivity coefficients, the model undergoes a series of heatings: 

the system sets different temperatures corresponding to a certain temperature gradient in the model on its faces. The system 

uses gradients directed along each coordinate axis. The effective thermal conductivity of the material is estimated in the 

form of the Fourier law of thermal conductivity:
     

                                                                                       

 

The result of the calculation is the effective thermal conductivity coefficients , output to the command line and to a 

JSON file with the name EffProps.json located in the working directory. The program calculates the coefficients in the 

coordinate system in which the calculation was carried out (to the coordinate planes / axes of which the faces / sides of the 

calculation model are parallel). 

The coefficient matrix contains 6 independent constants. Often this is more than enough to describe the effective linear 

thermal conductivity of the studied inhomogeneous material. Therefore, it is possible to automatically convert the obtained 

effective coefficients of linear thermal conductivity to the constants of an orthotropic or isotropic material. After the 

calculation is completed, the “Process data by effective properties” window also appears. Temperature tab, bottom right, 

 i ij j
q T  

ij

ij
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shows effective thermal conductivity coefficients in the form of a symmetric thermal conductivity matrix of size 3x3 (a 

part of the matrix below the main diagonal is not displayed due to symmetry). 

If the calculated effective thermal conductivities are unphysical, immediately after opening the data processing window, the 

system will show a warning that the matrix is not symmetric with sufficient accuracy or is not positively definite. In this 

case you should check again the correct choice of model for calculation:  

 if it is a rectangular parallelepiped with faces parallel to the coordinate planes  

 in the two-dimensional case, if it is a rectangle with sides parallel to the coordinate axes 

  if it is a periodicity cell in case of calculation with periodic boundary conditions. 

If the model is correct, it is necessary to improve (grind) the grid. 

The user can assess whether the matrix with obtained  corresponds to orthotropic materials with the acceptable tolerance. 

For the exact orthotropic material, the matrix should look as follows (where the letters X denote those components that can 

be nonzero). 

                                                                                                    

Since the components of the matrix are the result of numerical calculation of effective properties - they tend to contain some 

errors. If, from the user's point of view, the matrix corresponds to orthotropic materials with acceptable tolerance, select the 

«Orthotropic» type of material and click «Process Data», and the system will calculate nine constants of orthotropic material. 

If the material is not orthotropic with sufficient accuracy or if orthotropic constants turned out to be unphysical, when you 

click "Process data” the system will show you a message with a warning. 

If orthotropic constants do not depend on the direction (different coefficients of thermal conductivity are the same or differ 

from each other within the acceptable error) then you can select the type of material "Isotropic" and click "Process Data" 

again. The system will calculate one constant - isotropic coefficient of linear thermal conductivity of the material. If the 

material is not isotropic with sufficient accuracy, when you click "Process data” the system will show you a message with 

a warning. 

The calculation of the effective thermal conductivity of an inhomogeneous material can be carried out separately or together 

with calculations of effective elastic properties (in the second case, in the calculation settings it is necessary to tick the 

checkboxes “Elasticity” and “Thermal conductivity”). If the thermal expansion coefficients of at least one material in the 

model are specified in the joint calculation, the effective moduli of elasticity, the effective coefficients of thermal expansion, 

and the effective coefficients of thermal conductivity will be calculated. In the window for processing results, both thermal 

conductivity coefficients and thermal expansion coefficients are located on the “Temperature” tab. 

Processing Results and Exporting Effective Material 

The picture below shows the window exterior «Process effective properties data». 
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If the processed material constants satisfy the user, the option to export the material into the file XML is available in the 

same window. You need to select a name for the effective material and the name of the XML file into which it will be 

exported. When you click «Export Material», the system first creates the material with the name entered and with the 

obtained effective properties. Then all materials created during the calculation are exported to an XML file with the entered 

name. You can import these materials from the created file. 

If a heterogeneous material, the efficient properties of which are investigated, is orthotropic or isotropic for empirical 

reasons and the calculation results do not correspond to that – you should try to refine the mesh or to choose a model for 

calculation differently. 

 



CAE Fidesys — User Guide (version 5.1)           72 

 

 

SEG-Y Format 
SEG-Y is a sequential trail format designed for storing fully or partially processed seismic data. 

https://en.wikipedia.org/wiki/SEG-Y 
 

To record the selected calculation results in the SEG-Y format, it is necessary to place the Receivers on the model in the 

preprocessor (Command Panel, Mode - Receivers, Operation - Create).  

 
 

Select from the drop-down list the geometric entities that will be receivers. 

 

 
 

Specify which data fields to save in SEG-Y format. 

 

 
 

Installed receiver lines are displayed in the Tree on the left in the Results Settings section. 

https://en.wikipedia.org/wiki/SEG-Y


CAE Fidesys — User Guide (version 5.1)           73 

 

 

 
Viewing data in SEG-Y format is possible in the CAE Fidesys Viewer postprocessor, and you need to open the file with 

the .sgy extension. 

 

 
In Fidesys Viewer it is possible to select the required subregions of the model using the Slice / Clip filters (Menu - Filters 

- Alphabetical Index - Slice) 
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An example of the resulting SEG-Y file for Vy speed in CAE Fidesys: 

 
Features of writing data to the * .sgy file 

 

 All data in the file header, with the exception of the results themselves, are written in integer form. 

 The time step (recording step) is recorded in microseconds. 

 The coordinates of the receiver are recorded in meters (If the distance between receivers is less than one meter, 

then the coordinates of the paths may coincide, and the wave pattern may be incorrect). 

 Inline number coincides with the id of the node in which it is specified, the Crossline number matches the line 

number of the receivers. 
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Spectral Method for Solving Linear Dynamic Problems Using the Response Spectrum 

(response spectrum, reaction spectrum) 

Modal Analysis 

Calculation using the response spectrum is based on modal analysis. Before starting the calculation of natural frequencies 

and vibration modes, go to the tab Calculation settings – Modal Frequency analysis - Output field and check the Evaluate 

effective masses. 

.  

Next, start the calculation and go to Fidesys Viewer. 

Response Spectrum Setting 

The response spectrum is set in the Fidesys Viewer program. In the main menu, go to Filters - Index – Modal Combinations. 

The following settings are available in the appeared window of properties of calculation results: 
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1. The choice of the combination method of the mods Absolute sum, Square root of sum of squares, Complete 

quadratic combination; 

2. Setting the value of the modal damping coefficient Mode Damping Ratio; 

3. The way to set the response spectrum of the Dependency Type (CSV File - assignment via the csv format table, 

Formula - assignment through the formula); 

If you select CSV File in step 3, then CSV File - the path of the csv file is selected; if you select Formula in step 3, then 

Calc Function is the task of the function in which the argument is the natural frequency; 

Field Info spectral curve selection - displacement, speed, acceleration. 

 

After all the settings, click Apply. 

Further, it is possible to open the necessary result plots (for example, displacements obtained by the SRSS method will be 

available under the name Displacement_SRSS). 

 

Additive Printering 

Additive manufacturing is a technology for creating products, which is based on the gradual “building up” of material on a 

base in the form of a flat platform or axial frame. 
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Mathematical modeling of the additive manufacturing process is an important preparatory step in determining the strategy 

for manufacturing a part. The importance of this stage is primarily justified by the fact that during the production process, 

the shape of the object may be distorted due to the peculiarities of the technology, which can lead to going beyond the limits 

of dimensional tolerances or displacement of functional areas. 

Voxel Mesh and BCs 

For this calculation, a voxel mesh must be built on the model. CAE Fidesys uses the voxelmesh command for this. When 

using this command, a block is created for each layer, to which you later need to assign a material. 

To set boundary conditions when simulating additive printing in CAE Fidesys, you must use the boundary condition 

Additive printing: 

                         

You can also use the voxelbc command. 

voxelbc L <value> t0 <value> t1 <value> t2 <value> 

L (voxel per layer) - the number of layers added to the calculation in one step (or layer thickness in voxels); 

T0 - base (substrate) temperature; 

T1 is the temperature of the newly created layer; 

T2 - to what temperature the lower layer cools down at the moment of joining the upper one. 

Additionally, the voxelbc command: 

 sets the fixation in all degrees of freedom on the lower layer; 

 sets the number of steps for stepwise calculation (1+(2*total number of voxel layers/L)) 
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If necessary, changing/disabling blocks is done manually. 

Note: For the alpha version of the analysis, blocks and boundary conditions on steps are controlled through the static analysis 

settings (Set number of loading steps option). The calculation is launched directly from the Calculation Settings - Additive 

Printing section. In addition, the model must be modified so that the layers grow in the Z direction. 

Starting Calculation 

The calculation is started from the static analysis with the Additive 

Manufactered option (Command Panel - Calculation Settings - Static 

Analysis). 

Specify on the command line for static calculation: 

• Dimention 

• Model: elasticity, thermal conductivity, additive printing, geometric non-

linearity (if necessary). 

• Number of loading steps 

Click "Apply", "Start Calculation". 

The command to run on the calculation of additive printing: 

analysis type static elasticity heattrans slm findefs slm dim3 

calculation path “D:/calc/path_to_file.pvd” 

You must insert the path to the *.pvd calculation file into the calculation 

path command. 

 Modeling example for additive printing. 

1. To construct a voxel mesh, voxel sizes x=y=z=0.25 are used. The model 

was also scaled in meters. And moved so that the layers grow along the Z 

axis. The result: 
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At the same stage, 24 blocks were created (can be checked in the Tree or using the list block all command). 

2. You must define a material and assign it to blocks (for example, using the block all material 1 command) or via the GUI. 

3. Boundary condition is used Additive printing with parameters:  

 Voxels per layer: 1; 

 T0=100 T1=1300 T2=500. 

Thus, one layer is built up in one step (L=1). The total number of steps in step-by-step solution becomes 49. This is ( 

2*24+1) . 

4. Next, a boundary condition is manually added at the last step (fixing the middle of the cut layer) and the order of removing 

blocks is corrected. 

 Fastening in the last step simulates cutting off the “legs”. In order not to reassign the automatically created blocks, the faces 

of the hexahedra are fixed in the middle of the cut layer. 

The result of the solution at the last step in the postprocessor (deformed view): 
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Results Visualization and Postprocessing 

About Fidesys Viewer Software 

The Fidesys Viewer software is used for visualization and analysis of the obtained results: 

 Visualization of vector and tensor fields; 

 Graph; 

 Time dependency analysis; 

 SEG-Y files. 

You don’t need to install Fidesys Viewer individually as it is included into the CAE Fidesys  package.You don’t need a 

license to use Fidesys Viewer: the results of calculations obtained by using the CAE Fidesys  preprocessor are available for 

viewing in Fidesys Viewer even after the license expires. 

Main Window 

 

Workbench (1) displays the model and visual effects. 

Main Menu (2) includes standard operations for working with files and projects, managing the visualization modes, panel 

display settings, filters, tools, and help available in the drop-down lists of the menu. 

Toolbar (3) comprises the buttons for calling the most frequently used commands while working with the program. 

Pipeline Browser (4) includes the opened models and filters applied to them. 

Properties Page (5) displays the properties of the selected object in the Workbench or in the Pipeline Browser. 

You can show or hide additional panels in the menu View. 

Basics of the Program 

Fidesys Viewer allows you to view and analyze the results. You can do that using multiple filters selected in the item View 

in the menu. Some of them are described below. 
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Display on the data field and legend model  

Fields and components of display can be selected in the Toolbar: 

 

You can also see the Color Map by clicking in the Toolbar. 

Selection  

In order to select points or cells, use the following buttons in the Toolbar: 

 
On-screen information display  

Numerical results for the data fields can be viewed in the tab Information. If the entire model is in focus, the fields of the 

tab Information contain a range of data – from minimum to maximum value. 

The values in points can be found using the filter Probe Location (Filters →  Alphabetical →  Probe Location). Then you 

need to specify the viewing point coordinates. After applying the filter, data field values are displayed only for the specified 

point in the tab Information. 

It is also possible to view the numerical results for the selected points by clicking Point Information on the Toolbar.  

The values in the points/nodes/elements can be identified and viewed by using Selection Inspector (View 

→Selection Inspector).  

 

Overview of the strained model  

To view the strained model, select Filters →  Alphabetical →  Warp By Vector. In the Properties tab, you can select the 

display scale. 

To quickly access the filter, click Warp By Vector  on the top panel. 

 

Spherical/cylindrical coordinate systems  

To receive data from the spherical or cylindrical coordinate systems, select Filters →   Alphabetical → Coordinate 

systems. Next, select the data field that you want to represent in new coordinates. After applying the filter, a new data field 

will appear in the tab Information, for example, Stress (spher.). 

 

Graphing along straight line  

To graph along a straight line, select Filters →   Alphabetical → Graph along a straight line.  

Specify coordinates of the beginning and end of the line. In the tab View, select the appropriate data field to display in the 

graph. 

 

Graphing along curves  

To graph along a curve, select nodes (see par. Selection) for which graph will be plotted. Next, use Filters →   Alphabetical 

→ Extract selected and then Filters →   Alphabetical → Show data.  

Graphing in time dependency  

To plot a time dependency graph, you should allocate points of interest through the Allocation Inspector or by the button 

Select points in the standard string and then apply the filter Filters →   Alphabetical → Plot selection over time. 
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Estimation of the mesh quality  

To estimate the mesh quality, select View → Filters → Alphabetical → Mesh Quality. Specify the necessary settings in 

the tab Properties. After applying the filter, new fields will appear based on the analysis of which we can draw conclusions 

about the quality of the resulting mesh.  

 

Slice 

To view the model slice, select Filters → Alphabetical → Slice. Specify the normal or the direction in which you want to 

make the slice.  

 

Cross section  

To view the model cross section, select Filters → Alphabetical → Cross section. Specify the normal or the direction in 

which you want to make the slice.  

 

Beam and shell 3D-display  

To view beams and shells in 3D in the Fidesys Viewer postprocessor, you can click on the button 3D in the standard 

string. 

 

Margin of Safety 

To view the model cross section, select Filters → Alphabetical → Margin Of Safety. If the ultimate strength and yield 

strength were not specified when preprocessing, you should set them in the tab Properties. Margin of safety is calculated 

by the first theory of strength, energy theory, Tresca theory, Mohr’s theory of failure, Pisarenko-Lebedev theory. Obtained 

values can be viewed in the tab Information in the new field Margin Of Safety. The first component of the field is the 

margin of safety by the first theory of strength; the second is the margin of safety by the energy theory, etc. 

Formulas for Strength Criteria 

                  σt —  uniaxial tensile strength; 

σc — uniaxial compression strength; 

σm — tension von Mises; 

c — soil cohesion; 

φ — angle of friction; 

σ1 — first major stress; 

σ2 — second major stress; 

σ3 — third major stress; 

n — the field of the margin of safety that needs to be displayed. 

1. Calculation according to the first theory of strength. 

It is used in the assumption of brittle fracture. By contours σ1 contours of safety factors are built n = σt / σ1 

2. Calculation according to the energy theory of strength (Mises stress). 

It is used in the assumption of viscous fracture or if plastic state is not allowed. 

By contours σi isolines of safety factors are built  n = σy / σm or n = σ0,2 / σm, where σy or σ0,2 – physical or conditional yield strength. 
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3. Calculation according to the Pisarenko-Lebedev theory. 

It is used in mixed fracture. 

By fields σm and σ1 contours of safety factors are built  

, where 

 

4. Calculation according to the Mohr’s theory, mixed destruction. 

Contours of the margin of safety 

 

5. The third theory of strength by Tresk, viscous destruction or prevention of plastic flow. 

A special case from Mohr's theory for 

 

6. Mohr-Coulomb Criterion 

 - normal stress on the fracture plane 

A = c; B = - tanφ 

or 

If strength limits are specified σc and σt , then 

 

where 

a = σt + σc; 

b = σt - σc < 0 (with b > 0 the angle of internal friction becomes negative, which is unacceptable) 

Margin of safety: 
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7. Mogi-Coulomb Criterion 

 

or 

 

Safety factor 

 

8. Drucker-Prager criterion 

 

or 

 

Safety margin: 
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This criterion was developed to describe the plastic deformation of clay soils. You can also use it to describe the destruction of rocky 

soils, concrete, polymers, foam and other pressure-dependent materials. 

 

9. Navier criterion 

Another name for the Mohr-Coulomb criterion 

 - the normal stress at failure; 

A = c; B = - tanφ; 

The minus is due to the fact that compression should lead to hardening, and compression σn corresponds to negative values c = - τB - 

tensile strength (shear), which is entered by the user for each material, or cohesion; 

 

10. Hoek – Brown criterion 

Hook-Brown criterion has the form: 

 

where A, B are constants depending on the material. 

Using the average normal stress (σmean) and maximum shear stress (τmax), we get: 

 

Where  

 

The resulting expression can be transformed to a form similar to the Mohr-Coulomb criterion, resolving it with respect to 

τmax: 

 

Constants A and B, depending on the material, are related to the ultimate strength in uniaxial tension (σt) and ultimate 

strength in uniaxial compression (σc) by the following relationships: 
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Margin of safety: 
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Harmonic analysis 

To plot the frequency dependencies after performing a calculation using harmonic analysis, select Filters → Index → 

Harmonic Analysis. Specify the node number, the characteristics of which will be presented on the graph. 

 

Data saving 

To get numerical values of the obtained results, save the data in .csv format. To do it Click Ctrl+S or select File → Save. 

The saved file is an ordinary table of numerical data which can be opened in any text editor.  

For dynamic problems, saving the model variation under deformation is available. To do it Select File → Save Animation. 
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Step-by-Step User Guide 

Solving any problem using  CAE FIDESYS package includes 6 basic steps: 

 Model generating 

 Meshing 

 Setting boundary conditions 

 Setting the material 

 Starting calculation 

 Results analysis 

 See some examples with step-by-step guide below. 

Static Analysis (3D) 

NAFEMS test “Thick Plate Pressure”, Test No LE10, Date/Issue 1990-06-15/2. 

The problem of static load of a plate is being solved.  

The pictures below represent a geometric model of the problem: 

  

Displacements along the normal to the sides are constrained in the side slices of the plate. All of the points of the outer 

curvilinear surface are fixed in the XY plane. The outer curvilinear surface is fixed along the middle line of displacements 

along Z axis. The pressure to the upper side is 1 MPa. The material parameters are E = 210 hPa,  = 0.3. 

Test pass criterion is the following: stress σyy at the point D is -5.38MPa to within 3%. 

Geometry Creation 

1. Create the first elliptic cylinder. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Create). 
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Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 0.6; 

 Cross Section: Elliptical; 

 Major Radius: 2; 

 Minor Radius: 1. 

Click Apply. 

2. Create the second elliptic cylinder. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Create). 

Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 0.6; 

 Cross Section: Elliptical; 

 Major Radius: 3.25; 

 Minor Radius: 2.75. 

Click Apply. 

As a result, two generated entities are displayed in the Model Tree (Volume 1 and Volume 2): 
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3. Subtract the first cylinder from the second one . 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Boolean). 

 

Select Subtract in the list of operations. Set the following parameters: 
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 A Volume ID(s): 1 (the volumes to be subtracted); 

 B Volume ID(s): 2 (volumes from which other volumes will be subtracted); 

 Imprint. 

Click Apply. 

As a result, only one volume is displayed in the Model Tree (Volume 2). 

4. Leave a quarter of a volume (symmetry of the problem). 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Webcut). 

 

Select Coordinate Plane in the list of possible webcut types. Set the following parameters: 

 Volume ID(s): 2 (the volume to be webcut); 

 Webcut with: YZ Plane; 

 Offset Value: 0. 

Click Apply. 

Do the same for the ZX Plane: 

 Volume ID(s): 2 (the volume to be webcut); 

 Webcut with: ZX Plane; 

 Offset value: 0. 

Click Apply. 

As a result, the original volume in the Model Tree is split into three (Volume 2, Volume 3 and Volume 4). 
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Delete the volumes 2 and 3. To do this, select these volumes in the Model Tree holding down Ctrl and click Delete in contextual menu. 

As a result, a quarter of the original volume is left (Volume 4). 

5. Split the outer curvilinear surface into two (it is necessary for restraining this surface from displacements along the middle line). 

Select surface geometry modification section on Command Panel (Mode — Geometry, Entity — Volume, Action — Webcut). 

 

Set the following parameters: 

 Coordinate Plane; 

 Volume ID(s): 4 (volume to be cut); 

 Plane: XY; 

 Offset Value: 0; 
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 Put a checkmark in the Merge box. 

Click Apply. 

The result will be two volumes 4 and 5 glued to each other along the section plane:

 

Meshing 

1. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). 

 

Specify the parameters of mesh refinement: 

 Select Curves: 43 44 45 46 (using space after each curve); 

 Select the way of meshing: Equal; 

 Select the checkbox Interval; 
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 Specify the number of intervals: 6. 

Click Apply Size. 

Click Mesh. 

2. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). 

 Select Curves: 12 14 39 41 (using space after each curve); 

 Select the way of meshing: Equal; 

 Select the checkbox Interval; 

 Specify the number of intervals: 4. 

Click Apply Size. 

Click Apply. 

 

3. On the command panel, select the mesh generation mode on the curves (Mode - Mesh, Entity - Curve, Action – Mesh) 

 Select Curves: 51 53 61 62 (through spaces); 

 Settings for Curve: Equal; 

 Set the Interval flag; 

 Indicate the number of interval: 1. 

Click Apply Size. 

Click Mesh. 

4. Select volume mesh generation section on Command Panel (Mode — Mesh, Entity — Volume, Action — Mesh). 
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 Select Meshing Scheme: Map; 

 Select Volumes: 4 5 (or by the command all). 

Click Apply Scheme. 

Click Mesh. 

The resulting number of elements can be viewed in the Property Page by clicking on the inscription Volume 4 in the Model Tree on the 

left. 

To view the mesh properties, you can follow these steps: 

 Select the entire model; 

 Right-click the model; 

 In the pop-up menu, select List Information – List Mesh Info; 

 Information on the mesh will be displayed in Command Line. 
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Setting boundary conditions 

1. Fix one side (slice) along X axis. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 33 40; 

 Degrees of Freedom: X - Translation Disp; 

 DOF Value: 0. 

Click Apply. 

2. Fix one side (slice) along Y axis. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 35 39; 

 Degrees of Freedom: Y - Translation Disp; 

 DOF Value: 0. 

Click Apply. 

3. Fix the outer curvilinear surface along X and Y axes. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 
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 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 36 38; 

 Degrees of Freedom: X - Translation Disp and Y - Translation Disp; 

 DOF Value: 0. 

Click Apply. 

4. Fix the middle line of the outer curvilinear side along Z axis. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 50; 

 Degrees of Freedom: Z - Translation Disp; 

 DOF Value: 0. 

Click Apply. 

5. Apply pressure to the upper side. 

Select (Mode – Boundary Conditions, Entity – Pressure, Action – Create). 

  

 

Set the following parameters: 
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 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 31; 

 Magnitude Value: 1e6 (an exponential number format using the Latin letter“e” is supported ). 

Click Apply. 

All applied boundary conditions must be displayed in the Model Tree on the left. In addition, the boundary conditions are available for 

editing from the Model Tree. 

To view all the applied boundary conditions also click Show BC on the top panel. 

 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode — Material, Entity — Materials Management). 
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In the Materials Management window that opens, in the second column, double-click on the caption. Enter the name of the material and 

write “Material 1”. Press the ENTER key. 

 

  

Next, using the “drag & drop” method, add the necessary characteristics from the left column to the Material Properties column. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field opposite the Young Module and enter the number 

210e9. 

Similarly, from the Hooke Material section add the Poisson Ratio 0.3. 

Click Apply. 
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2. Create a block of one type of the material. 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Add). 

 

Set the following parameters: 

 Block ID: 1; 

 Entity List: Volume; 
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 Entity ID(s): 4 5 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Solid; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation settings section on Command Panel (Mode — Calculation Settings, Calculation Settings — Static, Static 

— General). 
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Select: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 

2. Set the solver settings. 

Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation Settings — Static, Static —Solver). 

 

Select the solver method (direct or iterative) and set Convergence Parameters in case of choosing an iterative one. You can also leave 

all the settings by default. 

Click Apply. 

Click Start Calculation. 

3. In a pop-up window select a folder to save the result and enter the file name. 
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4. If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at <date> 

<time>”. 

Results analysis 

1. Open the file with the results. You can do this in one of the three ways. 

 Press Ctrl+E. 

 Select Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode – Results). Click Open Results. 

 

2. Display the component σyy of the stress field and the mesh on the model. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Stress; 

 Representation Component: YY. 

 Surface with edges. 

 

  

3. Select a point where you need to view the stress. 

Select a point on the model by using Select Points Through. 

Select a point D on the upper side. From the main menu, select View – Selection Display Inspector. 

In Selection Display Inspector, go to the tab Point Tag and select and click on the Stress line in the drop-down list. 
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As a result, Stress components at the point D are displayed at the picture. 

 

  

  4. View the numerical value σyy at the selected point D. 

The difference between the obtained value -5.266e+06 and the required one -5.380e+06 is 2.12%. 

5. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click ОК. The saved 

file is an ordinary table of numerical data which can be opened in any text editor. 

6. You can see the way the body is deformed under the applied pressure. 

To do this select the filter Warp By Vector. Set the following parameters in the tab Properties: set the value to 5000 in the field Scale 

Factor. 

 

  

As a result, the deformed body is displayed in the picture. To see the original model, click near it in the Model Tree. The picture below 

shows the deformed (solid grey filling) and the original model (with the field of displacements distribution along Y axis). 
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the file static_solid_3D.jou by selecting Journal Editor on Toolbar. In a pop-up window of the 

main menu select File → Open and open the necessary journal file. 
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Static load (gravity force) 

R.J. Roark, Formulas for Stress and Strain, 4th Edition? McGraw-Hill Book Co., Inc., New York, NY, 1965, pg 112, no. 33  

The problem of the tube bending of under gravity force is to be solved. The pictures below represent a geometric model of 

the problem: 

  

 

The side edges are rigidly fixed on all displacements and rotations. Material parameters are E = 30e6 psi,     = 0.0, 

=0.00073 lb-sec2/in4. The gravity force is defined via the acceleration g=386 in/sec2. The geometrical dimensions of the 

model: L=200 in, d0=2 in, di=1 in. 

Due to the symmetry of the problem, half tube will now be considered (L/2). 

 

 

Test pass criterion is the following: displacement in the center of the tube uyy at the point D (0, d0/2, 0) is -0.12529 within 

3%.  

Geometry creation 

1. Create the first circular cylinder. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Create). 
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Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 100; 

 Cross section: Circular; 

 Radius: 1. 

Click Apply. 

2. Create the second cylinder. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Create). 

Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 100; 

 Cross section: Circular; 

 Radius: 0.5. 

Click Apply. 

As a result, two generated entities are displayed in the Model Tree (Volume 1 and Volume 2). 
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3. Subtract the first cylinder from the second one. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Boolean). 

 

Select Subtract in the list of operations. Set the following parameters: 

 A Volume ID(s): 1 (the volumes to be subtracted); 

 B Volume ID(s): 2 (volumes from which other volumes will be subtracted). 

Click Apply. 

As a result, only one volume is displayed in the Model Tree (Volume 1). 
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4. Place the volume to the coordinate origin. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Transform). 

 

Select Move from the list of possible types of slices. 

et the following parameters: 

 Volumes ID(s): 1 (the volume to be cut); 

 Select Method: Distance; 

 Z Distance: 50. 

Click Apply. 

Thus, the center of the left end of the tube is placed in the origin of coordinates. 

Meshing 

1. Set the approximate size of the elements. 

Select volume mesh generation section on Command Panel (Mode - Mesh, Entity - Volume, Action - Intervals). 
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Specify the Approximate Size of the elements: 

 Select Volumes: 1; 

 Approximate Size: 0.25. 

Click Apply Size. 

2. Select the way of mesh generation. 

Select volume mesh generation section on Command Panel (Mode - Mesh, Entity - Volume, Action - Mesh). 

 Select meshing scheme: Polyhedron. 

 Select Volumes: 1. 

Click Apply Scheme. 

Click Mesh. 
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The resulting number of elements can be found on the property page by clicking on Volume 1 in the Model Tree on the left.  

To view the mesh properties, you can follow these steps: 

 Select the entire model; 

 Right-click on the model; 

 In the pop-up menu, select List Information - List Mesh Info; 

 Information on the mesh will be displayed in Command Line. 

Setting boundary conditions 

1. Fix the right lateral edge at all directions. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 8; 

 Degrees of Freedom: All; 

 DOF Value: 0. 

Click Apply. 

2. Fix the left lateral edge along X and Z axes by analogy. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 9; 

 Degrees of Freedom: X-Translation Disp, Z-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

3. Set the gravity force. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Gravity, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Global; 

 Directions: Y; 

 Y: -386. 

Click Apply. 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode - Material, Entity - Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

Material 1•. Press the ENTER key. 
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In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young's modulus and enter the number 

30e6. 

Similarly, from the Hooke Material section add the Poisson Ratio 0 ; from the section General - Density: 0.00073. 

Click Apply. 

 

2. Create the block of one material type. 

Select setting the material properties section on Command Panel (Mode - Blocks, Entity - Block, Action - Add). 
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 Set the following parameters: 

 Block ID: 1; 

 Entity List:: Volume; 

 Entity ID(s): 1 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Solid; 
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 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Apply. 

Starting Calculation 

1. Set the type of the problem to be solved. 

Select calculation setting section on Command Panel (Mode - Calculation Settings, Calculation settings - Static, Static - General). 

 

 Select: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 

In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: "Calculation finished successfully at <date> <time>". 

Results analysis 

1. Open the file with the results. There are three ways to do this. 

 Click Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode - Results). Click Open Results. 
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To apply all of the filters changes automatically in Fidesys Viewer, click Apply changes to parameters automatically on 

Command Panel. 

2. Display the Uyy component of the displacement field on the model. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: Y; 

 Surface. 

After applying the settings, you will see the following picture: 

 

  

3. Check the maximum value Uyy at the selected point D. 

In the picture, it is the maximum in modulus Displacement (blue). It corresponds to -0.127222 in the color legend. 

The difference between the resulting value -0.1254 and the required -0.12524 is 0.13%. 

4. Download numerical data. 
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Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click OK. The saved 

file is an ordinary table of numerical data which can be opened in any text editor. 

5. You can see the way the body is deformed under the applied pressure. 

To do this, select Filters → Alpabatical → Warp By Vector. Set the following parameters in the tab Properties: 

 Vectors: Displacement; 

 Scale Factor: 100. 

As a result, the deformed body is displayed at the picture. To see the original model, click the button near the model in the Model Tree. 

The picture below shows the deformed (solid grey filling) and the original model (with the field of displacements distribution along Y 

axis). 

 

 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the file static_gravity_solid.jou by selecting Journal Editor on Toolbar. In a pop-up window of 

the main menu select File → Open and open the necessary journal file. 
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Static load (beam model, reaction forces)  

S.H. Crandall, N.C. Dahl, An Introduction to the Mechanics of Solids, McGraw-Hill Book Co., Inc., New York, NY, 1959, 

pg. 389, ex. 8.9 

 

The problem of static load of a square section beam is being solved. The picture represents a geometric model of the 

problem: a = 50 In, beam section 1 x 1 in. The boundary conditions are presented in the picture; the force applied at the 

point B is Fy = -1000 lb. The material parameters are E = 30e6 psi ,  = 0.3. 

Test pass criterion is the following: reaction force RA at the point A (0,0,0) is 148.15 lb, reaction moment at the point C is 

27778 in-lb within 1.5%. 

Geometry creation 

1. Create a straight line 100 in length (segment AB). 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Curve, Action — Create). 

 

Select Line in the list of geometric elements. Create it using Location and Direction. Set the following parameters: 

 Location: 0 0 0 (line origin); 

 Direction: 1 0 0 (along Х axis); 

 Length: 100. 

Click Apply. 

2. Create a straight line 50 in length (segment BC). 
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Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Curve, Action — Create). 

Select Line in the list of geometric elements. Create it using Location and Direction. Set the following parameters: 

 Location: 100 0 0 (line origin); 

 Direction: 1 0 0 (along Х axis); 

 Length: 50. 

Click Apply. 

As a result, in left side of the Model Tree there are two free curves having no common vertices. 

3. Unite two vertices. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Vertex, Action — Merge). 

 

Set the following parameters: 

 Vertex ID(s): 2 3 (using space after each of them). 

Click Apply. 

Meshing 

1. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). 
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Specify the parameters of mesh refinement: 

 Select Curves: all; 

 Select the way of meshing: Equal; 

 Select the meshing parameters: Interval; 

 Interval: 1. 

Click Apply Size. 

Click Mesh. 

Setting boundary conditions 

1. Fix the point C at all directions. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Vertex; 

 Entity ID(s): 4; 

 Degrees of Freedom: All; 

 DOF Value: 0. 

Click Apply. 

2. Fix the point A at the Y and Z displacement. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Vertex; 

 Entity ID(s): 1; 

 Degrees of Freedom: Y - Translation Disp, Z - Translation Disp; 

 DOF Value: 0. 

Click Apply. 

3. Apply force at the point B. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Force, Action — Create). 
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Set the following parameters: 

 System Assigned ID; 

 Force Entity List: Vertex; 

 Entity ID(s): 2; 

 Force: 1000; 

 Direction 0 -1 0. 

Click Apply. 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode — Material, Entity — Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

“Material 1”. Press the ENTER key. 
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In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young’s modulus and enter the number 

30e6.Similarly, from the Hooke Material section add the Poisson Ratio 0.3; 

Click Apply. 

 

2. Create the block of one type of the material. 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity List: Curve; 

 Entity ID(s): 1 2 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Beam; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Set Beam Properties. Set the checkbox Select profile. Select Rectangle in the list of geometric elements. Specify the following 

parameters: 

 Height (H): 1; 

 Width (B): 1. 

Click Apply. 

Close the window Set Beam Properties. 

Click Apply. 
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Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation settings — Static, Static 

— General). 

 

Select: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 

2. Set the solver settings. 

Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation settings — Static, Static — Solver). 

 

Select the solver method (direct or iterative) and set Convergence Parameters in case of choosing an iterative one. You can also leave 

all the settings by default. 
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Click Apply. 

3. Set the reaction force calculation. 

Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation settings — Static, Static 

— OutputFields). 

Set the checkbox Calculate nodal and reaction forces. 

 

Click Apply. 

Click Start Calculation. 

Note: Without setting the checkbox Calculate nodal and reaction forces, the field is not calculated. 

4. In a pop-up window select a folder to save the result and enter the file name. 

5. If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at <date> 

<time>”. 

Results analysis 

1. Open the file with the results. There are three ways do this. 

 Click Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode — Results). Click Open Results. 

 

2. Display the uy component of the displacements field. 

In Fidesys Viewer window set the following parameters on Toolbar: 
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 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: Y. 

The field of displacements distribution along the Y axis wil be displayed on the model. 

 

3. Check the numerical value of the reaction force at the point A. 

Display Component 2 of the Reaction Forces field. 

 

On the Fidesys Viewer Main Panel, click Select Points On surface. 

 

Select the limiting left point (point A) on the geometric model. 

To quickly view the information at the fixed point, click pointsInfo on the Main Panel. 

 

In the pop-up window, components of the reaction force at the selected point will be displayed. 

 

The difference between the resulting value 150.977 and the required 148.15 is less than 1,8%. 

Do not close the window Points information. 

4. Check the numerical value of reaction moments at the point C. 

Display Component Z of the Reaction_moment field. 

 

On the Fidesys Viewer Main Panel, click Select Points On surface. 

 

Select the limiting right point C on the geometric model. 

In the window Points information components of the reaction moment at the selected point will be displayed. 

 

The difference between the resulting value -27353.5 and the required -27377.3 is less than 0.01%. 
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5. Open 3D-image of the beam. 

To display 3D-view of the beam cross section, set the focus on the calculation title and click the button  in the Fidesys 

Viewer standard line. 

To apply all of the filters changes automatically, click Apply changes to parameters automatically on Command Panel. 

6. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click ОК. The saved 

file is an ordinary table of numerical data, any text editor can open it. 

 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the file static_solid_beam.jou by selecting Journal Editor on Toolbar. In a pop-up window of the 

main menu select File → Open and open the necessary journal file. 
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Static load (shell)  

Timoshenko S.P. Voynovskiy-Kriger S. Plates and shells, Nauka, Moscow, 1966, 636 pages [in Russian] 

 

We solve the problem of static load of square shell the two sides of which are 

clamped and the other two are freely supported.The picture represents a 

geometric model of the problem: a = 1 m, shell thickness is 0.1 m. The boundary 

conditions are presented in the picture. The plate is loaded by uniform pressure 

of 10 kPa. 

Test pass criterion is the following: the maximum deflection is 1.19e-6, 

moments Мx=252 N·m and Мy=332 N·m.  

 

Geometry creation 

1. Create the square 1 m on side. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Surface, Action - Create). 

 

Select Rectangle in the list of geometric elements. Set the parameters: 

 Width: 1; 

 Height: Optional. 

Click Apply. 

Meshing 

1. Select surface mesh generation section on Command Panel (Mode - Mesh, Entity - Surface, Action - Mesh).   
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Specify the following parameters: 

 Select meshing scheme: Polyhedron; 

 Select Surfaces: 1. 

Click Apply Scheme. 

Click Mesh. 

 

Setting boundary conditions 

1. Fix the two edges rigidly. 

Select surface mesh generation section on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 1 3 (or sequentially click on the top and bottom edges); 

 Degrees of Freedom: All; 

 DOF Value: 0. 

Click Apply. 

2. Fix the other two edges at displacements. 

Select surface mesh generation section on Command Panel  (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 2 4 (or sequentially click on the right and left edges); 

 Degrees of Freedom: X-Translation Disp, Y-Translation Disp, Z-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

3. Apply the uniform pressure on the surface. 

Select surface mesh generation section on Command Panel (Mode - Boundary Conditions, Entity - Pressure, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 1; 

 Magnitude Value: 1e4. 

Click Apply. 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode - Material, Entity - Materials Management). 

 

In the Materials Management window that opens, in the second column, click the caption “Enter the name of the material” and write 

“Material 1”. Press the ENTER key. 
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In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young's modulus and enter the number 

2e11.Similarly add the Poisson Ratio 0.3 from the Hooke Material section. 

Click Apply. 

 

2. Create the block of one type of the material. 

Select setting the material properties section on Command Panel (Mode - Blocks, Entity - Block, Action - Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity List: Surface; 

 Entity ID(s): 1 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Shell; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Set Shell Properties. Set the following parameters: 

 Thickness: 0.1; 

 Eccentricity: 0.5. 

Click Apply. 

Close the window Set Shell Properties. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved. 
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Select calculation setting section on Command Panel (Mode - Calculation Settings, Calculation settings - Static, Static - General). 

 

Select: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 

2. Set the solver settings. 

Select calculation setting section on Command Panel (Mode - Calculation Settings, Calculation settings - Static, Static - Solver). 

 

Select the solver method (direct or iterative) and set Convergence Parameters in case of choosing an iterative one. You can also leave 

all the settings by default. 

Click Apply. 

3. Set the reaction force calculation 

Go to the tab Static - Output fields and set the checkbox Calculate nodal and reaction forces. 
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Click Apply. 

Click Start Calculation. 

Note: Without setting the checkbox Calculate nodal and reaction forces, the field is not calculated. 

4. In a pop-up window select a folder to save the result and enter the file name. 

5. If the calculation is finished successfully, you will see a message in the Console: "Calculation finished successfully at <date> 

<time>". 

Results analysis 

1. Open the file with the results. There are three ways to do it: 

 Click Ctrl+E. 

 Select Calculation - Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode - Results). Click Open Results. 

 

2. Display the uz component of the displacement field. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: Z.

 

The field of displacements distribution along the Z axis will be displayed on the model. 
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3. Check the numerical value of the maximum displacement. 

Display maximum Component 3 of the Displacement field.

 

The difference between the resulting value 1.209e-6 and the required -1.19e-6 is 1.6%. 

4. Check numeric values of moments in the center of the plate. 

Display component XX of the MomentsShell field. 

 

Select the filter Probe Location (Filters - Alphabetical - Probe Location) in the Fidesys Viewer Main Menu. In the tab Properties set 

the following values: 

 Point: (0,0,0); 

 Number of Points: 1; 

 Radius: 0. 

Go to the Information tab and look at the MomentsShell field. 
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The difference between the resulting values (M x=260.347 and M y=344.745) and the required ( Mx=252 and M y=332) is 3.3% and 

3.8%, relatively. 

5. Open 3D-image of the shell. 

To display 3D-view of the beam cross section, set the focus on the calculation title and click the button 3D-view in the Fidesys 

Viewer standard line. 

The system will open a new file *.pvd and you will be able to apply various filters to it and to view its deformed view. 

Choose the new file example_3D.pvd in the Model Tree and display Filters - Alphabetical - Warp by Vector for it with the following 

fields values. 

 Vectors: Displacement; 

 Scale Factor: 2e5. 

 

  

On the Toolbar, set once again the following parameters for the deformed type: 

 

The first buckling mode will be displayed on the screen but the shell will be enveloped with thickness. 

 

To apply all of the filters changes automatically, click Apply changes to parameters automatically on Command Panel. 
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6. Download numerical data 

Select File - Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click OK. The saved 

file is an ordinary table of numerical data which can be opened in any text editor. 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the file static_gravity_shell.jou by selecting Journal Editor on Toolbar. In a pop-up window of 

the main menu select File → Open and open the necessary journal file. 
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Hydrostatic pressure on cylinder (setting boundary conditions according to coordinates) 

 

Societe Francaise des Mecaniciens, Guide de validation des progiciels de calcul de structures, 

(Paris, Afnor Technique,1990.) Test No. SSLS08/89. I-Deas Model Solution Verification Manual 

The problem of hydrostatic load of the cylindrical shell is being solved. The picture represents a 

geometric model of the problem: radius 1 m, shell thickness 0.02 m. The shell is fixed on the 

condition of the symmetry. The plate is loaded by the pressure p = 20000·z/L Pa. 

 

Test pass criterion is the following: displacement  at the point (0, R, L) is 2.8610-6 m. 

Geometry creation 

1. Create the cylinder of 1 m radius and 4 m high. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Create). 

 

Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 4; 

 Cross section: Circular; 

 Radius: 1. 

Click Apply. 

2. Get the cylindrical shell out of the volumeric cylinder. 

Select the volume removing section on Command Panel (Mode - Geometry, Entity - Volume, Action - Delete). 
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Enter the number of the created volume - 1 into the field Volume ID(s). 

Put a tick against Keep Lower Geometry. 

Click Apply. 

As a result, three plane bodies (Body 2, Body 3, Body 4) are obtained. 

This will be displayed in the Model Tree. 

 

3. Delete side surfaces Surface 2 and Surface 3. 

Select the surface removing section on Command Panel (Mode - Geometry, Entity - Surface, Action - Delete). 
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Enter numbers -  2 3 in the window Surface ID(s). 

Click Apply. 

As a result, only the lateral cylindrical shell of 1 m radius and 4 m high will remain of the initial volume. 

 

4. Leave a quarter of a shell (symmetric problem). 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Webcut). 
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Select Coordinate Plane in the list of possible webcut types. Set the following parameters: 

 Volume ID(s): 2 (the body to be webcut); 

 Webcut with Plane: YZ; 

 Offset Value: 0. 

Click Apply. 

Do the same for the ZX Plane. 

 Volume ID(s): 2 (the body to be webcut); 

 Webcut with Plane: ZX; 

 Offset Value: 0. 

Click Apply. 
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As a result, the original Body 2 in the Model Tree is split into three (Body 2, Body 5 and Body 6). 

5. Delete surfaces Surface 5 and Surface 6. 

Select the surface removing section on Command Panel (Mode - Geometry, Entity - Surface, Action - Delete). 

 

Enter numbers - 5 6 into the window Surface ID(s). 

Click Apply. 

As a result, only a quarter of the original shell Body 6 (Surface 7) is left. 
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6. Move the surface to the coordinate origin. 

Select surface geometry modification section on Command Panel (Mode - Geometry, Entity - Surface, Action - Transform). 

 

Select Move in the list of possible webcut types. Set the following parameters: 

 Surface ID(s): 7 (the surface to be moved); 

 Select Method: Distance; 

 Z Distance: 2. 

Click Apply. 

Meshing 

1. Specify the parameters of mesh refinement. 

Select meshing on curves section on Command Panel (Mode - Mesh, Entity - Curve, Action - Mesh). 
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Split the cross-cut curves Surface 17 and Surface 18 into 10 elements. 

 Select Curves: 17 18 (or click the mouse while holding down the Ctrl key on contour of the cross-cut curves); 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Intervalr: 10. 

Click Apply Size. 

Split longitudinal curves Curve 5 and Curve 16 into 20 elements. 

 Select Curves: 5 16 (or click the mouse while holding down the Ctrl key on contour of the longitudinal curves); 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 20. 

Click Apply Size. 

2. Create the mesh. 

Select the surface mesh generation section on Command Panel (Mode - Mesh, Entity - Surface, Action - Intervals). 
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 Select meshing scheme: Automatic Sizing; 

 Select Surfaces to Mesh (specify their ID)): 7 (or by the command all). 

Click Apply Size. 

Click Mesh. 

The resulting number of elements can be viewed in the Property Page by clicking on the inscription Surface 7 in the Model Tree on the 

left. 

To view the mesh properties, you can follow these steps: 

 Select the entire model; 

 Right-click on the model; 

 In the pop-up menu select List Information - List Mesh Info; 

 Information on the mesh will be displayed in Command Line; 
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Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode - Material, Entity - Materials Management). 
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In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

Material 1. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Youngs modulus and enter the number 

2.1e11. Similarly, from the Hooke Material section add the Poisson Ratio 0.3. 

Click Apply. 

 

2. Create the block of one type of the material. 

Select setting the material properties section on Command Panel (Mode - Blocks, Entity - Block, Action - Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity List: Surface; 

 Entity ID(s): 7 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Shell; 
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 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Set Shell Properties. Set the following parameters: 

 Thickness: 0.02; 

 Eccentricity: 0.5. 

Click Apply. 

Close the window Set Shell Properties. 

Click Apply. 

Setting boundary conditions 

1. Fix the cross-cut curve Surface 17 by the symmetry condition. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 17 (or click on the cross-cut curve); 

 Degrees of Freedom: Z-Translation Disp; X-Rotation Disp; Y-Rotation Disp. 

Click Apply. 
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2. Fix the longitudinal curve Curve 5 on the symmetry condition. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 5 (or click on the longitudinal curve); 

 Degrees of Freedom: X-Translation Disp; Y-Rotation Disp; Z-Rotation Disp. 

Click Apply. 

3. Fix the longitudinal curve Curve 16 by the symmetry condition. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 16 (or click on the longitudinal curve); 

 Degrees of Freedom: Y-Translation Disp; X-Rotation Disp; Z-Rotation Disp. 

Click Apply. 

4. Apply pressure to the cylinder inner surface with value of 1. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Pressure, Action - Create). 

 

Set the following parameters: 
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 System Assigned ID; 

 Pressure Entity List: Surface; 

 Entity ID(s): 7 (or click on the cylinder surface); 

 Magnitude Value: 1. 

Click Apply. 

5. Set pressure dependency of the z-coordinate. Select (Mode -  BC Dependency). 

 

In the pop-up window BC Dependency, set the following parameters: 

 BC name: Pressure 1; 

 Select checkbox Formula, Manually; 

 In the field below, enter -20000*z/4. 

Click Apply. 

 

To view the plotted graph use the appropriate tab. 
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Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation setting section on Command Panel (Mode - Calculation Settings, Calculation settings - Static, Static - General). 

 

Select: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 
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Click Start Calculation. 

In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: "Calculation finished successfully at <date> 

<time>"•. 

Results analysis 

 

1. Open the file with the results. There are three ways to do it: 

 Click Ctrl+E. 

 Select Calculation - Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode  Results). Click Open Results.

 

2. Display the Uz component of the displacement field on the model. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 
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 Representation Field: Displacement; 

 Representation Component: 3. 

3. Compare the numerical value of the target displacement at the point (0,1,4) with the initial one of the source -2.86e-6. 

Select Filters - Alphabetical - Probe Location. In the tab Properties, set the following parameters for the filter: 

 Point (0, 1, 4); 

 Number of Points: 1; 

 Radius: 0. 
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The difference between the resulting value -2.99994-06 and the required -2.86e-6 is 4.89%. 

You can see the way the body is deformed under the applied pressure. 

Select the filter Warp By Vector to do this. Set the following parameters in the tab Properties: 

 Vectors: Displacement; 

 Scale Factor: 1e5. 

As a result, the deformed body is displayed at the picture. 

Select the following display settings for the deformed view: 

 

To see the original model, click the icon  near the model in the Model Tree. 
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Consider the direction of the coordinate axes in the picture. 

4. Download numerical data. 

Select File - Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click OK. The saved 

file is an ordinary table of numerical data which can be opened in any text editor. 

 

 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file static_shell_coord_dependence.jou by selecting Journal Editor on Toolbar. In a pop-up 

window of the main menu select File → Open and open the necessary journal file. 
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Buckling (shell model) 

S.P. Timoshenko, J.M Manages “Theory of elastic stability” second edition. Dunod, 

1966, 500 pages  

We solve the problem of cylindrical shell buckling under the pressure uniformly 

distributed over the entire surface. 

The picture represents a geometric model of the problem: R = 2 m, L = 2 m, 

thickness h = 0.002 m. Due to the symmetry of the problem, the ¼ part of the 

cylinder is regarded. Constraints on the lines AB and CD are due to the conditions 

of symmetry; a uniformly distributed load on the surface is ABCD q = 1 kPa. The 

material parameters are E = 200 GPa,  = 0.3.  

It is necessary to compare the first three critical values. 

Geometry creation 

1. Create a cylinder with radius of 2 m and length of 2 m. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Create). 

 

Select Cylinder in the list of geometric elements. Create leaving Circular at the base. 

Set radius of 2 and height of 2. 

Click Apply. 

2. Get the cylindrical shell out of the volumeric cylinder. 

Select the volume removing section on Command Panel (Mode — Geometry, Entity — Volume, Action — Delete). 
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Enter the number of the created volume – 1 into the field Volume ID(s). Put a tick against Keep Lower Geometry. 

Click Apply. 

As a result, three plane bodies (Body 1, Body 2, Body 3) are obtained. This will be displayed in the Model Tree. 

 

3. Delete side surfaces Body 3 and Body 4. 

Select the surface removing section on Command Panel (Mode — Geometry, Entity — Surface, Action — Delete). Enter numbers 2 

3 in the window Surface ID(s). 

Click Apply. 

As a result, only the lateral cylindrical shell of 2 m radius and 2 m high will remain of the initial volume. 

4. Leave a quarter of a shell (symmetry of the problem). 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Surface, Action — Webcut). 
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Select Coordinate Plane in the list of possible webcut types. Set the following parameters: 

 Body ID(s): 2 (the surface to be webcut); 

 Webcut with Plane: YZ; 

 Offset Value: 0; 

 Imprint. 

Click Apply. 

Do the same for the ZX Plane: 

 Body ID(s): 2 (the volume to be webcut); 

 Webcut with Plane: ZX; 

 Offset Value: 0; 

 Imprint. 

Click Apply. 

As a result, the original volume in the Model Tree is split into three (Body 2, Body 5 and Body 6). 
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Delete the bodies 2 and 5. To do this select these bodies in the Model Tree holding down the Ctrl key and click Delete in contextual 

menu. As a result, a quarter of the original shell is left (Body 6): 
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Meshing 

1. Create a quadrangular mesh. 

Select meshing on plane section on Command Panel (Mode — Mesh, Entity — Surface, Action — Intervals). 

 

Specify the parameters of mesh refinement: 

 The way of meshing: Approximate Size; 

 Select Surfaces: 7; 

 Approximate Size: 0.125. 

Click Apply Size. 

2. Select meshing on plane section on Command Panel (Mode — Mesh, Entity — Surface, Action — Mesh). 

Select meshing scheme: 

 Select meshing scheme: Polyhedron; 

 Select Surfaces: 7. 

Click Apply Scheme. 

Click Mesh. 
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Setting boundary conditions 

1. Fix the line AB on the conditions of symmetry. 

Select meshing on plane section on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entities ID(s): 5 (or click on the top line on a quarter of the shell); 
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 Degrees of Freedom: Х-Translation Disp, Y-Rotation Disp, Z-Rotation Disp; 

 DOF Value: 0. 

Click Apply. 

2. Fix the line CD of the conditions of symmetry. 

Select meshing on plane section on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 16 (or click on the lower line on a quarter of the shell); 

 Degrees of Freedom: Y-Translation Disp, X-Rotation Disp, Z-Rotation Disp; 

 DOF Value: 0. 

Click Apply. 

3. Apply pressure to the entire surface of the shell. 

Select meshing on plane section on Command Panel (Mode — Boundary Conditions, Entity — Pressure, Action — Create). Set the 

following parameters: 

 

 System Assigned ID; 

 Pressure Entity List: Surface; 

 Entity ID(s): 7; 

 Magnitude Value: 1000. 



CAE Fidesys — User Guide (version 5.1)           169 

 

 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode — Material, Entity — Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

“Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young’s modulus and enter the number 

2e11. Similarly, from the Hooke Material section add the Poisson Ratio 0.3. 

Click Apply. 

 

2. Create a block of one type of the material. 
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Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Add). 

 

Set the following parameters: 

 Block ID: 1; 

 Entity List: Surface; 

 Entity ID(s): 7 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 
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 Category: Shell; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Set Shell Properties. Set the following parameters: 

 Thickness: 0.02; 

 Eccentricity: 0.5. 

Click Apply. 

Close the window Set Shell Properties. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation settings section on Command Panel (Mode — Calculation Settings, Calculation settings — Buckling, Stability 

— General). 

 

Select 3 in the field Number of buckling modes. Leave other parameters by default. 

Click Apply. 

Click Start Calculation. 

In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at <date> <time>”. 

Results analysis 

1. Compare the obtained results. 

The first three critical values are displayed in Command Line. 
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Compare the obtained results with those in the table: 

 

2. Open the file with the results. There are three ways to do it: 

 Click Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode — Results). Click Open Results. 

3. In a pop-up Fidesys Viewer window select a filter Warp By Vector. 

 

4. In a pop-up filter Warp By Vector in the tab Properties, set the following parameters: 

 Vectors: Mode 1 displacement; 

 Scale Factor: 0.1. 

5. Display Mode 1 displacement. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 

Make sure that the first required critical value is displayed in the window Critical value. 

6. View results. 

As a result, the deformed body is displayed at the picture. To see the original model, click  near the model in the Model Tree. The 

picture below shows the deformed (solid grey filling) and the original model (with the distribution field Displacements for Mode 1). 
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7. Select the filter Warp By Vector to do this. Set the following field value in the tab Properties: 

 Vectors: Mode 2 displacement; 

 Scale Factor: 0.1. 

8. Display Mode 2 displacement. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 

Make sure that the second required critical value is displayed in the window Critical value. 

9. View results. 
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10. Similarly display Displacements for mode 3, make sure that the third required critical value is displayed in the window Critical 

value. 

 

11. Display the 3D-view of the model (shell with thickness). 

To do this, click on the name of the source file in the Model Tree. After this click 3D-view button in the default string. 
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The file* _3D.pvd with a 3D-image of the shell must be opened and you will be able to apply various filters to it and to view its deformed 

view. 

Choose the new file example_3D.pvd in the Model Tree and display Filters Warp by Vector for it with the following fields values: 

 Vectors: Mode 1 displacement; 

 Scale Factor: 0.1. 

On the Toolbar, set once again the following parameters for the deformed type: 

 

The first buckling mode will be displayed on the screen but the shell will be enveloped with thickness. 

 

  

 To apply all of the filters’ changes automatically, click Apply changes to parameters automatically on Command Panel. 
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12. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click OK. In the 

pop-up window select: 

 Field Association: Field Data. 

The saved file is an ordinary table of numerical data which can be opened in any text editor. 

 

 

Using Console Interface 

 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file stability_shell.jou by selecting Journal Editor on Toolbar. In a pop-up window of the main 

menu select File → Open and open the necessary journal file. 
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Modal analysis (3D) 

NAFEMS Selected Benchmarks for Natural Frequency Analysis “Simply Supported "Solid" Square Plate”, Test No FV52. 

We solve the problem of modal analysis of a square plate. 

The picture represents a geometric model of the problem and a mesh: 

The size of the plate is 10 m х 10 m х 1 m. Displacements along z-axis are 

constrained for the edges of the plate bottom side. The material parameters are E = 

200 hPa,  = 0.3,  = 8000 kg/m3. 

Eigenmodes from 4 to 10 are to be compared.  

Geometry creation 

1. Create the plate. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity  - Volume, Action - Create). 

 

Select Brick in the list of geometric elements. Set the brick dimensions: 

 X (width): 10; 

 Y (height): 10; 

 Z (depth): 1. 

Click Apply. 

Meshing 

A mesh of 8*8*3 linear hexahedral elements is to be generated (as shown at the picture with the problem setting). 

1. Select meshing on curves section on Command Panel (Mode - Mesh, Entity - Curve, Action - Mesh). 
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Specify the parameters of mesh refinement: 

 Select Curves: 1 2 3 4 5 6 7 8 (using space after each of them); 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 4 (see the figure). 

Click Apply Size. 

  

2. Select meshing on curves section on Command Panel (Mode - Mesh, Entity - Curve, Action - Mesh). Specify the parameters of mesh 

refinement: 

 Select Curves: 9 10 11 12 (using space after each of them); 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 1. 

Click Apply Size. 

  

Select volume mesh generation section on Command Panel (Mode - Mesh, Entity - Volume, Action - Mesh). 
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Specify the parameters of mesh refinement: 

 Select Meshing Scheme: Automatic Sizing; 

 Select Volumes: 1 (or by the command all). 

Click Apply Size. 

Click Mesh. 

Setting boundary conditions 

1. Fix the bottom side edges along Z. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 5 6 7 8 (using space after each of them); 

 Degrees of Freedom: Z - Translation Disp; 

 DOF Value: 0. 

Click Apply. 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode - Material, Entity - Materials Manegment). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

"Material 1". Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young's modulus and enter the number 

2e11. Similarly, from the Hooke Material section add the Poisson Ratio 0.3. Density: 8000. 

Click Apply. 
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2. Create a block of one type of the material. 

Select setting the material properties section on Command Panel (Mode - Blocks, Entity - Block, Action - Add). 

 

Set the following parameters: 

 Block ID: 1; 
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 Entity list: Volume; 

 ID: 1 (or by the command all). 

Click Apply. 

  

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Category: Solid; 

 Order: 1. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation setting section on Command Panel (Mode - Calculation Settings, Calculation settings -  Mode frequency analysis, 

ModeFrequency - General). 
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Specify the following settings: 

 Interval: 20 - 250. 

Click Apply. 

Click Start Calculation. 

  

2. In a pop-up window select a folder to save the result and enter the file name. 

  

3. If the calculation is finished successfully, you will see a message in the Console: "Calculation finished successfully at <date> 

<time>;" as well as the required eigen values and frequencies. 

Results analysis 

1. Compare the obtained results with those in the given table. 

 

  

2. Open the file with the result There are three ways to do it: 

 Click Ctrl+E. 
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 Select Calculation Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode Results). Click Open Results. 

 

  

3. You can see the way the body is deformed. 

Select a filter Warp By Vector to do this. Set the following parameters in the tab Properties: 

 Vectors: Eigenvalue_# (# stands for the number of the eigenvalue) 

 Scale Factor: 700 

As a result, the deformed body is displayed at the picture. To see the original model, click  near it in the Model Tree. The picture 

below shows the deformed model at different eigenvalues. 

 

4 eigenmode 

 

5 eigenmode 
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6 eigenmode 

 

7 eigenmode 

 

8 eigenmode 

 

9 eigenmode 
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10 eigenmode 

 

 

 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file analysis_frequency_solid_model.jou by selecting Journal Editor on Toolbar. In a pop-up 

window of the main menu select File → Open and open the necessary journal file. 
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Modal analysis (shell model)  
NAFEMS-Glasgow, BENCHMARK newsletter, Report No. E1261/R002, 

“Free Vibrations of a Simply-supported Thin Square Plate” , February 

1989, p.21. 

We solve the problem of modal analysis of a square plate. 

The size of the plate is 10 m х 10 m, the thickness is 0.05 m. X- and Y-

Translation and Z-Rotation are constrained for all nodes of the plate. All the 

edges are constrained in Z-direction. The X-rotation is constrained for edges 

AB and CD. The Y-rotation is constrained for edges BC and AD. The 

material parameters are E = 200 hPa,  = 0.3,  = 8000 kg/m3. 

We need to compare Eigenmodes from 1 to 8. 

Geometry creation 

1. Create the plate. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Surface, Action — Create). 

 

Select Rectangle in the list of geometric elements. Set the brick dimensions: 

 Width: 10; 

 Location: ZPlane. 

Click Apply. 

Meshing 

A mesh of 32*32 linear quadrilateral elements is to be generated (as shown at the picture with the problem setting). 

1. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). 
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Specify the parameters of mesh refinement: 

 Select Curves: all; 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 32 (see the figure). 

Click Apply Size. 

Click Mesh. 

  

2. Select surface mesh generation section on Command Panel (Mode — Mesh, Entity — Surface, Action — Mesh). 
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 Select Surfaces: 1 (or by the command all); 

 Select Meshing Scheme: Automatically Calculate. 

Click Apply Scheme. 

Click Mesh. 

Setting boundary conditions 

1. Fix the plate: X- and Y-Translations and Z-Rotations. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Node; 
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 Entity ID(s): all; 

 Degrees of Freedom: X-Translation, Y-Translation and Z-Rotation; 

 DOF Value: 0. 

Click Apply. 

  

2. Fix all the edges at the Z-direction. 

Select (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 

 System Assigned ID; 

 System Assigned ID; 

 Entity ID(s): all; 

 Degrees of Freedom: Z-Translation; 

 DOF Value: 0. 

Click Apply. 

  

3. Fix the edges AB and CD on X-Rotation. 

Select (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curves; 

 Entity ID(s): 2 4 (using space after each of them); 

 Degrees of Freedom: X-Rotation; 

 DOF Value: 0. 

Click Apply. 

  

4. Fix the edges BC and AD in Y-rotation. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curves; 

 Entity ID(s): 1 3 (using space after each of them); 

 Degrees of Freedom: Y-Rotation; 

 DOF Value: 0. 
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Click Apply. 

Setting material and block properties 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode — Material, Entity — Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

“Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young’s modulus and enter the number 

200e9.Similarly from the Hooke Material section add the Poisson Ratio 0.3, Density: 8000. 

Click Apply. 
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2. Create the block of one type of the material 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Add). 

 

Set the following parameters: 

 Block ID: 1; 

 Entity list: Surface; 

 ID: 1 (or by the command all). 

Click Apply. 

  

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 
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Set the following parameters: 

 Block ID(s): 1; 

 Available materials: Material 1; 

 Coordinate System: Global Cartesian; 

 Category: Shell; 

 Order: 1. 

Click Set Shell Properties. Set the following parameters: 

 Thickness: 0.05; 

 Eccentricity: 0.5. 

Click Apply. 

Close the window Set Shell Properties. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation settings — Mode frequency 

analysis, ModeFrequency — General). 

 

Set the default settings. 

Click Apply. 

Click Start Calculation. 

  

2. In a pop-up window select a folder to save the result and enter the file name. 
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3. If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at <date> <time>” 

as well as the required eigenvalues and frequencies. 

Results analysis 

1. Compare the obtained results to those given in the picture. 

 

  

2. Open the file with the results. There are three ways to do it: 

 Click Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click Open last result. 

 

 Select Results on Command Panel (Mode — Results). Click Open Results. 

 

  

3. You can see the way the body is deformed under the applied pressure. 

Select a filter Warp By Vector to do this. Set the following parameters in the tab Properties: 

 Vectors: Eigenvalue_# (# stands for the number of the eigenvalue); 

 Scale Factor: 200. 
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As a result, the deformed body is displayed at the picture. To see the original model, click near it in the Model Tree. The picture below 

shows the deformed model at different eigenvalues. 

 

 4. Display the 3D-view of the model (shell with thickness). 

To do this, click on the name of the source file in the Model Tree. After this click 3D-view button in the default string. 

 

The file *_3D.pvd with a 3D-image of the shell will open and you will be able to apply various filters to it and to view its deformed 

view. 

 

Using Console Interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file modal_shell.jou by selecting Journal Editor on Toolbar. In a pop-up window of the main 

menu select File → Open and open the necessary journal file. 
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Setting heat transfer (3D, working with two blocks) 

 

We solve the 3D problem of a hollow two-material cylinder the inner and outer surfaces of which undergo convection.  

The pictures represent a geometric model of the problem: 

The inner radius of the cylinder Ri = 0.30 m, the middle radius of the cylinder (at the place of material changing) Rm = 0.35 

m, the external radius of the cylinder Re = 0.37 m.  

Сonvective heat exchange with internal temperature Ti = 70 ° C and coefficient hi = 150 W/ m2/°C occurs on the inner 

surface of the cylinder. Сonvective heat exchange with exterior temperature Te = -15 °C and coefficient he = 200 W/ m2/°C 

occurs on the outer surface of the cylinder. 

Materials are isotropic. The material heat transfer 1 is Ѵ1 = 40 W/(m·°C). The material heat transfer 2 is Ѵ2 = 20 W/(m·°C). 

Test pass criterion is the following:  

at the point (0.3, 0, 0) heat flux  6687 W/ m2 is within 1%. 

 

 

 

 

 

 

 

 

Geometry creation 

1. Create the first cylinder. 

Select volume geometry generation section on Command Panel (Mode – Geometry, Entity – Volume, Action – Create). 
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Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 0.01; 

 Circular; 

 Radius: 0.3. 

Click Apply. 

2. Create the second cylinder. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Create). 

Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 0.01; 

 Circular; 

 Radius: 0.35. 

Click Apply. 

3. Create the third cylinder. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Create). 

Select Cylinder in the list of geometric elements. Specify the cylinder dimensions: 

 Height: 0.01; 

 Circular; 

 Radius: 0.37. 

Click Apply. 

As a result, three generated entities are displayed in the Model Tree (Volume 1, Volume 2 and Volume 3). 
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4. Subtract the first cylinder from the second one. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Boolean). 
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Select Subtract in the list of operations. Set the following parameters: 

 A Volume ID(s): 2 (volumes from which other volumes will be subtracted); 

 B Volume ID(s): 1 (the volumes to be subtracted); 

 Keep Originals. 

Click Apply. 

5. Subtract the second cylinder from the third one. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Boolean). 

Select Subtract in the list of operations.  Set the following parameters: 

 A Volume ID(s): 3 (volumes from which other volumes will be subtracted); 

 B Volume ID(s): 2 (the volumes to be subtracted); 

 Keep Originals. 

Click Apply. 

As a result, five generated entities are displayed in the Model Tree: Volume 1, Volume 2, Volume 3, Volume 4 and Volume 5. Delete 

the thirst three bodies by right-clicking and selecting Delete. 

Two entities: Volume 4 and Volume 5 are left in the Model Tree. 

6. Merge obtained entities. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Imprint and 

Merge). 

 

Select Merge Volumes in the list of operations. Set the following parameters: 

 Volume ID(s): 4 5 (the volumes to be united). 

Click Apply. 
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Meshing 

1. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). 

 

Specify the parameters of mesh refinement: 

 Select Curves: all (mesh will be create on all the curves); 

 Select the way of meshing: Equal; 

 Select the meshing parameters: Interval; 

 Interval: 200. 

Click Apply Size. 

2. Select volume mesh generation section on Command Panel (Mode — Mesh, Entity — Volume, Action — Mesh). 
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 Select meshing scheme: Polyhedron. 

 Select Volumes: all (mesh will be create on all the volumes); 

Click Apply Scheme. 

Click Mesh. 

Setting material and block properties 

1. Create Material 1. 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Materials Management). 

 

Specify the name of the material. Material 1. Drag from the left column to the section Thermal of the label Thermal isotropic in the 

Material Properties column. 

Set the following parameters: 
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 Thermal Expansion coefficient: 40. 

Click Apply. 

2. Create Material 2. 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Materials Management). 

Specify the name of the material. Material 2. Drag from the left column to the section Thermal of the label Thermal isotropic in the 

Material Properties column. 

Set the following parameters: 

 Thermal Expansion coefficient: 20. 

Click Apply. 

 

3. Create Block 1. 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity List: Volume; 

 Entity ID(s): 4. 

Click Apply. 

4. Create Block 2. 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Add). 

Set the following parameters: 

 Block ID: 2; 

 Entity list: Volume; 

 Entity ID(s): 5. 

Click Apply. 

5. Set parameters for block № 1. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 



CAE Fidesys — User Guide (version 5.1)           204 

 

 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Solid; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Apply. 

6. Set parameters for block № 2. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

Set the following parameters: 

 Block ID(s): 2; 

 Category: Solid; 

 Material: Material 2; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Apply. 

Setting boundary conditions 

1. Set the process of convective heat exchange on the inner surface of the cylinder. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Convection, Action — Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 10; 

 Select the way of parameters setting: Surrounding; 

 Temperature: 70; 

 Coefficient: 150. 

Click Apply. 

2. Set the process of convective heat exchange on the outer surface of the cylinder. 

Select on Command Panel (Mode — Boundary Conditions, Entity — Convection, Action — Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 15; 

 Select the way of parameters setting: Surrounding; 

 Temperature: -15; 

 Coefficient: 200. 

Click Apply. 

3. Fix the base of the cylinder. 
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Select on Command Panel (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 12 13 16 17 (using space after each of them); 

 Degrees of Freedom: Z-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved. 

Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation settings — Static, Static 

— General). 
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Set the solver settings: 

 Dimensions: 3D; 

 Model: Elasticity 

 Model: Heat transfer.. 

Click Apply. 

2. In a pop-up window select a folder to save the result and enter the file name. 

3. If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at <date> 

<time>”. 

Results analysis 

1. Open the file with the results. You can do this in one of the three ways. 

 Click Ctrl+E. 

 Select Calculation Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode — Results). Click Open Results. 

 

2. Display the component of the heat flux. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: HeatFlux.
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To display the color legend scale, click the button Switch the color legend visibility on Command Panel. 

3. Select a point where you need to view the heat flux. 

In the Main Menu, select the filter Probe Location. In the tab Properties set the coordinates of the point A where you need to view the 

stress: 

 Show Point; 

 Point (coordinates): 0.3 0 0; 

 Number of Points: 1; 

 Radius: 0. 

Click Apply. 

  

To apply all of the filters changes automatically, click Apply changes to parameters automatically on Command Panel. 

As a result, point A is displayed at the picture. 

 

4. View a numerical value of the heat flux  at the selected point A. 

See the heat flux values in the line HeatFlux in the tab Information in the field Data Arrays. 

 

  

The heat flux value is calculated using the following formula: 
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The difference between the obtained value 6686.41 and the required one 6 687 is 0.01%. 

5. Download numerical data. 

Select File  Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click ОК. The saved 

file is an ordinary table of numerical data which can be opened in any text editor. 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file thermal_conductivity.jou by selecting Journal Editor on Toolbar. In a pop-up window of 

the main menu select File → Open and open the necessary journal file. 
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Dynamic load: nonsteady heat transfer (3D, implicit scheme)  

The 3D problem of 1D nonsteady heat transfer inside a beam is being solved.  

The picture below represents a geometric model of the problem: 

 

 

 

 

 

 

 

The beam length is 0.1 m, square cross section is 0.01x0.01 m. The temperature at the point A is TA = 0 °C, the temperature 

at the point B varies harmonically: TB = 100 sin  °C. The material parameters are isotropic, V = 35 W/(m·°C), C = 440.5 

J/(kg ·°C),  = 7 200 kg/m3. 

 

Test pass criterion is the following: temperature T at the point C (0.8;0;0) at time t = 32c is 36.60°C within 2%. 

Geometry creation 

1. Create the sliver parallelepiped. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Create). 

 

Select Brick in the list of geometric elements. Set the brick dimensions: 

 X (width): 0.1; 

 Y (height): 0.01; 
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 Z (depth): 0.01. 

Click Apply. 

2. Combine left edge of the beam with the origin of coordinates. 

Set the following parameters: Select volume geometry modification section on Command Panel (Mode - Geometry, Entity - Volume, 

Action - Transform). 

 

Select Move in the list of possible types. Set the following parameters: 

 Volume ID(s): 1; 

 Select Method: Distance; 

 X Distance: 0.05. 

Click Apply. 

Meshing 

1. Create the mesh of hexahedrons. 

Select volume mesh generation section on Command Panel (Mode - Mesh, Entity - Volume, Action - Mesh). 
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 The way of meshing: Polyhedron; 

 Select Volumes (specify their ID): 1 (or by the command all). 

Click Apply Scheme. 

Click Mesh. 

Setting material and block properties 

1. Create the material 

Select setting the material properties section on Command Panel (Mode - Material, Entity - Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

“Material 1”. Press the ENTER key. 

Set the following parameters: 

 Density: 7200; 

 Specific Heat coefficient: 440.5; 

 Thermal conductivity coefficient: 35. 

Click Apply. 
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2. Create a block of one type of the material. 

Select setting the material properties section on Command Panel (Mode - Blocks, Entity - Block, Action - Add). 

 

Select Add in the list of possible operations. Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume; 

 Entity ID(s): 1 (or by the command all). 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 
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Set the following parameters: 

 Block ID(s): 1; 

 Category: Solid; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Apply. 

Setting boundary conditions 

1. Set the value of temperature applied to the left side of the beam. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Temperature, Action - Create). 

Set the following parameters: 

 

 System Assigned ID; 

 Temperature Entity List: Surface; 

 Entity ID(s): 4; 
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 Temperature Value: 0. 

Click Apply. 

2. Set the value of temperature applied to the right side of the beam. 

Select on Command Panel (Mode - Boundary Conditions, Entity - Temperature, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Temperature Entity List: Surface; 

 Entity ID(s): 6; 

 Temperature Value: 1. 

Click Apply. 

Setting time dependency of boundary conditions 

1. Set time dependency of the temperature applied to the right edge of the beam. 

Select (Mode - Boundary Conditions). Click on the button Time dependency on Command Panel. The pop-up menu with the settings 

will be opened. On the left panel, select BC for which the time dependency will be set: Temperature 2. Set the following parameters: 

 Time dependency type: Manually; 

 Enter formula: 100*sin(0.0785*t). 

Click Apply. 

 

Starting calculation 

1. Set the type of the problem to be solved. 
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Select calculation setting section on Command Panel (Mode — Calculation Settings, Calculation settings — Transient analysis, 

Transient  — General). 

 

Set the following calculation parameters: 

 Dimension: 3D; 

 Method: Full solution; 

 Scheme: Implicit; 

 Max time: 32; 

 Steps count: 10; 

 Elasticity: untick; 

 Heat transfer: tick. 

Click Apply. 

Click Start Calculation. 

In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at <date> <time>”. 

Results analysis 
1. Open the file with the results. 

You can do this in one of the three ways: 

 Click Ctrl+E. 

 Select Calculation Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode  Results). Click Open last result. 
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You can see the calculation results in the pop-up Fidesys Viewer window. 

2. There is a menu on Toolbar which allows viewing animation. It consists of a cycle of solutions calculated for every moment of time. 

Click Last Frame• to see the model in time moment t = 32°C. 

 

3. Display the component of the temperature. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Field: Temperature; 

 Representation Mode: Surface With Edges. 

 

The model displays the mesh resulting from application of the spectral element method and the field of temperature distribution. 

To display the color legend scale, click the button Switch the color legend visibility on Command Panel. 
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4. To graph along one of the beam edges. 

Select the filter Plot Over Line in the Main Menu. Set the coordinates of the points defining the line In the tab Properties: 

 Source: High Resolution Line; 

 Show Line; 

 Point 1 (coordinates): 0 -0.005 0.005; 

 Point 2 (coordinates): 0.1 -0.005 0.005; 

 Resolution: 100; 

 PassPartialArrays. 

Click Apply. 

 

  

To apply all of the filters changes automatically, click Apply changes to parameters automatically on Command Panel. 

Click on the graph window appeared on the right side of the screen. 

5. Display temperature change on the graph. 

Click on the graph window, go to the tab "Display" in the filter control panel. 

Set the Attribute Mode - Point Data 
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Next, in the field “Line Series”, set up labels against the parameters that you want to display on the graph. 

Untick all the options except Temperature. 

The temperature dependency at points belonging to the beam edge and the coordinates of these point coordinates are displayed on the 

graph. 

 

6. Check the numerical temperature value T at the point (0.08;0;0). 

Move the cursor to the required point on the graph. You can see a tool tip with the temperature value. 
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7. Download numerical data. 

Select → File Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. Click OK. The saved 

file is an ordinary table of numerical data which can be opened in any text editor. 

 

 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file tutorial_dynamics_thermo.jou by selecting Journal Editor on Toolbar. In a pop-up window 

of the main menu select File → Open and open the necessary journal file. 
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Harmonic analysis (beam model) 

We consider an example with a beam construction. Structural damping is specified. 

 

 

The model is rigidly fixed at points A, D, C, F. A force dependent on frequency is applied to the middle of the BE face. The 

sides of the structure have the same length: AB = BC = DE = EF = BG = EG = 2.5 m. Material parameters: Young's modulus 

E = 2e11 Pa, Poisson’s ratio  = 0.3, density  = 7800 kg / m3. Structural damping 0.1 is specified 

Geometry creating 

1. Create a structure and beams (lines). 

Since the structure contains edges of the same length, use the parameter L = 2.5. To set a parameter, enter in the command line # {L = 

2.5}. 

 

On the toolbar, select a line creating mode (Mode - Geometry, Entity - Curve, Action - Create). 
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From the drop-down list, select Line. On the Build panel, use select Location and Direction. Next, enter the necessary data to create 

the first line: 

 Location: 0 0 0 (space separated); 

 Direction: 0 1 0; 

 Length: {L}. 

Click Apply. 

Specify the necessary data to create a second line: 

 Location: 0 {L} 0; 

 Direction: 0 1 0; 

 Length: {L}. 

 

Click Apply. 

Specify the necessary data to create a third line: 

 Location: 0 {L} 0; 

 Direction: 1 0 0; 

 Length: {L}. 

 

Click Apply. 

Specify the necessary data to create the fourth line: 

 Location: {L} {L} 0; 

 Direction: 1 0 0; 

 Length: {L}. 

 

Click Apply. 

  

Specify the necessary data to create a fifth line: 

 Location:{2 * L} 0 0; 
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 Direction: 0 1 0; 

 Length: {L}. 

 

Click Apply. 

Specify the necessary data to create the sixth line: 

 Location:{2 * L} {L} 0; 

 Direction: 0 1 0; 

 Length: {L}. 

 

Click Apply. 

2. Splicing tops on received beams. On the toolbar, select the vertex creating mode (Mode - Geometry, Entity - Vertex, Action 

- Merge). 

 

Specify: 

 Vertex ID(s): all. 

Click Apply. 

A beam structure was created. 
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Meshing 

1. On the command panel, select the volume mesh mode (Mode - Mesh, Entity - Curve, Action - Mesh). 

 



CAE Fidesys — User Guide (version 5.1)           225 

 

 

Specify the following parameters: 

 Select Curves: all; 

 Settings for Curve: Equal; 

 Approximate Size: 0.1. 

Click Apply Size. 

Click Mesh. 

Setting material and block properties 

1. Create a material. 

Select setting the material properties section on Command Panel (Mode -Material, Entity -Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

Material 1. Press the ENTER key. 

In the left column, select Elasticity - Hook Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young's modulus and enter the number 

2e11.Similarly, from the Hook Material section add the Poisson Ratio 0.3, Density: 7800. 

Click Apply. 

Close the window. 
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2. Create a block of the one type of material. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Add). 

 

Set the following parameters: 

 Block ID: 1; 
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 Entity List: Curve; 

 Entity ID(s): all. 

Click Apply. 

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Category: Beam; 

 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Order: 1. 

Click Set Beam Properties. Set the checkbox Select profile. Select Rectangle in the list of geometric elements. Specify the following 

parameters: 

 CS rotation angle: 0; 

 Offset to: Centroid; 

 Select profile: Ellipse; 

 Minor axis (b): 0.1; 

 Major axis (a): 0.1. 

Click Apply. 

Close the window Set Beam Properties. 

Click Apply. 
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Setting boundary conditions 

1. Fix the vertices A, D, C, F through all displacements and rotations. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

 

Set the following parameters: 

 System Assignment ID; 

 Entity List: Vertex; 

 Entity ID(s): 1 4 9 12 (or select the vertices with the mouse by pressing the Ctrl key); 

 Degrees of Freedom: All; 

 DOF Value: 0 (can not fill). 

Click Apply. 

2. Apply a force dependent on frequency. 

On the command panel, select (Mode - Boundary Conditions, Entity - Force, Action - Create). 
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Set the following parameters: 

 System Assignment ID; 

 Force Entity List: Vertex; 

 Entity ID(s): 6 (or select a vertex with the mouse, as shown in the figure); 

 Force: 1; 

 Direction: 0 0 -1 (negative direction along the z axis). 

Click Apply. 

 

3. Set the frequency dependence. 

On the command panel, select (Mode - BC Dependency). 

In the BC Dependency window that appears, select the boundary condition Force 1 in the left column, in the Formula panel from the 

drop-down list, select Harmonic. 
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Enter the following data: 

 Amplitude: 1e5; 

 Phase: 0. 

Click Apply. 

 

Starting calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings module (Mode - Calculation Settings, Calculation Settings - Frequency analysis, 

Frequency analysis - General). 
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Set the following calculation parameters: 

 Dimension: 3D; 

 Method: Mod superposition; 

 Maximum frequency number: 10; 

 Frequency Interval: 0-200; 

 Frequency step: 0.5. 

Click Apply. 

2. Specify structural damping. 

On the command panel, select the calculation settings module (Mode - Calculation Settings, Calculation Settings - Frequency analysis, 

Frequency analysis - Damping). 

 

Set the following calculation parameters: 

 Structural damping: 0.1. 



CAE Fidesys — User Guide (version 5.1)           232 

 

 

Click Apply. 

Click Start Calculation. 

3. In the window that appears, select the directory in which the result will be stored, and enter the file name. 

4. In the case of a successful calculation, the console displays the message: “Calculation finished successfully at <date> <time>”. 

Results analysis 

1. Compare the results displayed on the command line with the results below: 

 

2. Open the file with the results. 

You can do this in one of the three ways: 

 Click Ctrl+E. 

 Select Calculation Open Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode - Results). Click Open last result. 

 

The Fidesys Viewer window will appear, in which you can view the calculation results. 

In the standard line, select Filters -> Alphabetical -> Harmonic Analysis. 
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The plot of Displacement (Amplitude) versus frequency must be plotted for node 2 (coincides with vertex B).For the Harmonic analysis 

filter in the Tree, in the Properties tab, specify: 

 Node ID: 2. 

Click Apply. 
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In the section Row Parameters for the X-axis that appears, select only the Displacement Amplitude Z (Harmonic Analysis). 
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On the right side of the screen received the desired graph. 
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Hover over one of the peaks, then the pop-up text will display the amplitude value corresponding to the frequency. 
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Using the console interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file harmonic_beam.jou by selecting Journal Editor on Toolbar. In a pop-up window of the 

main menu select File → Open and open the necessary journal file. 
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Bounded Contact Simulation 

We consider an example of the calculation of a structure consisting of several volumes that are not merged with each other. 

There is a geometric gap between the two volumes, so instead of “gluing” the volumes, the bounded contact will be used. 

The model represents a quarter of the original part. 

The model is located here:  

C:\Program Files\Fidesys\CAE-Fidesys-

4.1\preprocessor\bin\help\fidesys_example_tutorials\modeling_contact\images/geom_example_contact.stp 

 

  

 

The model is fixed on the lateral faces of the symmetry conditions. The inner surface of the hole is fixed in all degrees of 

freedom. A pressure of 1 MPa is applied to the upper face of the part. Material parameters: Young's modulus E = 2e11 Pa, 

Poisson’s ratio  = 0.3. 

 

Geometry creation 

1.Import geometry 

In the standard line select Menu - File - Import. Specify the path to the Geom_example_contact.stp file. In the window that 

appears, click Finish with all the default values of settings. 
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In the Tree on the left you can see three volumes into which the model is separated. All three volumes have no common 

surfaces. 

Meshing 

1. On the command panel, select the volume mesh mode (Mode — Mesh, Entity — Volume, Action — Intervals). 

 

Specify the following parameters: 
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 In the drop-down list, select: Approximate size; 

 Choice of volumes: 1; 

 Approximate size: 0.1. 

Click Apply Size. 

Click Mesh. 

 

  

2. On the command bar, select the volume mesh building mode (Mode — Mesh, Entity — Volume, Action — Intervals). 

Specify the following parameters: 

 In the drop-down list, select: Approximate size; 

 Select volumes: 2; 

 Approximate size: 0.3. 

Click Apply Size. 

Click Mesh. 

  

 

 

  

3. On the command panel, select the volume mesh creating mode (Mode — Mesh, Entity — Volume, Action — Intervals). Specify 

the following parameters: 

 In the drop-down list, select: Approximate size; 

 Select volumes: 2; 
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 Approximate size: 0.3. 

Click Apply Size. 

Click Mesh. 

 

Thus, a non-conformal finite element mesh was created on the model. 
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Specifying the material and block properties 

1. Create a material. 

Select setting the material properties section on Command Panel (Mode — Material, Entity — Materials Management). 

 

In the Materials Management window that opens, in the second column, click on the caption Enter the name of the material and write 

“Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hook Material. Select with the mouse the characteristic Young's modulus. Hold down the left 

mouse button and drag the label to Material Properties. Double-click in the Value field next to Young’s modulus and enter the number 

2e11.Similarly, from the Hook Material section add the Poisson Ratio 0.3 

Click Apply. Close the window. 
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2. Create a block of the one type of material. 

On the command panel, select (Mode - Blocks, Entity — Block, Action — Add). 

 

Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume; 

 Entity ID(s): All. 

Click Apply. 

  

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 
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Set the following parameters: 

 Block ID(s): 1; 

 Available materials: material1; 

 Coordinate System: Global Cartesian; 

 Category: Solid; 

 Order: 1. 

Click Apply. 

Setting boundary conditions 

1. Fix the sides of the part with the condition of symmetry. 

On the command panel, select (Mode - Boundary Conditions, Entity — Displacement, Action — Create). 

 

Set the following parameters: 

 System assignment ID; 

 Entity list: Surface; 

 Entity ID(s): 2 27 38 (or select the vertices with the mouse while holding down the Ctrl key); 

 Degrees of freedom: X-Translation Disp; 

 DOF Value: 0 (can not fill). 

Click Apply. 

  

On the command panel, select (Mode - Boundary Conditions, Entity — Displacement, Action — Create). 
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Set the following parameters: 

 System assignment ID; 

 Entity list: Surface; 

 Entity ID(s): 5 22 23 36 (or select the vertices with the mouse by pressing the Ctrl key); 

 Degrees of freedom: Z-Translation Disp; 

 DOF Value: 0 (can not fill). 

Click Apply. 

  

2. Fix the hole. 

On the command panel, select (Mode - Boundary Conditions, Entity — Displacement, Action — Create). 

Set the following parameters: 

 System assignment ID; 

 Entity list: Surface; 

 Entity ID(s): 30 (or select the vertices with the mouse by pressing the Ctrl key); 

 Degrees of freedom: All; 

 DOF Value: 0 (can not fill). 

Click Apply. 

  

3. Apply pressure to the top face. 

On the command panel, select (Mode - Boundary Conditions, Entity — Pressure, Action — Create). 

 

 Set the following parameters: 



CAE Fidesys — User Guide (version 5.1)           246 

 

 

 System assignment ID; 

 Entity list: Surface; 

 Entity ID(s): 17 37; 

 Magnitude Value: 1e6 (the exponential type of the number is supported using the Latin letter “e”). 

Click Apply. 

  

4. Set the contact condition. 

On the command panel, select (Mode - Boundary Conditions, Entity — Contact, Action — Create). 

 

Set the following parameters: 

 Auto selection; 

 Entity List: Global; 

 Friction Value: 0; 

 Offset: 0.055; 

 Type: Tied; 

 Method: Auto. 

Click Apply. 

  

In the Tree on the left, find the Boundary Conditions - Constraints - Contacts. Two contact pairs are automatically identified. 
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Starting calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings mode (Mode - Calculation Settings, Calculation Settings — Static, Static 

— General). 

 

Set the following calculation parameters: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 

  

2. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

  

3. In the case of a successful calculation, the console displays the message: “Calculation finished successfully at <date> <time>”. 
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Results analysis 

1. Open the results file. There are three ways to do it: 

 Click Ctrl+E. 

 From the main menu, select Results. Click Open last result. 

 Select Results on Command Panel (Mode - Results). Click Open last result. 

 

The Fidesys Viewer, window will appear, in which you can view the calculation results. 

  

2. Display the Contact Status Node for the model. 

 

  

 

 

  

3. Display displacements for the deformed view of the model. 
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Specify the scale of 2000. 

 

 

 

Using the console interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file modeling_contact.jou by selecting Journal Editor on Toolbar. In a pop-up window of the 

main menu select File → Open and open the necessary journal file. 
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The loading history of the elastic-plastic plate 

Hinton E. Fundamental Tests for Two and Three-dimensional, Small Strain, Elastoplastic Finite Element Analysis / Emest 

Hinton, M.H. Ezatt. - NAFEMS, 1987. 

We solve the problem of tension-compression of a square plate. Material parameters: E = 250e3 N / mm2,  = 0.25, yield 

strength c = 5 N / mm2. The model is meshed into one finite element. The left and bottom sides are fixed perpendicularly. 

The boundary conditions are presented in the figure below: 

 

Geometry creating 

1. Create a square plate. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, 

Action - Create). 

  

From the list of geometric primitives, select Rectangle. Set block sizes: 
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 Width: 1; 

 Location: Zplane. 

Click Apply. 

  

2. Move the surface to the origin of CS. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, 

Action - Transform). 

 

From the list of possible transformations, select Move. Set the parameters: 

 Surface ID(s): 1; 

 Including Merged: uncheck; 

 Select method: Distance; 

 X Distance: 0.5; 

 Y Distance: 0.5. 

Click Apply. 

Thus, the lower left corner of the plate has moved to the origin of CS. 

Meshing 

1. On the command panel, select the meshing mode on the curves (Mode - Mesh, Entity - Curve, Action - Mesh). 
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Specify the degree of refining mesh: 

 Select Curves: all; 

 Select the meshing method: Equal; 

 Select the meshing options: Interval; 

 Interval: 1. 

Click Apply Size. 

Click Mesh. 

  

2. On the command panel, select the surface meshing mode (Mode - Mesh, Entity - Surface, Action - Mesh). 
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 Select the mesh scheme: Automatically Calculate; 

 Select Surfaces: all. 

Click Apply Scheme. 

Click Mesh. 

Specifying the material and block properties 

1. Create material. 

On the command panel, select the mode for setting material properties (Mode - Material, Entity - Materials 

Management). 

  

Specify the name of the material Material 1. Drag the Hook Material inscription from the left column into the 

Material Properties column. Set the following parameters: 
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 Young’s modulus: 250e3; 

 Poisson ratio: 0.25; 

In the window on the left, go to the section Plasticity – Mises Criterion. Drag the Yield strength feature into the 

Material Properties window. Enter value: 

 Yield strength: 5. 

 

Click Apply. 

  

2. Create a block of the one type of material. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - 

Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity list: Surface; 

 Entity ID(s): 1 (or by command all). 

Click Apply. 

  

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - 

Block properties/parameters). 
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Set the following parameters: 

 Block ID(s): 1; 

 Available materials: Material 1; 

 Coordinate System: Global Cartesian; 

 Category: Plane; 

 Order: 2. 

Click Apply. 

Setting boundary conditions 

1. Fix curve 3 in the Y direction. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

 

Set the following parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 3; 

 Degrees of freedom: Y-Translation Disp; 

 DOF Value: 0. 

Click Apply. 
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 2. Fix curve 2 in the X direction. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create).  

Set the following parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 2; 

 Degrees of freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

 3. Fix curve 4 in the X direction. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create).  

Set the following parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 4; 

 Degrees of freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

4. Fix curve 1 in the Y direction. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create).  

Set the following parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 1; 

 Degrees of freedom: Y-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

Set the dependence of the BC on the time and / or coordinates 

1. Set the dependence of the BC on the time and / or coordinates. 
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 On the command panel, select Mode – BC Dependency. 

 

Click Displacement 3 and choose panel Table in the right side. Set the flag: Time and fill in the table as follows: 

 

Click Apply. 

 2. Create table 2 for displacement 
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Click Displacement 4 and choose panel Table in the right side. Set the flag: Time and fill in the table as follows:

 

Click Apply. 

Starting calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings module (Mode - Calculation Settings, Calculation Settings 

- Static, Static - General). 
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 Dimensions: 2D; 

 Plain state: Plane strain; 

 Model: Elasticity, Plasticity; 

 Load steps count: 8. 

Click Apply. 

Click Start Calculation. 

 2. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

 3. In the case of a successful calculation, the console displays the message: “Calculation finished successfully at 

"date time". 

Results analysis 

1. Open the file with the results. There are three ways to do that. 

 Press Ctrl+E. 

 From the main menu, select Calculation . Click Open results. 

 Select Results on Command Panel (Mode - Results). Click Open last result. 

 

To analyze the results, go to the Fidesys Viewer window. 

To automatically apply changes to all filters, click the corresponding button Apply changes to parameters 

automatically on the command bar. 

 2. Connect the filter to Warp by vector (Menu - Filters - Alphabetical Index - Warp by vector). Or use the 

corresponding button on the command bar. 

 

For this filter, on the Properties tab, set: 

 Vector: Displacement; 

 Scale multiplier: 10,000. 

Click Apply (unless Apply changes to parameters automatically is enabled). 
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 3. In the top pane, select the payroll result data to display. From the first drop-down list, select Displacement, 

from the second - Magnitude. 

 

  

In the step view panel, set step 1. 

You should see the plate image in the initial state. Next, click on Play. You should see a consistent 

stretching, and then compression of the plate in accordance with the loading history.

 

Thus, the calculation of the stress-strain state with the loading history of the plate was made. 

 

Using the console interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the file  elastoplastic_plate_loadsteps.jou by selecting Journal Editor on Toolbar. In a pop-up 

window of the main menu select File → Open and open the necessary journal file. 
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Sequential addition of volumes in the calculation process 

We consider an example of a multi-step calculation in CAE Fidesys with the addition of volume in the calculation process. 

The problem is solved in two steps of loading. At the first step, the model is a brick, one end of which is fixed along the X 

axis,the pressure is applied along the Y axis to the other side (thus, compression occurs). At the second step of the 

calculation, the boundary condition fixation along the X axis is removed for the model, instead of it a new brick is added to 

the same face. At the junction, the volumes merged, the opposite side of the new added volume is fixed along the X axis. 

At the same time, the volumes continue to compress. 

Geometry creating 

1. Create the first brick. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, Action - Create). 

 

From the list of geometric primitives, select Brick. Set block sizes: 

 X (width): 2; 

 Y (height): 1; 

 Z (depth): 0.3. 

Click Apply. 

  

2. Create a second brick. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, Action - Create). From 

the list of geometric primitives, select Brick. Set block sizes: 

 X (width): 1; 

 Y (height): 1; 

 Z (depth): 0.3. 
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Click Apply. 

  

3. Move the first brick to the origin of CS. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, Action - Transform). 

 

From the list of possible transformations, select Move. Set the parameters: 

 Volume ID(s): 1; 

 Including Merged: uncheck; 

 Select Method: Distance; 

 X Distance: 1; 

 Y Distance: 0.5; 

 Z Distance: 0.15. 

Click Apply. 

  

4. Move the second brick to the origin of CS. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, Action - Transform). 

From the list of possible transformations, select Move. Set the parameters: 

 Volume ID(s): 1; 

 Including Merged: uncheck; 

 Select Method: Distance; 

 X Distance: 2.5; 

 Y Distance: 0.5; 



CAE Fidesys — User Guide (version 5.1)           264 

 

 

 Z Distance: 0.15. 

Click Apply. 

  

5. Merge two volumes. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, Action – Imprint and 

Merge). 

 

From the list of possible transformations, select Merge Volumes. 

In the Volume ID(s) field, enter: all. 

Click Apply. 

Meshing 

1. On the command panel, select the volume meshing mode (Mode - Mesh, Entity - Volume, Action - Intervals). 
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Specify the degree of refining mesh: 

 Approximate Size: 0.1; 

 Select Volumes: all. 

Click Apply Size. 

Click Mesh. 

Specifying the material and block properties 

1. On the command panel, select the mode for setting material properties (Mode - Material, Entity - Materials Management). 
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Specify the name of the material Material 1. Drag the Hook Material inscription from the left column into the Material Properties 

column. Set the following parameters: 

 Young's modulus: 2.1e4; 

 Poisson's ratio: 0.3. 

In the left window, go to Plasticity - Mises Criterion and drag the Yield Strength feature into the Material Properties window. Set: 

 Yield Strength: 24. 

Click Apply. 

  

2. Create a block. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity List: Volume; 

 Entity ID(s): 1 2 (or the all command). 

Click Apply. 

  

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 
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 Material: Material 1; 

 Coordinate System: Global Cartesian; 

 Category: Solid; 

 Order: 2. 

Click Apply. 

Setting boundary conditions 

1. Fix the model along the Y axis. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 3 5 9 11; 

 Degrees of Freedom: Y-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

2. Fix the model along the X axis. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 6; 

 Degrees of Freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

3. Fix the model along the X axis. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 12; 

 Degrees of Freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

4. Fix the model along the Z axis. 

On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 1 2 7 8; 

 Degrees of Freedom: Z-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

5. Apply pressure 100 MPa to the left side. 

On the command panel, select (Mode - Boundary Conditions, Entity - Pressure, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Pressure Entity List: Surface; 

 Entity ID(s): 4; 

 Magnitude Value: 100. 

Click Apply. 

Starting calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings mode (Mode - Calculation Settings, Calculation Settings - Static, Static 

- General). 
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 Dimensions: 3D; 

 Model: Elasticity, Plasticity; 

 Load steps count: 2. 

Click Apply. 

  

2. Go to the Settings window load steps. 

 

  

Set step calculation – 1 for displacement 2. Boundary condition will be active in this step. 
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Click Apply. 

  

3. In the setting load steps window, select block 2 and set at which calculation step this block will be active. 

 

Click Apply. 

Click Start Calculation. 
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 4. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

 5. In the case of a successful calculation, the console displays the message: Calculation finished successfully at "date time". 

Result Analysis 

1. Open the file with the results. There are three ways to do that. 

 Click Ctrl+E. 

 From the main menu, select Calculation . Click Open results. 

 Select Results on Command Panel (Mode - Results). Click Open last result. 

 

For postprocessor analysis, go to the Fidesys Viewer  window. 

  

2. Connect the filter Warp by Vector (Menu - Filters – Alphabetical - Warp by Vector). Or use the corresponding button on the 

command bar: 

 

For this filter, on the Properties tab, set: 

 Vector: Displacement; 

 Scale factor: 100; 

Click Apply. 

  

3. On the top bar, select the required result data to display. From the first drop-down list, select Displacement, from the second 

- Magnitude, from the third - Surface with edges. 
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  In the step view panel, set step 1. You should see the image in the initial state. Next, click on Play . You 

should see the sequential compression of the model in accordance with the loading history.

 

 

Using the console interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the add_layers.jou by selecting Journal Editor on Toolbar. In a pop-up window of the main menu 

select File → Open and open the necessary journal file. 
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Sequential Deletion of Volumes in The Calculation Process 

The model is a cylindrical tube consisting of three layers. Material parameters for all three layers: E = 2.1e4 N / mm2,  = 

0.3, yield strength c = 24 N / m2. A uniform pressure of 14 N / mm2 is applied to the inner surface of the pipe. Fixation 

according with the symmetry condition. Three loading steps are specified: in the second step, the outer layer of the pipe is 

removed, in the third step, the next outer layer of the pipe is removed. In the process of solution, stresses are analyzed with 

the plastic flow and pipe thinning 

.  

 

Geometry Creating 

1. Create a circular surface with a radius of 100. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, Action - Create). 
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From the list of geometric primitives, select Circle. Set the dimensions: 

 Radius: 100; 

 Location: Z-plane. 

Click Apply. 

  

2. Create a circular surface with a radius of 170. Set the dimensions: 

 Radius: 170; 

 Location: Z-plane. 

Click Apply. 

  

3. Create a circular surface with a radius of 190. Set the dimensions: 

 Radius: 190; 

 Location: Z-plane. 

Click Apply. 

  

4. Create a circular surface with a radius of 200. Set the dimensions: 

 Radius: 190; 

 Location: Z-plane. 

Click Apply. 
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5. Subtract surface 1 from the remaining surfaces 2 3 4. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, Action - Boolean). 

 

From the list of operations, select Subtract. Set the following parameters: 

 Surface ID (s): 2 3 4 (surfaces from which other surface will be subtracted); 

 Surface ID (s): 1 (surfaces to be subtracted). 

Click Apply. 

  

6. Subtract surface 5 from surface 6. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, Action - Boolean). 

From the list of operations, select Subtract. Set the following parameters: 

 Surface ID (s): 6 (surfaces from which other surface will be subtracted); 

 Surface ID (s): 5 (amounts to be deducted); 

 Check the Keep Originals box and select Keep both (A and B). 

Click Apply. 

  

7. Subtract surface 6 from surface 7. 

On the command panel, select the mode for creating volumetric geometry (Mode - Geometry, Entity - Surface, Action - Boolean). 

From the list of operations, select Subtract. Set the following parameters: 

 Surface ID (s): 6 (surfaces from which other surface will be subtracted); 

 Surface ID (s): 7 (surfaces to be subtracted). 
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Click Apply. 

  

8. Cut the body. 

On the command panel, select the mode for creating volumetric geometry (Mode - Geometry, Entity - Surface, Action - Webcut). 

 

From the list of possible types of cuts, select Coordinate Plane. Set the following parameters: 

 Body ID(s): all (the surfaces to be cut); 

 Cut: Plane YZ; 

 Offset value: 0. 

Click Apply. 

  

Do the same, but in the ZX plane: 

On the command panel, select the mode for creating volumetric geometry (Mode - Geometry, Entity - Surface, Action - Webcut). 

From the list of possible types of cuts, select Coordinate Plane. Set the following parameters: 

 Body ID(s): all (the surfaces to be cut); 

 Cut: Plane ZX; 

 Offset value: 0. 

Click Apply. 

 9. Delete the surface. 

On the command panel, select the mode for constructing volumetric geometry (Mode - Geometry, Entity - Surface, Action - Delete). 
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In the Surface ID field, enter the numbers - 16 20 24 17 21 25 19 23 27. 

Click Apply. 

  

10. Draw a surface to create volume: 

On the command panel (Mode - Geometry, Entity - Volume, Action - Create). 

 

From the list of geometric primitives, select Sweep. 

Set the following parameters: 

 Surface ID (s): all; 
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 Perpendicular; 

 Distance: 10. 

Click Apply. 

Meshing 

1. On the command panel, select the mesh generation mode on curves (Mode - Mesh, Entity - Curve, Action - Mesh). 

 

Specify the degree of refining mesh: 

 Curve selection: 71 76 79 87 (through spaces); 

 Select the mesh generation method: Equal; 

 Select the partitioning options: Interval; 

 Interval: 50 (see picture). 

Click Apply. 

  

2. On the command panel, select the mesh generation module on curves (Mode - Mesh, Entity - Curve, Action - Mesh). 

Specify the degree of refining mesh: 

 Select Curves: 74 82 90 78 86 94 (through spaces); 

 Select the meshing method: Equal; 

 Select the partitioning options: Approximate size; 

 Approximate size: 2. 
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Click Apply. 

  

3. On the command panel, select the mesh generation module on curves (Mode - Mesh, Entity - Curve, Action - Mesh). 

Specify the degree of refining mesh: 

 Select Curves: 75 72 80 88 77 73 81 89 (through spaces); 

 Select the meshing method: Evenly; 

 Select the partitioning options: Interval; 

 Interval: 1 (see picture). 

Click Apply. 

  

4. On the command panel, select the mesh generation module on the planes (Mode - Mesh, Entity - Volume, Action - Intervals). 

 

Specify the mesh spacing: 

 Select Volumes: all; 

 Select the meshing mode: Automatic Sizing. 

Click Apply Size. 

Click Mesh. 

Set the Material 
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1. On the command panel, select the module for setting material properties (Mode - Material, Entity - Materials Management). 

 

Specify the name of the material Material 1. 

  

2. Drag the Hook Material inscription from the left column, as well as, under the Mises inscription, in the Plasticity section, in the 

Material Properties column. Set the following parameters: 

 Young's modulus: 2.1e + 04; 

 Poisson's ratio: 0.3. 

In the left window, go to Plasticity - According to Mises and drag the Yield Strength feature into the Material Properties window. Set: 

 Yield strength: 24. 
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Click Apply. 

Setting boundary conditions 

1. On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 29 34 39; 

 Degrees of Freedom: Y-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

2. On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 31 26 41; 

 Degrees of Freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 
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3. On the command panel, select (Mode - Boundary Conditions, Entity - Displacement, Action - Create). 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 32 37 42 18 22 26; 

 Degrees of Freedom: Z-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

4. Apply uniform pressure to the surface. 

On the command panel, select (Mode - Boundary Conditions, Entity - Pressure, Action - Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Pressure Entity List: Surface; 

 Entity ID(s): 30; 

 Magnitude Value: 14. 

Click Apply. 

Set the material and block properties 
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1. Create block of one type of material. 

On the command panel, select the module for setting material properties (Mode - Blocks, Entity - Block, Action – Add). 

 

Set the following parameters: 

 Block ID: 1; 

 Entity List: Volume; 

 Entity ID(s): 6. 

Click Apply. 

  

2. Create a second block. 

On the command panel, select the module for setting material properties (Mode - Blocks, Entity - Block, Action – Add). 

Set the following parameters: 

 Block ID: 2; 

 Entity List: Surface; 

 Entity ID (s): 7. 

Click Apply. 

  

3. Create the third block. 

On the command panel, select the module for setting material properties (Mode - Blocks, Entity - Block, Action – Add). 

Set the following parameters: 

 Block ID: 3; 

 Entity List: Surface; 

 Entity ID (s): 8. 
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Click Apply. 

  

4. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): all; 

 Available materials: Material 1; 

 Coordinate System: Global Cartesian; 

 Category: Solid; 

 Order: 2. 

Click Apply. 

Starting calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings module (Mode - Calculation Settings, Calculation Settings - Static, Static 

- General). 
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 Dimensions: 2D; 

 Plane state: Plane strain; 

 Model: Elasticity, Plasticity; 

 Load steps count: 3. 

Click on the three dot icon  in order to configure the active calculation steps for block 2 - 1 2 (separated by spaces), and for block 3 - 1. 

.  

Click Apply, 
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Click Start Calculation. 

  

2. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

  

3. In the case of a successful calculation, the console displays the message: Calculation finished successfully at "date time". 

Result Analysis 

1. Open the file with the results. There are three ways to do that. 

 Press Ctrl+E. 

 From the main menu, select Calculation . Click Open results. 

 Select Results on Command Panel (Mode - Results). Click Open last result. 

 

For postprocessor analysis, go to the Fidesys Viewer window. 

  

2. In the top pane, select the reqired result data to display. From the first drop-down list, select Stress, from the second - Mises, from 

the third - Surface. 

 

  

In the step view panel, set step 1. You should see the image in the initial state. Next, click on Play .  

You should see the sequential removal of layers on the model according to the loading history. 
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Using the console interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 
 It is also possible to run the add_layers.jou by selecting Journal Editor on Toolbar. In a pop-up window of the main menu 

select File → Open and open the necessary journal file. 

 



CAE Fidesys — User Guide (version 5.1)           291 

 

 

 



CAE Fidesys — User Guide (version 5.1)           292 

 

 

Seismic wave propagation (SEG-Y results) 

CAE Fidesys allows you to upload solution results in SEG-Y format. This example considers the propagation of seismic 

waves in the ground based on the Lamb problem for a 2D case. The procedures for setting receivers, saving and subsequent 

analysis of data in the SEG-Y format are demonstrated. 

The model is a part of the plane (xy), a point force is applied to vertex. Non-reflective boundary conditions are applied. 

Geometry creation 

1. Create a square plate. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, 

Entity - Surface, Action - Create). 

 

From the list of geometric primitives, select Rectangle. Set block sizes: 

 Width: 1000; 

 Location: ZPlane. 

Click Apply. 

  

2. Due to symmetry, we consider half of the model. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, Action - Webcut). 

 

From the list of possible kind of webcuts, select Coordinate Plane. Set the following parameters: 

 Body ID(s): 1 (the body to be cut); 

 Cut: YZ; 

 Offset Value: 0. 

Click Apply. 
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Do the same, but in the ZX plane. 

 Body ID(s): 1 (the body to be cut); 

 Cut: ZX; 

 Offset Value: 0. 

Click Apply. 

 

As a result, the original Body 1 in the Model Tree will be divided into three bodies (Body 1, Body 2 and Body 3). 

  

3. Delete Surface 3. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, Action - Delete). 
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Set the parameters: 

 Surface ID (s): 3. 

Click Apply. 
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 4. Print and splice the surface. 

On the command panel, select the module for constructing volumetric geometry (Mode - Geometry, Entity - Surface, Action 

- Transform). 

 

Set the following parameters: 

 Surface ID(s): all. 

Click Apply. 

  

5. Rotate the model. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, Action - Transform). 

 

Select Rotate in the list of operations.  Set the following parameters: 

 Surface ID(s): all; 

 Angle: -90; 
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 Rotate About: Z-Axis. 

6. Write the following commands on the command line: 

 imprint all; 

 merge all. 

 

Meshing 

1. On the command panel, select the curve meshing mode (Mode - Mesh, Entity - Surface, Action - Intervals). 

 

Specify the degree of mesh refinement: 

 Approximate Size; 

 Select Surfaces: all; 

 Approximate Size: 7. 

Click Apply Size. 
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Click Mesh. 

Specifying the material and block properties 

1. On the command panel, select the mode for setting material properties (Mode - Material, Entity - Materials Management). 

 

From the Imported Material list, drag the Soil to the Material ID window. 

 

Click Apply. 

  

2. Create a block of  one material type. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Add). 
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Set the following parameters: 

 Block ID: 1; 

 Entity List: Surface; 

 Entity ID(s): All. 

Click Apply. 

  

3. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 
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 Material: Soil; 

 Coordinate System: Global Cartesian; 

 Category: Plane; 

 Order: 4. 

Click Apply. 

Setting boundary conditions 

1. Set non-reflective boundary conditions. 

On the command panel, select (Mode - Boundary Conditions, Entity – Absorbing Condition, Action - Create). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 7 15 13 6 (separated by spaces). 

Click Apply. 

  

2. Set the force. 

On the command panel, select (Mode - Boundary Conditions, Entity - Force, Action - Create). 
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Set the following parameters: 

 System Assigned ID; 

 Force Entity List: Vertex; 

 Entity ID(s): 10; 

 Force: 1; 

 Direction: 0 -1 0 (space separated). 

Click Apply. 

Set the BC dependency on time and / or coordinates 

1. Create a formula 1 for strength 1. 

On the command panel, select (Mode – BC Dependency). 

 

Click Force 1 and choose Formula panel in the right. Then choose Berlage and set the following parameters: 

 Select the flag Formula: Berlage; 

 Amplitude: 2e8; 

 Frequency: 10. 
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Click Apply. 

Receivers 

1. Create receivers on curve 16 along all directions. 

On the command panel, select (Mode - Receivers, Operation - Create). 

 

From the drop-down list, select the fields whose data you want to save in SEG-Y format. Set the following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s): 16; 

 Velocity; 

 Variables: All. 

Click Apply. 
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Repeat all the steps with the same parameters for each field in the drop-down list (velocity, principal stresses, pressure). 

The receiver lines are highlighted on the model in yellow when clicked in the corresponding section of the Model Tree. 

 

Starting calculation 

1. Set the type of problem you want to solve. On the command panel, select the calculation settings mode (Mode - Calculation Settings, 

Calculation Settings - Transient analysis, Transient - General). 

 

Set the following calculation parameters: 
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 Dimension: 2D; 

 Method: Full solution; 

 Scheme: Explicit; 

 Max time: 5; 

 Max steps count: 2025; 

 Preload model: uncheck; 

Click Apply. 

 Go to the settings section for Output Fields. Specify: 

 Save Results: Every 135 Steps 

Click Apply. 

Click Start Calculation. 

 2. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

 3. In case of a successful calculation, a message will be displayed in the console: “Calculation finished successfully at "date time". 

Results analysis 

1. Open the file with the results. There are three ways to do that. 

 Press Ctrl+E. 

 From the main menu, select Calculation . Click Open results. 

 Select Results on Command Panel (Mode - Results). Click Open last result. 

 

  

2. To analyze the results, go to the Fidesys Viewer. 

  

1. On the top bar, select the required result data to display. From the first drop-down list, 

select Stress, from the second - Mises. 

 

 4. Set the step 1 in the step viewer panel. You should see the plate image in the initial state. Next, click on Play  . You should see 

the propagation of stress over time. 
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 5. Open the saved data in SEG-Y format. 

To do this, go to Menu - File - Open. In the drop-down list of file types, select SEG-Y Files (* .sgy, * .segy). Specify the file to 

view test_Vy.sgs 
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 Set the viewing direction along the Y axis. 

 

The calculation results for displacement Uy in the SEG-Y format are visualized in the field of visualization. 

 

Using the console interface 

 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the boussinesq_problem_segy.jou by selecting Journal Editor on Toolbar. In a pop-up window 

of the main menu select File → Open and open the necessary journal file. 
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Poro-Elastic-Plastic Well Model (2D) 

Stress-strain state in the vicinity of a vertical well of radius Rw drilled to a depth of h is determined. The reservoir is 

considered to be isotropic and homogeneous. The problem is solved in a cylindrical coordinate system. 

Geometry creation 

1. Create the first circle with radius 10. 

On the command panel choose (Mode — Geometry, Entity— Surface, Action — Create). 

 

Select Circle in the list of geometric elements. Set block sizes: 

 Radius: 10; 

 Location: Z-plane. 

Click Apply. 

  

2.Create the second circle with radius 1. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, Action 

- Create). 
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From the list of geometric primitives, select Circle. Set block sizes: 

 Radius: 1; 

 Location: Z-plane. 

Click Apply. 

  

3. Subtract the first circle from the second one. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Surface, Action 

— Boolean). 
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Select Subtract in the list of operations. Set the following parameters: 

 A Surface ID(s): 1; 

 B Surface ID(s: 2. 

Click Apply. 

  

As a result, only one body (Body 1) will remain in the object tree. 

 

  

4. Leave a quarter of the volume (condition of symmetry). 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Surface, Action 

— Webcut). 
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From the list of available section views select Coordinate Plane. Set the following parameters: 

 Body ID(s): 1; 

 Cut: Plane ZX; 

 Offset Value: 0. 

Click Apply. 

  

Do the same, but in the YZ plane: 

 Body(ies) ID: 3; 

 Cut: Plane YZ; 

 Offset Value: 0. 

Click Apply. 

  

Then delete volumes 4 and 1. 



CAE Fidesys — User Guide (version 5.1)           310 

 

 

 

  

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action — Delete). 

 

Set the following parameters: 

 volume  ID(s): 4 1 (separated by a space). 

Click Apply. 

Setting material 

On the command panel, select the module for setting material properties (Mode — Material,Entity — Material 

management). 
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Specify the name of the material Material 1. Expand the item Elasticity in the left column and drag the Hooke Material to 

the Material Properties column. Set the following parameters: 

 Young's modulus: 1e9; 

 Poisson's ratio: 0.25; 

Expand Plasticity in the left column and drag the Second Drucker-Prager Strength Criterion into the Material Properties 

column. Set the following parameters: 

 Cohesion: 5.43712e+6; 

 Internal friction angle: 21.43; 

 Dilatancy angle: 21.43. 

Expand Geomechanics in the left column and drag Bio Isotropic Model to the Material Properties column. Set the following 

parameters: 

 Porosity: 0.25; 

 Permeability: 1e-12; 

 Fluid's viscosity  : 0.005; 

 Biot alpha: 1; 

 Fluid's bulk modulus: 1e+9; 

 Fluid's density: 1000. 
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Click Apply. 
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Meshing 

1. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). 

 

Specify the parameters of mesh refinement: 

 Selection curves: 8; 

 Bias; 

 Intervals and Bias; 

 Interval Count: 90; 

 Bias Factor: 1.05; 

 Start  Vertex ID: 7. 

Click Apply. 

  

2. Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). Specify the 

parameters of mesh refinement: 

 Selection curves: 12; 

 Bias; 

 Intervals and Bias; 

 Interval Count: 90; 

 Bias Factor: 1.05; 

 Start Vertex ID: 11. 
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Click Apply. 

  

3.Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Curve, Action — Mesh). Specify the 

parameters of mesh refinement: 

 Selection of curves: 13 14 (separated by a space); 

 Equal; 

 Interval: 30. 

Click Apply. 

  

4. Building the mesh. 

Select meshing on curves section on Command Panel (Mode — Mesh, Entity — Surface, Action — Mesh). 

 

Specify the degree of mesh refinement: 

 Automatically Calculate; 

 Select Surfaces: all. 

Click Mesh. 
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Setting boundary conditions 

1. Attach curves 8 and 12 in the direction Y and X respectively. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: curve; 

 Entity ID(s): 8; 

 Degrees of Freedom: Y-Translation Disp; 
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 DOF Value: 0. 

Click Apply. 

 Set the following parameters: 

 System Assigned ID; 

 Entity List: curve; 

 Entity ID(s): 12; 

 Degrees of Freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

  

2. Set the pore pressure. 

On the command panel, select Mode - Boundary Conditions, Entity – Pore Pressure, Action - Create. 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: curve; 

 Entity ID(s): 13 14 (separated by a space); 

 Value: 4e+7; 

Click Apply. 
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3. Set the pressure on curves 13 and 14. 

On the command panel, select Mode - Boundary Conditions, Entity – Pore Pressure, Action - Create. 

 

Set the following parameters: 

 System Assigned ID; 

 Pressure Entity List: curve; 

 Entity ID(s): 13; 

 Magnitude Value: 4e+7; 

Click Apply. 

  

Set the following parameters: 

 System Assigned ID; 

 Pressure Entity List: curve; 

 Entity ID(s): 14; 

 Magnitude Value: 8e+7; 

Click Apply. 
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Setting the block properties 

1. Create a block of one material type. 

On the command panel, select Mode — Blocks, Entity — Block, Action — Add entity to block. 

 

Set the following parameters: 

 Block ID: 1; 

 Entity List: Surface; 

 Entity ID(s): all. 

Click Apply. 

  

2. Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 
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Set the following parameters: 

 Block ID(s): 1; 

 Available materials: Material 1; 

 Coordinate System: Global Cartesian; 

 Category: Plane; 

 Order: 2. 

Click Apply . 

Starting calculation 

1.Set the analysis type. 

Select calculation setting section on Command Panel (Mode — Calculation settings, Calculation settings — Static, Static 

— General). 
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Select: 

 Dimension: 2D; 

 Type of plane problem: Plane deformed state; 

 Model: Elasticity, Plasticity, Pore Fluid Transfer; 

 Set the nonlinear solver options; 

 Min load substeps: 30; 

 Max load substeps: 10000000; 

 Max. iterations: 100; 

 Tolerance: 1e-6; 

 Target iterations: 5. 

Click Apply. 
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Results analysis 

1.Open the file with the results. There are three ways to do it. 

 Click Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click Open last result. 

 On the command panel, select the calculation settings module (Mode — Calculation Settings, 

Calculation Settings — Results. Click Open Results. 

 

  

2. Go to the Fidesys Viewer to analyze the results . 

  

3. On the toolbar, select Filters → Alphabetical → Coordinate System Conversions. In the Properties window that 

opens, set: 

 Scalar Array: Stresses; 

 Untick the Spherical coordinates box; 

 Cylinder axis: Z. 

 

  

Click Apply. 

  

4. Display the σθθ component of the stress field (cylinder) on the model. 
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On the toolbar, set the following parameters: 

 Display type: Surface; 

 Display field: Stresses (cyl.); 

 Display component: FF. 

 

 

  

5. On the toolbar, select Filters → Alphabetical → Plot Over Line. In the Properties window that opens, set: 

 Click Apply; 

 Row parameters: untick the Variable box; 

 Row parameters: tick the box Stresses_cylindrical_FF. 
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Using Console Interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the poroelastoplasticity.jou by selecting Journal Editor on Toolbar. In a pop-up window 

of the main menu select File → Open and open the necessary journal file. 
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Hertz problem for two hemispheres with contact 

In the proposed problem, the Hertz problem is modeled for two hemispheres with contact. The test task is designed to check 

the correctness: 

 setting parameters of sliding contact without friction in the interface; 

 static solution with sliding contact without friction for 3D models; 

 the correctness of the output of the Stress field, taking into account the contact interaction. 

 

Geometry Creation 

1.Create a sphere. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Create). 

 

From the list of geometric primitives, select Sphere. 

Set the following parameters: 

 Radius: 50; 
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Click Apply. 

 

  

2.Move the spher. 

On the command panel, select (Mode - Geometry, Entity - Volume, Action - Transform). 

 

From the list, select Move. 

Set the following parameters: 

 Volume ID(s): 11; 

 Include Merged; 

 Select Method: Distance; 

 Y Distance: 50 

Click Apply. 
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3.Create a second sphere. 

Select volume geometry generation section on Command Panel (Mode - Geometry, Entity - Volume, Action - Create). 

 

From the list of geometric primitives, select Sphere. 

Set the following parameters: 

 Radius: 50; 

Click Apply. 
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4.Move the second sphere. 

On the command panel, select (Mode - Geometry, Entity - Volume, Action - Transform). 

 

From the list, select Move. 

Set the following parameters: 

 Volume ID(s): 2; 

 Include Merged; 

 Select Method: Distance; 

 Y Distance: -50 

Click Apply. 
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 5.Cut the first sphere in two. 

On the command panel, select geometry (Mode - Geometry, Entity - Volume, Action - Webcut). 

 

Select from the list Coordinate Plane. 

Set the following parameters: 

 Volume ID(s): 1; 

 Coordinate plane: ZX; 

 Offset Value: 50; 

Click Apply. 
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6.Cut the second sphere in two. 

On the command panel, select geometry (Mode - Geometry, Entity - Volume, Action - Webcut). 

  

 

  

Select from the list Coordinate Plane. 

Set the following parameters: 

 Volume ID(s): 2; 

 Coordinate plane: ZX; 

 Offset Value: -50; 

Click Apply. 
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 7.Delete the cut off parts of the spheres. 

On the command panel, select geometry (Mode - Geometry, Entity - Volume, Action - Delete). 

 

Set the following parameters: 

 Volume ID(s): 2 3; 

Click Apply. 
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8.Cut the geometry in two. 

On the command panel, select geometry (Mode - Geometry, Entity - Volume, Action - Webcut). 

 

 Select from the list Coordinate Plane. 

Set the following parameters: 

 Volume ID(s): all; 

 YZ; 

Click Apply. 

 

  

9.Cut the geometry in two. 

On the command panel, select geometry (Mode - Geometry, Entity - Volume, Action - Webcut). 
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 Select from the list Coordinate Plane. 

Set the following parameters: 

 Volume ID(s): all; 

 XY; 

Click Apply. 

 

  

10.Remove parts of the spheres. 

On the command panel, select geometry (Mode - Geometry, Entity - Volume, Action - Delete). 
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Set the following parameters: 

 Volume ID(s): 5 6 7 8 9 10; 

Click Apply. 

 

  

Meshing 

1.Create a polyhedral mesh for the entire model. 

On the command panel, select (Mode — Mesh, Entity – Volume, Action – Mesh). 
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Select from the list Polyhedron. 

Select Volumes: all. 

Click Mesh. 

  

2.Create a mesh. 

On the command panel, select (Mode — Mesh, Entity – Volume, Action – Intervals). 
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Select from the list Automatic Sizing. 

 Select Volumes: 4. 

Click Apply Size. 

Click Mesh. 
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Specifying the material and Block 

1. Set the first material. On the command panel, select (Mode — Material, Entity — Materials Management). 

 

In the column "Material" enter the name of the material Material 1. 

Click Apply. 

In the column "Material properties" select the created material, then drag the desired properties to it from the left column. 

Drag properties and specify their value: 

 Young's Modulus: 2e+04; 

 Poisson Ratio: 0.3; 

Click Apply. 

 

 2.Create a block. 
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On the command panel, select (Mode — Blocks, Entity – Block, Action – Add). 

 

 Entity List Volume; 

 Entity ID: all. 

Click Apply. 

  

3.Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Available materials: Material 1; 
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 Coordinate System: Global Cartesian; 

 Category: Solid; 

 Order: 1. 

Click Apply. 

  

Setting boundary conditions 

1.Fix the plate at X. 

On the command panel select (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 25 33; 

 Degrees of Freedom: X-Translation Disp; 

 DOF Value: 0. 
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Click Apply. 

  

2.Fix the plate at Z. 

On the command panel select (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 23 31; 

 Degrees of Freedom: Z-Translation Disp; 

 DOF Value: 0. 
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Click Apply. 

  

3.Set displacement 

On the command panel select (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 24; 

 Degrees of Freedom: Y-Translation Disp; 

 DOF Value: -2. 
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Click Apply. 

  

4.Set displacement 

On the command panel select (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 

 

Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 34; 

 Degrees of Freedom: Y-Translation Disp; 

 DOF Value: 2. 
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Click Apply. 

  

5.Set the contact condition 

On the command panel select (Mode — Boundary Conditions, Entity — Contact, Action — Create). 

 

Set the following parameters: 

 Master and Slave selection: Surface; 

 Entity ID master entity: 32; 

 Entity ID slave entity: 26; 

 Tolerance: 0.0005; 

 Type: General; 
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 Method: Auto. 

 

Click Apply. 

  

Run calculation 

1.Set the type of problem you want to solve. 

On the command panel select the calculation settings module (Mode — Calculation Settings, Calculation Settings 

— Static, Static — General). 

 

Please select: 

 Dimension: 3D; 

 Model: Elasticity; 

Click Apply, Click Start Calculation. 
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2.In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at "date 

time". 

Results analysis 

1.Open the file with the results. 

You can do this in one of the three ways: 

 Click Ctrl+E. 

 Select Calculation Open Results in the Main Menu. Click Open Results. 

 Select - Results on Command Panel (Mode - Results). Click Open last result. 

 

The Fidesys Viewer window will appear, in which you can view the calculation results. 

2. On the top panel, select the data of the calculation result to display. From the first dropdown list select Stress, from the 

second – YY. 
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Using Console Interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. For geometry 

generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the Hertz_problem.jou by selecting Journal Editor on Toolbar. In a pop-up window of 

the main menu select File → Open and open the necessary journal file. 
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Calculation of the dynamic problem of plates with contact 

We consider the problem of an elastic strip that moves from the initial speed and crashes into a hard wall. During interaction, 

the strip in contact with the wall (sliding contact without friction). 

 

Geometry Creation 

1.Create a rectangle. 

Select surface geometry generation section on Command Panel (Mode — Geometry, Entity — Surface, Action — Create). 

 

From the list of geometric primitives, select Rectangle. 

Set the following parameters: 

 Width: 10; 

 Heigtht: 1; 

 ZPlane. 
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Click Apply. 

 

  

2.Create a vertical rectangle. 

Select surface geometry generation section on Command Panel (Mode — Geometry, Entity — Surface, Action — Create). 

 

From the list of geometric primitives, select Rectangle. 

Set the following parameters: 

 Width: 1; 

 Heigtht: 5; 

 ZPlane. 

Click Apply. 
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3.Move the vertical rectangle. 

On the command panel, select: (Mode — Geometry, Entity — Surface, Action — Transform). 

 

From the list of actions, select Move. 

Set the following parameters: 

 Surface ID(s): 2; 

 Include Merged; 

 X Distance: 5.51. 

Click Apply. 
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Meshing 

1.Create a mesh. 

On the command panel, select (Mode — Mesh, Entity – Surface, Action – Intervals). 

 

From the list of actions, select Automatic Sizing 

 Select Volumes: all; 

 Auto Factor: 7 

Click Apply Size,Mesh. 
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Specifying the material and Block 

1. Set the first material. 

On the command panel, select (Mode — Material, Entity — Materials Management). 

 

In the column "Material" enter the name of the material Mat1. 

In the column "Material properties" select the created material, then drag the desired properties to it from the left column. 

Drag properties and specify their value: 

 Young's Modulus: 3e+07; 

 Poisson Ratio: 0.3; 

 Density: 0.73e-3; 

Click Apply. 
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2.Create a block. 

On the command panel, select (Mode — Blocks, Entity – Block, Action – Add). 

 

 Entity List Surface; 

 Entity ID: all. 

Click Apply. 
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 3.Set the block parameters. 

On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - Block 

properties/parameters). 

 

Set the following parameters: 

 Block ID(s): 1; 

 Available materials: Mat1; 

 Coordinate System: Global Cartesian; 

 Category: Plane; 

 Order: 2. 

Click Apply. 

  

Setting boundary conditions 

1.Fix the horizontal plate at Y and Z directions. 

On the command panel select (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 1; 

 Degrees of Freedom: Y-Translation Disp, Z-Translation Disp; 

 DOF Value: 0. 

 

Click Apply. 

  

2.Fix the vertical plate at all directions. 

On the command panel select (Mode — Boundary Conditions, Entity — Displacement, Action — Create ). 
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Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 1; 

 egrees of Freedom: All; 

 DOF Value: 0. 

 

Click Apply. 

  

3.Set the contact condition 

On the command panel select (Mode — Boundary Conditions, Entity — Contact, Action — Create). 
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Set the following parameters: 

 Master and Slave selection: Curve; 

 Entity ID master entity: 6; 

 Entity ID slave entity: 4; 

 Tolerance: 0.0005; 

 Type: General; 

 Method: Penalty; 

 Normal Stiffness: 0.5; 

 Tangent Stiffness: 0.5. 

 

Click Apply. 
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Setting initial conditions 

1.Apply initial velocity to the first plate. 

On the command panel select (Mode — Initial Conditions, Entity — Velocity, Action — Create). 

 

Set the following parameters: 

 Surface; 

 Entity ID(s): 1; 

 Х Velocity: 202.2; 

 

Click Apply. 

  

Run calculation 

1.Set the type of problem you want to solve. 

On the command panel select the calculation settings module (Mode — Calculation Settings, Calculation Settings 

— Transient analysis, Transient analysis — General). 
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Please select: 

 Dimension: 2D; 

 Plane strain; 

 Scheme: Implicit; 

 Max time: 0.00016; 

 Steps count: 1000; 

 Preload model: remove the flag; 

 Implicit scheme options: Newmark algorithm gamma: 0; 

Click Apply. 

  

2.Configure additional settings. 

On the command panel select the calculation settings module (Mode — Calculation Settings, Calculation Settings 

— Transient analysis, Transient analysis — Output Fields). 
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Please select: 

 Calculate kinetic and deformation energies; 

Click Apply, Click Start Calculation. 

  

3.In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully at "date 

time". 

Results analysis 

1.Open the file with the results. 

You can do this in one of the three ways: 

 Click Ctrl+E. 

 Select Calculation Open Results in the Main Menu. Click Open Results. 

 Select - Results on Command Panel (Mode - Results). Click Open last result. 

 

The Fidesys Viewer window will appear, in which you can view the calculation results. 

2. On the main panel Fidesys Viewer click Select Points On (d) 

. 
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Select a point with coordinates on the geometric model (5 0 0). 

 

From the main menu select Filters - Alphabetical - Plot Selection Over Time. 
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Using Console Interface 
 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. For geometry 

generation, meshing, setting boundary conditions and materials you can use Console Interface.  

 

 It is also possible to run the dyn_contact_penalty.jou by selecting Journal Editor on Toolbar. In a pop-up 

window of the main menu select File → Open and open the necessary journal file. 
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Optimization Problem With Fidesys Python API 

To carry out the optimization calculation, it is necessary that the following conditions are met: 

 Installed Python v.3.8 or higher; 

 Installed vtk library for Python; 

 Installed numpy library for Python. 

To meet these conditions, you must do the following: 

 Download Python 3.8 or higher from python.org and install. 

 Open the Windows command line (cmd.exe) and write: 

pip3 install numpy (then press Enter and let the installation complete); 

pip3 install vtk (then press Enter and let the installation complete). 

After all the necessary steps have been completed, you can start solving the problem. 

  

The problem of optimization of the diameter of the base of a billboard pillar, loaded with a wind load, is considered. 
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Geometry Creating 

1. Create a brick. 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action 

— Create). 

  

 

  

From the list of geometric primitives, select Brick. 

Set the following parameters: 

 X (width): 20; 

 Y (heigtht): 0.5; 

 Z (depth): 10; 

Click Apply. 

 Then the volume needs to be moved. 

Go to (Mode — Geometry, Entity — Volume, Action — Transform). 
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 Select Move from the list of operations. 

Set the following parameters: 

 Volume ID's: 1; 

 Method: Distance 

 X Distance: 0; 

 Y Distance: 0; 

 Z Distance: 30. 

Click Apply. 

  

2. Create a frusto-cone pillar. 

Go to (Mode — Geometry, Entity — Volume, Action — Create). 
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Select Cone from the list of geometric primitives. 

Set the following parameters: 

 Height: 25; 

 Top radius: 0.25; 

 Circular; 

 Radius: 0.3. 

Click Apply. 

  

Next, the pillar must be moved. 

Go to (Mode — Geometry, Entity — Volume, Action — Transform). 
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Select Move from the list of operations. 

Set the following parameters: 

 Volume ID's: 2; 

 Method: Distance ; 

 X Distance: 0; 

 Y Distance: 0; 

 Z Distance: 12.5. 

Click Apply. 

  

3. Create common surfaces to generate the correct mesh. 

Go to (Mode — Geometry, Entity — Volume, Action — Imprint and Merge). 
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 Select Imprint/Merge Volumes from the list of operations. 

Set the following parameters: 

 Volume ID's: all 

Click Apply. 

  

Meshing 

1. Create a mesh. 

Go to (Mode — Mesh, Entity — Volume, Action — Mesh). 
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 Select Tetmesh from the list of algorithms. 

Set the following parameters: 

 Select volumes: all 

Click Mesh. 

  

If everything was done correctly, you will see a model like this: 
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Specifying the material 

1. Create the material. 

Go to (Mode — Material, Entity — Materials Management). 
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In the Material Management window, drag&drop "Steel" from the third column to the second. 

  

 

 Click Apply. 

  

2. Create a block 

Go to (Mode — Blocks, Entity — Block, Action — Add). 
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 Select Volume in the Entity List. 

Set the following parameters: 

 Entity ID's: all 

Click Apply. 

  

3. Set the block properties 

Go to (Mode — Blocks, Entity — Block, Action — Block properties/parameters). 

  

 

  

Set the following parameters: 
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 Block ID's: 1 

 Material: Steel; 

 Coordinate system: Global Cartesian; 

 Category: Solid; 

 Order: 1. 

Click Apply. 

  

Setting boundary conditions 

1. Fix all displacements of the surface of the base of the pillar 

Go to (Mode — Boundary Conditions, Entity — Displacement, Action — Create). 

  

 

  

Set the following parameters: 

 Entity list: Surface; 

 Entity ID's: 8; 

 Degrees Of Freedom: All; 

 DOF Value: 0. 

Click Apply. 



CAE Fidesys — User Guide (version 5.1)           373 

 

 

  

 

  

2. Set the distributed wind force on the billboard surface to p = 230 N/m2. 

Go to (Mode — Boundary Conditions, Entity — Distributed force, Action — Create). 

 

  

Select Surface from the Entity List. 

Set the following parameters: 

 Entity ID(s): 3; 

 Force type: Distributed Force; 

 Force: 230; 

 Direction Vector: (X: 0, Y: 1, Z: 0). 
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Click Apply. 

  

 

  

3. Add gravity 

Go to (Mode — Boundary Conditions, Entity — Gravity, Action — Create). 

 

  

Select Global from the Entity List. 

Set the following parameters: 

 Directions: Z -9.81. 
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Click Apply. 

  

Preparing for calculation 

1. Set the calculation settings. 

Go to (Mode — Calculation Settings, Calculation settings — Static, Static — General). 

  

 

Set the following parameters: 

 Dimensions: 3D; 

 Model: Elasticity. 

Click Apply. 

Extracting and Transforming of the Script 

1. Extract the model script from History. 

Go to the Command line and switch the tab to "History" , where you will see the script of the model you generated: 

reset 

brick x 20 y 0.5 z 10 

move Volume 1  x 0 y 0 z 30 include_merged  

create frustum height 25 radius 0.25 top 0.25 

move Volume 2 x 0 y 0 z 12.5 include_merged  

undo group begin 

imprint volume all  

merge volume all  

undo group end 

volume all scheme tetmesh 

mesh volume all 

create material 1 from 'Steel' 

set duplicate block elements off 
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block 1 add volume all 

block 'Block 1' material 1 cs 1 element solid order 1 

create displacement  on surface 8  dof all fix   

create distributed force on surface 3  force value 230 moment value 0 direction 0 1 0 specific 

create gravity global 

modify gravity 1 dof 3 value -9.81 

analysis type static elasticity dim3 

Right-click anywhere on the command line and select Select All , then right-click the selected script again and select Copy . 

 

  

This is how you copied the script to the clipboard. 

  

2. Convert the script to Python syntax. 

Open the Journal Editor and paste the script you copied earlier into its window. 
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Convert the script to Python syntax via Tools - Translate - Python. 
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If everything is done correctly, then you will get the following script in the window: 

  

 

  

Copy the resulting Python script from the Journal Editor. 

  

Create and run a Python script 

1. Create a Python script file 

Start Python IDLE, select File - New File from the menu, and a window for editing the script will open. 
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 2. Copy and paste the script below into a blank window that opens 

This Python script already contains the portion of the Fidesys model script that we got earlier. The place where the Fidesys 

model script is inserted is marked with appropriate comments. 

  

Please note that the bottom diameter of the pillar is varied by modifying of the cone creating command: 

- the initial view of the command:  fidesys.cmd("create frustum height 25 radius 0.25 top 0.25") 

- view of the changed command:  fidesys.cmd("create frustum height 25 radius "+str(r)+"top 0.25"). 

Inserting "+str(r)+" adds a radius value to the text command break. 

import vtk        # Library for working with output data 

from vtk.util.numpy_support import vtk_to_numpy # Library for converting results 

import sys        # System library 

import os         # System library 

         

fidesys_path = r'C:\Program Files\Fidesys\CAE-Fidesys-4.1' # Location of Fidesys 

base_dir = os.path.dirname(os.path.abspath(__file__))      # Directory where the script is located 

pvd_file = os.path.join(base_dir, '1.pvd') # Results Links File 

prep_path = os.path.join(fidesys_path, 'preprocessor', 'bin')    # Directory where the preprocessor is 

os.environ['PATH'] += prep_path  # Adding preprocessor path to PATH 

sys.path.append(prep_path)       # Adding preprocessor path to PATH 

import cubit                     # Preprocessing library 

import fidesys                   # Library of Fidesys 

cubit.init([""])                 # Initializing the preprocessor 

fc = fidesys.FidesysComponent()  # Create a required Fidesys fc component 

fc.initApplication(prep_path)    # Initializing the path to the preprocessor 

fc.start_up_no_args()            # Launch of the required Fidesys fc component 

r = 0.25           # Initial bottom radius of the pillar 

print("Initial bottom diameter: ", 2*r)  # Output to the data console - the initial value of the diameter 

isOptimized = False  # Initially False - initial construction is not optimized 

iteration = 1           # Initial value of the counter of passes (iterations) 



CAE Fidesys — User Guide (version 5.1)           380 

 

 

while isOptimized == False: # The loop repeats until the condition isOptimized == True 

    print("Iteration № ",iteration) # Write to the console which iteration 

    overstressed = [] # Create an empty array to fill with overstressed nodes 

     

    # ---------Start script from Fidesys------------- 

    fidesys.cmd('reset') 

    fidesys.cmd('brick x 20 y 0.5 z 10') 

    fidesys.cmd('move Volume 1  x 0 y 0 z 30 include_merged ') 

    fidesys.cmd("create frustum height 25 radius "+str(r)+"top 0.25") 

    fidesys.cmd('move Volume 2 x 0 y 0 z 12.5 include_merged ') 

    fidesys.cmd('undo group begin') 

    fidesys.cmd('imprint volume all ') 

    fidesys.cmd('merge volume all ') 

    fidesys.cmd('undo group end') 

    fidesys.cmd('volume all scheme tetmesh') 

    fidesys.cmd('mesh volume all') 

    fidesys.cmd('create material 1 from \'Steel\'') 

    fidesys.cmd('set duplicate block elements off') 

    fidesys.cmd('block 1 add volume all') 

    fidesys.cmd('block \'Block 1\' material 1 cs 1 element solid order 1') 

    fidesys.cmd('create displacement  on surface 8  dof all fix  ') 

    fidesys.cmd('create distributed force on surface 3  force value 230 moment value 0 direction 0 1 0 specific') 

    fidesys.cmd('create gravity global') 

    fidesys.cmd('modify gravity 1 dof 3 value -9.81') 

    fidesys.cmd('analysis type static elasticity dim3') 

    # ---------End script from Fidesys------------- 

         

    output_pvd_path = os.path.join(base_dir + "\\" + "1.pvd")       # We declare the directory and the save file 

    print("strarting calculation to " + output_pvd_path)            # We output the directory and the save file to the console 

    fidesys.cmd("calculation start path '" + output_pvd_path + "'") # We ask Fidesys to start the calculation in the specified 

directory 

         

    print("                  ") 

    print("Calculation completed successfully!") 

    print("                  ") 

    reader = vtk.vtkXMLUnstructuredGridReader()                             # Connect the reader 

    print("Reading the results from ",str(base_dir)+r"\1\case1_step01_substep01.vtu") # Writes where we get the results 

from 

    filename = os.path.join(str(base_dir)+r"\1\case1_step01_substep01.vtu") # Specifying the path to the file 

    reader.SetFileName(filename)                                            # We connect the path to the reader and read 

    reader.Update()                                                         # Needed because of GetScalarRange 

    grid = reader.GetOutput()                                               # We take the output 

    point_data = grid.GetPointData()                                        # We collect data for points 

    arrayOfStress = vtk_to_numpy(point_data.GetArray("Stress")) # Reading stresses from the array of results 

    node_id = vtk_to_numpy(point_data.GetArray("Node ID"))      # Reading node numbers from the result array 

    print("Start searching for overstressed nodes") 

    print("                  ") 

    for point in range(len(arrayOfStress)): 

            if arrayOfStress[point][6] > 106e6:     # Checking the von Mises stresses in the nodes 

                overstressed.append(node_id[point]) # Fill the array with numbers of overstressed nodes 

    if len(overstressed) == 0:  # The size of the array of overstressed nodes is checked, if it is 0 then 

        isOptimized = True      # set the variable isOptimized = True to exit the loop 

        print("Design optimized!") 
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    else: 

        print("Overstressed nodes: ",len(overstressed)) # Displaying information about the number of overstressed nodes 

        print("                  ") 

        r = r + 0.05    # Increase the radius by 0.05 

        iteration = iteration + 1 # Increasing the value of the iteration counter            

fc.deleteApplication() # Removing the completed task from memory 

print("                  ") 

print("Complete! Optimal diameter is at least: ", 2*r) 

  

3. Run the script. 

Select Run - Run Module from the menu and when the system asks to save this file, save it to the "Example" folder 

created in a directory with no Cyrillic characters in its path to avoid errors. 

  

 

  

The following messages will appear in the console. 
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The results will be saved to the folder where the script file was located. Upon completion of the calculation, you can open 

and view the 1.pvd results file. 
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Contacts  

http://www.cae-fidesys.com 

support@cae-fidesys.com 

+7 (495) 177-36-18 
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